Using PenPoint

DEVELOPER RELEASE
BETA EDITION

GO CORPORATION, FOSTER CITY, CALIFORNIA
Your license agreement with GO Corporation, which is included with the product, specifies the permitted and prohibited uses of the PenPoint™ operating system. Any unauthorized duplication or use of the PenPoint operating system in whole or in part is forbidden. Information in this document is subject to change without notice and does not represent a commitment on the part of GO Corporation.

GO, the GO logo, PenPoint, the PenPoint logo, and First Experience are trademarks of GO Corporation.

Words are checked against the 77,000 word Proximity/Merriam-Webster Linguibase, © 1983 Merriam-Webster. © 1983. All rights reserved, Proximity Technology, Inc. The spelling portion of this product is based on spelling and thesaurus technology from Franklin Electronic Publishers. All other products or services mentioned in this document are identified by the trademarks or service marks of their respective companies or organizations.

Warranty Disclaimer and Limitation of Liability

GO Corporation makes no warranties, express or implied, including without limitation the implied warranties of merchantability, fitness for a particular purpose and non-infringement, regarding PenPoint software or anything else. GO Corporation does not warrant, guarantee, or make any representations regarding the use or the results of the use of the PenPoint software or other products or documentation in terms of its correctness, accuracy, reliability, currentness, or otherwise. The entire risk as to the results and performance of the PenPoint software or other products or documentation is assumed by you. The exclusion of implied warranties is not permitted by some states. Therefore, the above exclusion may not apply to you.

In no event will GO Corporation, its directors, officers, employees, or agents be liable to you for any consequential, incidental, or indirect damages (including damages for loss of business profits, business interruption, loss of business information, cost of procurement of substitute goods or technology, and the like) arising out of the use of or inability to use the PenPoint software or other products or documentation or defects therein even if GO Corporation has been advised of the possibility of such damages, whether under theory of contract, tort (including negligence), products liability, or otherwise. Because some states do not allow the exclusion or limitation of liability for consequential or incidental damages, the above limitations may not apply to you. GO Corporation's liability to you for actual damages from any cause whatsoever, and regardless of the form of the action (whether in contract, tort (including negligence), product liability or otherwise), will be limited to $50.

Note

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and if not installed and used in accordance with the instruction manual may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at his or her own expense.
CONTRIBUTORS

Todd Agulnick
Bonnie Albin
Roland Alden
Fannie Allen
Josh Axelrod
Celeste Baranski
Steve Bartlett
Simon Bate
Sandy Benett
John Bennett
Sharin Blair
Arnold Blinn
Joe Bosurgi
Murray Bowles
Carol Broadbent
Alex Brown
Howard Brunnings
Kurt Buecheler
Robert Carr
Chia Lun Chang
David Chavez
Ratha Chea
Mark Cogdill
John Croll
Richard Dickson
Kevin Doren
Gary Downing
Celeste Dunn
Jim Floyd
Dan Fraisl
Mike Freedman
John Garrett
Alex Gerson
Ken Guzik
Paul Hammel
Greg Heumann
June Hirai

Deborah Hodge
Tony Hoeber
Greg Hullender
Steve Isaac
Jerry Kaplan
Merri-Lynn Kubota
Roy Kumar
Ilona Leale
Mark Lentczner
Charlie Leu
Debra Levesque
Dan'l Lewin
Kris Lincicome
David Low
Pete Ma
Arjen Maarleveld
Henry Madden
Cary Masatsugu
Hollis Maxwell
Janet McCandless
Devin McKinney
Carl Meyer
George Mills
Dana Mitchell
Robert Moncrieff
Ravi Narayanan
Lisa Oatman
Alex Osborne
Mike Ouye
S Page
Michael Papp
Grace Pariente
Craig Payne
John Russell
Mark Sapsford
Steve Schoettler
Bruce Schwartz

Mike Schwartz
David Serna
Danny Shader
Robbie Shepard
Ed Soloko
Peter Stahl
Peggy Stok
Craig Taylor
Sue Toeniskoetter
Bob Vallone
Doug van Duyne
Joe Vierra
Tim Wiegman
Rick Wolfe
Phil Ydens
Eddie Yee
Peter Yorgin
John Zussman

Special thanks to . . .

Maurice Balick
Pam Barringer
Janis Baron
Janet Beech
Timothy Bishop
Joel Borden
Brendan Boyle
Bill Bradley
Paul Bradley
Steve Brown
Diana Bury
Steve Chernicoff
Paul Catt
Vali Desmond
Cary Duncan
Bill Evans

Chris Glazek
Steven Hales
Tom Hall
Mimi Hathaway
Lynn Henry
Madeleine Kahn
Susan Kare
Donna Kelley
Ira Kleinberg
Henry Korman
Gary Lang
Tom Lindsey
Chris Metcalfe
Mike McGeoy
Keith McCandless
Marie Moreland
Signe Ostby
Andrew Osterman
Dan Petri
Jonathan Price
Paul Quin
Wes Richards
Pat Rogondino
Jon Ruppert
Fred Russo
Alan Saichek
Craig Sampson
Nancy Schoendorf
Herb Schueneman
Greg Stikeleather
Mike Stone
Amir Toussi
Cynthia Vincent
Anne Westbrook
Ellinor Wheeler
Richard Wineapple
Patti Zussman
Contents

CHAPTER 1 / 1

How to Use This Book

Using Procedures / 2

CHAPTER 2 / 5

Fundamentals

Documents in the Notebook / 8
Giving Commands with Gestures and Menus / 10
Making a Selection / 12
Working with Notebook Objects / 13
  Dismissing an Object / 13
  Moving a Notebook Object / 14
  Making an Object Bigger or Smaller / 15
Seeing What’s on the Bookshelf / 16
  Help / 16
  Preferences / 17
  Tools / 18
  Stationery / 20
  Disks / 20
  Keyboard / 21
  Installer / 21
  In Box and Out Box / 22
Using Option and Dialog Sheets / 23
  Displaying Option Sheets / 24
  Choosing Options / 25
  Using Dialog Sheets / 27
Copying and Moving Notebook Objects / 28
Getting Help / 30
  Getting Quick Help / 30
  Using the Help Notebook / 31

CHAPTER 3 / 33

Drawing Gestures

Using Gestures / 34
  Using Gesture Profiles / 35
PenPoint Gestures / 36

CHAPTER 4 / 65

Installing Applications and Devices

Finding Out What’s Installed in the Notebook / 67
Installing an Application or Utility from Disk / 68
  Automatic Installation / 70
Creating Personalized Versions of Utilities / 71
Saving Your Changes / 74
Deactivating Applications and Utilities / 76
  Deactivating Fonts / 77
Changing the Home Volume / 78
Setting Up Printers / 79
  Connecting a Printer / 79
  Setting Printer Options / 81
  Printing a Document / 82

CHAPTER 5 / 83

Creating and Using Documents

Using the Create Menu to Create a Document / 85
Using the Stationery Notebook to Create a Document / 87
  Adding Stationery to the Create Menu / 88
CONTENTS

Creating Stationery / 89
  Creating Customized Stationery / 89
Managing the Stationery Notebook / 91
  Deleting or Purging Stationery / 92
Scrolling a Document / 93
Floating a Document / 97
Moving and Resizing Floating Documents / 99
Zooming a Document / 100
Using Documents / 102
  Renaming a Document / 102
  Saving and Deleting Documents / 104
Embedding a New Document / 105
Embedding an Existing Document / 106
  Embedding a Tool / 106
Working with Embedded Documents / 107
  Setting Document Options / 107
  Moving an Embedded Document / 107
  Making an Embedded Document a Full-page Document / 107
  Floating an Embedded Document / 108
  Printing an Embedded Document / 109
Using the Cork Margin / 111
Customizing a Document / 113

CHAPTER 6 / 115
Writing in the Notebook

Learning to Write on the Computer Screen / 116
Printing in Writing Pads / 117
  Some Tips on Writing in Pads / 119
  Printing in Upper Case / 121
Translating Your Handwriting / 122
Correcting the Translation / 124
  Correcting the Translation in the Writing Pad / 124
  Correcting the Translation with the Proof Sheet / 125
Getting a Writing Pad / 126
Choosing a Writing Pad Style / 128
  Choosing Boxed Pads / 128
  Choosing a Ruled Pad / 129
  Choosing a Ruled-Boxed Pad / 131
  Choosing a Writing Pad Size and Shape / 133
Using a Keyboard to Write / 134
  Typing Text Directly onto the Page / 134
  Correcting Text in the Writing Pad by Typing / 135
Customizing Your Handwriting / 136
  Using a Customization Set / 138
  Analyzing Your Progress / 140
  Accommodating Multiple Users / 141

CHAPTER 7 / 143

Editing and Formatting Text

Selecting Text / 144
Editing Text / 146
  Adding Text / 147
  Deleting Text / 148
  Inserting Spaces in Text / 148
  Editing Text in Edit Pads / 149
  Editing Text in Labels and Document Titles / 150
  Editing Text in Fields / 150
Moving and Copying Text / 152
  Moving Text / 152
  Copying Text / 153
Styling Text / 154
  Styling Text Directly / 154
  Styling Text with Text Option Sheets / 156
Formatting Text / 157
  Setting Margins / 157
  Changing Line Spacing / 158
  Positioning Text / 159
  Setting Tab Stops / 160
  Starting a New Line, Paragraph, or Page / 161
  Copying a Format or Style / 162
Viewing Text / 163
    Viewing Text / 163
    Magnifying the Text / 164
Checking Your Spelling / 165
    Adding a Word to the Dictionary / 166
Adding your Signature to a Document / 167

CHAPTER 8 / 169
Finding and Replacing Text

Finding Text / 170
Replacing Text / 171
Defining The Search / 173
    Setting the Search Range and Direction / 173
    Refining the Search / 175

CHAPTER 9 / 177
Managing the Notebook

Seeing What’s in Your Notebook / 179
Finding Out More about a Document / 180
    Using the Show menu / 180
    Using the Document Option Sheets / 181
Sorting the Table of Contents / 182
Rearranging the Notebook / 183
    Moving Pages / 183
Grouping Documents into Sections / 184
    Creating a Section / 184
    Moving a Document into a Section / 185
    Creating a Subsection / 186
    Creating Multiple Notebooks / 186
Turning to a Page / 187
Using Notebook Tabs to Mark Pages / 189
    Attaching and Deleting Notebook Tabs / 189
    Attaching Several Notebook Tabs / 190
    Displaying Notebook Tabs / 191
Using Hyperlink Buttons to Move between Pages / 192
Setting Preferences / 194
    Setting the Time / 195
    Setting the Date / 196
    Setting the Response Time / 196
    Using the Auto Shut Off Option / 197
    Turning On the Warning Beep / 197
    Choosing PenPoint Fonts and Field Fonts / 198
    Choosing a Screen Layout / 199
Moving Items on the Bookshelf / 200
Customizing the Help Notebook / 201
Using the Clock / 202
    Changing the Display / 203
    Setting the Alarm / 204

CHAPTER 10 / 205
Printing, Sending, and Receiving Documents

Printing a Document / 207
    Choosing a Page Layout / 207
    Adding Headers and Footers / 208
    Printing a Document / 209
    Printing from the Out Box / 211
    Printing Embedded Documents / 211
Sending and Receiving Documents / 213

CHAPTER 11 / 215
Filing Documents

Using The Disk Manager / 218
    Finding Out More About What’s on a Disk / 221
    Creating New Directories / 222
    Renaming a Disk and its Documents / 223
    Deleting Documents from the Disk Manager / 223
    Creating Disk Manager Stationery / 223
CONTENTS

Transferring Documents / 224
  Transferring Documents and Sections to and from the Notebook / 224
  Transferring Documents Between Disks / 226

Copying and Duplicating Disks / 228
Converting a PenPoint Document to a PC Format / 230
Converting a PC Document to a PenPoint Document / 233
Formatting a Floppy Disk / 235
Saving Documents / 236
Backing Up Your Notebook / 237
  Restoring Your Notebook / 238

CHAPTER 12 / 241

Learning More About PenPoint

Managing Memory / 242
  Finding Out How Much Memory Something Uses / 242
  Things You Can Safely Delete or Deactivate / 243
  Other Ways to Use Memory Efficiently / 243
  When You Get an Out of Memory Message / 244

Restarting PenPoint When a Document Freezes / 245

Booting PenPoint When PenPoint Freezes / 246

Accommodating Multiple Users / 247
  Creating Individual Notebooks / 247

Tips on Navigating and Using Documents / 249
  Turning the Table of Contents into a Control Panel / 249
  Creating a Customized Index / 251

CHAPTER 13 / 253

Setting Up Your Computer

Recharging the Battery / 255
  Using the GO Travel Charger / 256
  Using the GO Quick Charger / 257

Replacing the Battery / 258
  Removing a Battery / 258
  Installing a Battery / 259

Connecting to a Printer / 260
  Connecting Directly to a Serial Printer / 260
  Serial Printer Connectors And Adapters / 261
  Connecting to a Serial Printer Through the GO Quick Charger / 262

Using a GO Floppy Drive / 263
  Connecting a GO Floppy Drive through the GO Quick Charger / 263
  Connecting Directly to a Disk Drive / 264

Using Floppy Disks / 265
  Manually Ejecting a Disk from the GO Floppy Drive / 266

Using a Hard Drive / 267

Connecting to a PC / 268
  Connecting Directly to a TOPS FlashCard / 269
  Connecting to a TOPS FlashCard through the GO Quick Charger / 270

Using Option Cartridges / 271

Connecting A Keyboard / 272

Caring For Your GO Computer / 273

HARDWARE APPENDIX / 275
GLOSSARY / 281
INDEX / 287
CHAPTER 1

How to Use This Book
Using PenPoint explains how to work with your PenPoint computer. Each chapter covers some aspect of working with the PenPoint™ operating system—creating documents, writing in the Notebook, copying documents to disk, or setting up the computer. The chapters themselves are broken up into procedures. Each procedure details the steps to accomplishing a specific task, such as editing text in fields, using Handwriting Customization, or installing an application.

The chapter introduction gives you a framework for understanding the procedures it contains. Each procedure gives you step-by-step instructions and shows you what you’ll see on screen when you do the steps.

Using Procedures

For example, here's the procedure for using this book. It has a brief introduction followed by an illustration with several steps.

1 Use the book's table of contents to find a specific task, such as how to rename a document.

△ When you look up the procedure you'll see a picture next to the steps. The picture illustrates your actions and the results you'll see on the screen.

△ Text preceded by a triangle like this one tells you more about the step above.

△ Leader lines often link a specific step to the appropriate part of the illustration.
You'll often draw gestures when you're following the steps in a procedure. Other basic skills include choosing commands from menus, working with option and dialog sheets, and using items on the Bookshelf. Read chapter 2, Fundamentals to learn about them before you go on to use the individual procedures in the rest of this book.

2 The procedure for renaming a document has steps like this: Draw a circle \( \circ \) over the title to display an edit pad and change it there.

- The illustration shows both the circle \( \circ \) over the title and the result: the edit pad. Every time we tell you to use a gesture (such as a circle) we illustrate that gesture: \( \circ \).
- The sample documents that we use in these screen illustrations are not all included in the Samples section on your computer.

3 When you need more information about drawing gestures, or about where they’ll work, see chapter 3, Drawing Gestures.

- You’ll find a gesture profile for each gesture (arranged alphabetically), and some tables that divide the gestures into logical groups.

4 Procedures are grouped by topic, so if you want to know more about a task, look at the other procedures in that section or chapter.

You’ll also see notes like this one referring you to related information in other parts of the book.
CHAPTER 2

Fundamentals
The PenPoint™ operating system organizes information you keep in the computer in a Notebook. When you turn the computer on you'll see a page of the Notebook. At the bottom of the screen is a Bookshelf which contains tools that are useful when you're working with documents. They're represented by icons (small pictures).

The first page of the Notebook is the Table of Contents, which tells you what's in the Notebook.

Commands in the menus on the menu line are instructions that tell PenPoint what to do next.

You can also give commands by drawing gestures on the screen. For example, to turn to a document, you tap its page number.

Tabs let you turn quickly to a page from anywhere in the Notebook.

The Bookshelf contains useful things you refer to and use while working with documents.
The first page of the Notebook is the Table of Contents which lists every document and section. To turn to a document directly, you tap—or lightly touch—its page number or its tab with the GO pen. An icon next to each title tells you the type of document it is, in other words which application was used to create it.

You use the pen to write in the Notebook and to tell PenPoint what you want to do next—create a new document, copy a paragraph to another page, or edit text, for example. To do any of these things you can either choose a command from a menu or draw a gesture (a symbol or letter) on the screen.

The procedures in this book tell you which gesture or menu command to use to accomplish a given task. If it’s a gesture, you’ll see the name of the gesture and its symbol (tap) and, if it’s a menu choice, the name of the command and the menu it’s on. Chapter 3, Drawing Gestures shows you how to draw each gesture and tells you what it does.
Documents in the Notebook

Each page of the Notebook contains a different document. You can have as many pages in the Notebook as you want (up to the amount of available memory).

A document can be longer than what you see on the screen.

To bring the hidden part into view you scroll the document.

You can find details in “Scrolling a Document” in chapter 5 (Creating and Using Documents).
<table>
<thead>
<tr>
<th>Document Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Products</td>
<td>2</td>
</tr>
<tr>
<td>Inventory</td>
<td>3</td>
</tr>
<tr>
<td>Standard Order Form</td>
<td>4</td>
</tr>
<tr>
<td>Proposed New Products</td>
<td>5</td>
</tr>
<tr>
<td>New Product Ideas</td>
<td>6</td>
</tr>
<tr>
<td>Capers</td>
<td>7</td>
</tr>
<tr>
<td>Chili Mixes</td>
<td>8</td>
</tr>
<tr>
<td>Sales</td>
<td>9</td>
</tr>
<tr>
<td>Customers</td>
<td>10</td>
</tr>
<tr>
<td>Chain Stores</td>
<td>11</td>
</tr>
<tr>
<td>Complaints to Action</td>
<td>12</td>
</tr>
<tr>
<td>New Bottle Design</td>
<td>13</td>
</tr>
<tr>
<td>Sales/Condiments</td>
<td>14</td>
</tr>
<tr>
<td>Package Design Letter</td>
<td>15</td>
</tr>
<tr>
<td>Proposed New Design (2,21)</td>
<td>16</td>
</tr>
<tr>
<td>Bottle Design Sketch</td>
<td>17</td>
</tr>
<tr>
<td>Revised Bottle FAX</td>
<td>18</td>
</tr>
<tr>
<td>CONTRACT</td>
<td>19</td>
</tr>
<tr>
<td>New Product Draft</td>
<td>20</td>
</tr>
</tbody>
</table>

Tap the Contents tab to see the Table of Contents for the entire Notebook.

Section titles are in bold.

To see all the documents in a section, double tap the section title.

Double tap it again to hide the titles.

Document titles are plain.

The document’s page number.

The document icon which shows what type of application you used to create the document.

To turn to a document:

- Tap either its page number or its icon.
- You can also turn to it by tapping its tab, if it has one.

You can find out how to make the tap and double tap gestures by reading chapter 3, Drawing Gestures.
Giving Commands with Gestures and Menus

There are two ways to tell PenPoint what you want to do next: choose a menu command or draw a gesture (a symbol or letter) on the screen. Generally, each menu item has an equivalent gesture. For example, to delete a word you can choose Delete from the Edit menu or cross it out X.

When you work with the documents in your Notebook, you:

Choose menu commands. To do so:
- Tap a menu name to open it and see its choices.
- Dimmed commands are currently unavailable.
- Tap again to choose a command.
- To close the menu without choosing a command, tap anywhere outside it.

Draw gestures. For example, to delete a word, you draw a cross out gesture X on it.

Some applications may add commands and gestures to those described in this guide. Check the application guide for more information.
Chapter 3, Drawing Gestures, shows you how to draw each gesture and tells you where it’s used. The gesture profile for cross out is shown below.

**Cross Out**  Deletes a word or selection in text, or any object directly beneath the X.

- **What Works**
  Make an X using two distinct strokes (top to bottom) over the selection or object that you want to delete.
  1. Draw the first stroke; barely lift the pen from the screen
  2. Quickly draw the second stroke.

- **Where It Works**
  Deletes the contents of a field, documents from the Table of Contents, and icons from the Bookshelf. When you draw it over a document’s title line, it deletes the document. When you draw it over a disk icon or disk name in the Disk Manager, it ejects the disk.

If you draw a gesture and PenPoint doesn’t recognize it, you see a starburst where you drew it. If you draw a gesture that PenPoint recognizes, but it doesn’t work where you used it, you see a series of concentric circles followed by a starburst.

When you choose a command or draw a gesture, PenPoint lets you know it’s carrying out the instruction by giving you visual feedback. For example, when you tap the page turn arrow, it darkens while the page is turning.

If carrying out the command takes more than an instant, you see a busy clock during the process. For example, when you tap an icon on the Bookshelf, the busy clock appears.
You often need to specify what you want a command to affect before you give that command. You do this by selecting the object. For example, you select a document in the Table of Contents before you tell PenPoint to print it.

When you select something it looks different; usually it gets highlighted. For example, if you select a word by double tapping it, the background behind the word turns gray, highlighting it.

To make a selection go away, you deselect it, usually by tapping it.

To find out how to select text, read "Selecting Text" in chapter 7 (Editing and Formatting Text).
As you work with documents, you often use Notebook objects, such as items on the Bookshelf, and option and dialog sheets. If any of these hides part of the page you want to see, you can move, resize, or dismiss it.

To see the contents of an item on the Bookshelf, tap its icon. To use a dialog or option sheet, you choose the appropriate menu command or draw a gesture. (Read “Using Dialog and Option Sheets” in this chapter for more details.)

**Dismissing an Object**

When you’re finished looking at or using a Bookshelf item or option or dialog sheet, you can dismiss it.

If it has a button:

Tap the button labeled **Close** or **Cancel**. This closes the item without changing anything.

If it has a close corner (a triangle in the upper left corner):

Tap the close corner.
Moving a Notebook Object

If an object obscures part of the page you want to see, you can move it to a more convenient location on the screen by dragging the title line.

To move an object:

1. Press the title (touch the pen firmly to the screen) and hold it there. Wait until the border turns dark to tell you it's ready to be moved.

2. Then, without lifting the pen, drag the item to its new location.

3. Lift the pen to complete the move.
Making an Object Bigger or Smaller

Notebook objects have handles that you can drag to expand or reduce your view of their contents. Some, such as option sheets, have only one handle at the bottom; others, such as the Stationery notebook, have both a bottom and corner handle.

If it has a corner handle:

1. Press the handle with the pen. You see an outline surrounding the handle, telling you it's ready to be resized.
2. Without lifting the pen, drag the handle to the right to widen it, down to lengthen it, or diagonally to increase it in both directions.
   ▲ Do the reverse to make it smaller.

If it has a bottom handle:

1. Press the handle with the pen. You see an outline surrounding the handle telling you it's ready to be resized.
2. Without lifting the pen, drag the handle down to lengthen the object, or up to shorten it.

When you resize an object, sometimes the information no longer fits within the borders. To bring hidden information into view, scroll the page by drawing a flick up \( \uparrow \) on the page or by tapping \( \downarrow \) the scroll arrows in the scroll margin. You can find a detailed explanation of scrolling in chapter 5, Creating and Using Documents.
The Bookshelf at the bottom of the screen holds tools and notebooks that you use for tasks such as creating new documents, choosing preferences, and installing applications.

Tap the Help icon to open it.

You see the Quick Help sheet and a button labeled Help Notebook.

While the Quick Help sheet is showing, you can get help about anything on the screen by tapping it. The contents of the sheet change according to what you tap.

To get more detailed help, organized by topic and task, tap Help Notebook.

Tap Done to close Quick Help.

"Getting Help" in this chapter gives more detail about how to use Quick Help and the Help notebook.
To learn more about the different options you can set, see “Setting Preferences” in chapter 9 (Managing the Notebook).
Tools contains accessories that you use in working with your Notebook.

1 Tap the Tools icon to open it.  
(You may see tools other than those pictured here if you've installed different ones on your computer.)

2 To see each tool, tap to open it.

The tools include:
- A Clock displays the time and date and also lets you set an alarm with a reminder message.
- A Personal Dictionary contains words that you add to it while proofing or checking the spelling of your work.
- Handwriting Customization contains sentences that you copy to show PenPoint how you write.
- A Letter Practice sheet lets you get used to writing on the screen.
- A software Keyboard lets you enter text into a document by tapping the keys.
- A Disk Manager allows you to transfer documents to and from the Notebook.
- A Printers sheet lets you configure the printers you’ve installed.

3 To close a tool, tap its close corner or the Close button.

4 To close Tools, tap its close corner—the triangle in the upper left hand corner.

See “Working with Notebook Objects” in this chapter for information about how to move, resize, and close the tools.
Chapter 9, Managing the Notebook tells you more about Tools in general. You’ll find an explanation of how to use each individual tool in the appropriate section of this manual:

- Clock: “Using the Clock” in chapter 9 (Managing the Notebook).
- Letter Practice: “Learning to Write on the Computer Screen” in chapter 6 (Writing in the Notebook).
- Handwriting Customization: “Customizing Your Writing” in chapter 6 (Writing in the Notebook).
- Keyboard: “Using a Keyboard” in chapter 6 (Writing in the Notebook).
- Disk Manager: “Displaying the Disk Manager” in chapter 11 (Filing Documents).
- Printers: “Setting up Printers” in chapter 4 (Installing Applications and Devices).
1 Tap \( \rightarrow \) the Stationery icon to open it.

You see the Stationery notebook’s table of contents.

The Stationery notebook contains pieces of stationery for the different applications you’ve installed. Each application has its own section in the Stationery notebook.

2 Tap \( \rightarrow \) the close corner to close the Stationery notebook.

1 Tap \( \rightarrow \) the Disks icon to open the Disk Manager.

If you have connected the PenPoint computer to a disk drive, you see an icon with the name of the disk. Tap \( \rightarrow \) the icon to see what’s on the disk.

Use the Disk Manager to transfer documents to and from the Notebook.

2 Tap \( \rightarrow \) the close corner to close the Disk Manager.

Read chapter 5, Creating and Using Documents, to find out how to use stationery. Chapter 11, Filing Documents, explains how to transfer documents with the Disk Manager.
1 Tap the Keyboard icon to open the software keyboard so you can tap to add text to a document.

2 Tap the close corner to close the keyboard.

---

1 Tap the Install icon to open the Installer.

You see a sheet showing you what’s installed in the computer. Each install sheet contains information about a different category.

2 Tap the arrow on the title line to see a list of the install sheets.

▲ Tap the name of the install sheet you want to see.

3 Tap the close corner to close the Installer.

To find out how to use the keyboard, see “Using the Keyboard” in chapter 6 (Writing in the Notebook). Chapter 4, Installing Applications and Devices, explains how to use the Installer to copy applications, fonts, and other utilities to your Notebook.
In Box and Out Box

When you finish working with a document, you can send it to someone or print it. If you’re not connected to a printer or modem when you choose the Print or Send command from the Document menu, PenPoint places the documents in the Out box. After you connect the computer to the equipment, you can automatically print or send the documents in the Out box.

The In box stores incoming documents such as faxes and electronic mail.

You open the In or Out box the same way. This example shows the Out box.

1 Tap the Out box icon to open it.

The documents you’ve asked PenPoint to print or send are listed under the service you’ve installed.

The Out box remains empty until you install the appropriate service and choose the Send or Print command.

2 Tap the close corner to close the Out box.

Read chapter 10, Printing, Sending, and Receiving Documents, to learn how to use the In and Out box.
When you choose a menu command that’s followed by an ellipsis (three dots) you see a dialog or option sheet.

Dialog sheets prompt you for further information before carrying out the command. For example, when you choose Find, you’ll see a dialog sheet that asks you what to find. You fill in the requested information by writing in a text field or by choosing options. When you have finished, tap the appropriate button, and PenPoint carries out the command.

Option sheets allow you to set attributes for a document or for a selection in a document. For example, you can choose an option that prevents a document from being accidentally deleted or choose a font style for the text in a document.

This section tells you how to use the option and dialog sheets. You can find more information about what’s on them under the appropriate topic elsewhere in this book. For example chapter 8, Finding and Replacing Text, explains what’s on the Find dialog sheet.
Displaying Option Sheets

To display an option sheet, you choose a menu command or draw a check ✓ on an object.

Some option sheets have more than one sheet. For example, Text options include Character, Paragraph, Tab Stop, and View option sheets. An arrow on the title line tells you there's more than one sheet. Tap ➝ it to see a list of the other ones.

To display a text option sheet:

1. Draw a check ✓ on a word to display the text option sheet for it.
2. Tap ➝ the arrow on the title line to see a list of the other sheets.
3. Tap on the one you want to see.
4. Reposition the option sheet by dragging anywhere on the gray border or on the title line.
Choosing Options

After displaying an option sheet, you choose options from a check list, multiple check list, or pop-up menu. Sometimes you write information in fields. For example, on the paragraph option sheet you might write the number of inches to indent the first line of a paragraph.

Once you’ve chosen the options, you tap the Apply button to apply the options. If you’re selecting options from more than one sheet, be sure to tap the Apply button to accept the options before going on to another sheet.

To choose an option from a pop-up list:

- Tap the arrow next to the option to see the other options.
- Tap to select another option.

You can also choose options from check lists and multiple check lists:

- A check list has a single line which indicates that you can only choose one option from it; tap to make a choice.
- A multiple check list has a double line next to it which indicates that you can choose more than one option. Tap each one you want. If you change your mind, tap again to clear your choice.
Option sheets may also have text fields in which you write information.

- Enter text by writing on the line.
- If something is already written there, draw a cross out $\times$ through the text and write in the new text.

After making your choices or filling in the information, tap the appropriate action button:

- To apply your choices and continue using the sheet, tap Apply.
- To apply the changes and close the sheet, tap Apply & Close.
- To close the sheet without applying the choices, tap Close.

If the option sheet covers up something you want to see on the page, you can reposition it by dragging its title line, or resize it by dragging the corner or bottom handle as explained in the section “Working with Notebook Objects” earlier in this chapter.

Option sheets show you the current settings for what you’ve selected. On a pop-up list, the choice that’s showing is the current setting.

On a multiple check list, a gray checkmark tells you which option is currently set. When you select a new option, PenPoint displays a black checkmark next to it. (If an option is unavailable, the label is dimmed, and you won’t be able to choose it.)

Tapping Apply applies only what you’ve changed.

To find out how to edit text in fields, see chapter 7, Editing and Formatting Text.
Using Dialog Sheets

Dialog sheets work like option sheets, but their purpose is slightly different. Option sheets set the attributes of a selection or document. Dialog sheets ask you for information that's needed before carrying out a command, such as what text to find.

You display dialog sheets and enter information on them the same way you do option sheets. That is:

- To display a dialog sheet, choose a command or draw an equivalent gesture. For example, to check the spelling in a document, you can choose Spell from the Edit menu or draw an $S$ on the document title line.
- Display the choices on a pop-up list by tapping it; tap to choose one.
- Choose an option on a check list by tapping it.
- Choose one or more options on a multiple check list by tapping them; tap an option again to deselect it.
- Enter information in a field by writing in it.
- Reposition it by dragging its title line.
- Resize it by dragging the corner or bottom handle.

After choosing options or filling in the requested information, tap the appropriate button. For example, on the Find dialog sheet, tap the Find button to find the next occurrence of the text you asked PenPoint to locate.
COPYING AND MOVING NOTEBOOK OBJECTS

You can choose commands from the Edit menu or draw equivalent gestures to copy or move:

- a document to another location in the Notebook
- information to another place on the page or to a different page
- items on the Bookshelf to another location on the Bookshelf.

To move an icon on the Bookshelf:

1. Use the press gesture. Put the pen down on the icon and hold it there until you see a marquee an animated line surrounding the icon.

   (If you decide not to move it, tap the icon.)

2. Without lifting the pen, drag the icon to the new location.

   ▲ Lift the pen to complete the move.
To copy a sentence from one page to the following page:

1. Triple tap \( \text{key} \) anywhere in the sentence to select it.
   - Barely lift the pen between taps.

2. Tap press \( \text{key} \) the selected sentence.
   (Tap the selection and then immediately press until you see a double line marquee.)
   - Barely lift the pen between the tap and the press.
   - When you copy or move more than a line of text, PenPoint surrounds a few characters of the selected text in a marquee to make it easier to drag.

   Tap the page turn arrow to turn to the next page. When you turn to the page, the text in the marquee follows.

3. Drag the text in the marquee to the new location.
   - PenPoint inserts it where you lift your pen.

To find out more about copying or moving information in documents, read chapter 5, Creating and Using Documents. See Managing the Notebook (chapter 9) for information on how to rearrange documents on the Table of Contents. That chapter also contains information about different methods for turning pages.

You can also select what you want to move or copy, and then choose the appropriate command from the Edit menu. Once you see the marquee, you can drag it to its new location.
Getting Help

You can get two kinds of help from PenPoint: Quick Help and the Help notebook. Use Quick Help when you see something on the screen you want to know more about, and the Help notebook when you want to look up a topic.

Getting Quick Help

Quick Help briefly describes the part of the Notebook or page you asked about.

1. Tap the Help icon on the Bookshelf to see the Quick Help sheet.
   ▶ You’ll see instructions on using the Quick Help sheet.

2. Tap on the part of the Notebook or page you want information about.
   ▶ You see a brief description. Some explanation include a list of gestures you can use in this area.

3. Tap Done to close Quick Help.
   ▶ Or, if you want to use the Help Notebook, tap Help Notebook to open it and close Quick Help.

If the information doesn’t fit on the Quick Help sheet, you can bring the hidden part into view by scrolling it. Draw a flick up on the sheet or press the bottom scroll arrow in the scroll margin. See “Scrolling a Document” in chapter 5 (Creating and Using Documents) for information about scrolling documents.
Using the Help Notebook

The Help notebook organizes information topically so that you can find out how to use different features of PenPoint, the computer, or the applications you've installed on it. You can continue working while displaying the Help notebook.

1. Double tap the Help icon on the Bookshelf.
   ▲ Or, tap the icon to open Quick Help and then tap Help Notebook.

   You'll see the Help table of contents.

2. Double tap a section title to see the topics, as you would in the Notebook Table of Contents.
   ▲ Or, tap the page number for a section to see the section table of contents.

3. Tap the page number of the topic you want to see.

4. Tap the close corner to close the notebook.
   ▲ The next time you use it, the Help notebook opens to the last page you used.

To move the notebook to see what's below it, press the title line and hold until you see the border darken, and then drag the notebook.
CHAPTER 3

Drawing
Gestures
Using Gestures

You use gestures to give commands to PenPoint and to edit text in a document or text field. Most gestures have corresponding menu commands, but you'll find that the gesture is usually faster.

This chapter contains gesture profiles which tell you what each gesture does and how it works. The gesture profiles are in alphabetical order. For quick reference, you can look in the table at the beginning of the chapter. It lists the gestures by their functions (such as copying and moving things). You'll also find there a table of the core gestures—the ones you'll most often use.

PenPoint recognizes gestures the same way it does your handwriting. Thus you'll get the best results if you draw gestures with a light, firm touch, and make clean lines free of hooks or extensions. The gesture is complete when you lift your pen away from the screen or pause for more than a few seconds. If a gesture has more than one part (a double flick, for example), keep the pen very close to the screen, and complete the gesture quickly.

You can set the amount of time that PenPoint gives you between lifting the pen tip and recognizing a gesture by choosing a number for the Timeout category in Preferences.

If you draw a gesture and PenPoint doesn't recognize it, you'll see a small starburst. If the gesture is correct, but you've tried to use it somewhere it won't work, you'll see a series of concentric circles on the screen.

Programs you install in your Notebook may add their own gestures. Refer to those guides for more information.
We’ve used several conventions in these gesture profiles which should help you:

- The drawing in the box shows how big the gesture should be in relation to letters on the screen.

- The letters in the box rest on a baseline. This should help you draw the gestures correctly above or below the line of text on the screen.

- If the direction of a stroke is important one end will be thicker than the other. Start drawing the gesture where you see the thicker line, and draw in the direction of the line’s tapering.

- The drawings for gestures that involve tapping or pressing include a symbol for the pen tip. For example, the symbol for double tap shows two dots and the pen tip. Whenever you use more than one tap, or tap and then press, make sure you make all the taps or the tap and press in the same spot on the screen.

- For detailed instructions on how to draw each gesture, read the section “What Works” in each gesture profile.
This table briefly describes PenPoint gestures by function and location. The gestures are arranged alphabetically within each category. Some gestures work in several places, and so are repeated in several categories. The categories are:

- Basic Gestures
- Copying and Moving Text & Objects
- Deleting Text & Objects
- Editing Text in Documents
- Editing Text in Edit Pads
- Editing Text in Boxed & Ruled Writing Pads
- Editing Overwrite Fields on Forms
- Editing Fill-in Fields on Forms
- Getting Help
- Working with Embedded Documents
- Scrolling
- Setting Options for Documents, Text, & Objects
- On the Bookshelf
- In the Document Title Line
- On Notebook Tabs
- In the Scroll Margin
- In the Table of Contents

Basic Gestures (continued)

- Bracket left selects text or adjusts the selection.
- Bracket right selects text or adjusts the selection.
- Caret opens a writing pad or creates a document.
- Check displays options for selected text or objects.
- Circle opens an edit pad.
- Cross out deletes selected text or objects.
- Flick scrolls a Notebook page or pop-up list.
- Insert space adds a blank space in text or boxed pads.
- Pigtail deletes a character in text or boxed pads.
- Press sets an insertion point or gets text or an object ready to move.

Copying and Moving Text & Objects

- Press and drag moves a selection or object.
- Tap press and drag copies a selection or object.

Deleting Text & Objects

- Cross out deletes words, selected text and objects in documents or tables of contents.
- Line through deletes characters in edit pads.
- Scratch out deletes words in text and ruled writing pads.
- Pigtail deletes one character in text and pads.
DRAWING GESTURES

Editing Text in Documents

Arrow up or down increases or decreases the size of a word or selected text.

Bold makes words or selected text bold.

Bracket left selects the word to the right of the bracket; extends or reduces selections.

Bracket right selects the word to the left of the bracket; extends or reduces selections.

Caret opens a small writing pad.

Caret tap opens a large embedded writing pad.

Check displays options for the selected text.

Check tap displays options for an embedded document.

Circle opens an edit pad for a word or text selection.

Circle line opens a blank edit pad so you can replace a word or text selection.

Cross out deletes words and selected text.

Double caret creates an embedded document.

Double flick left or right scrolls to the extreme right or left of a document.

Double flick up or down scrolls to the bottom or top of a document.

Double tap selects a word.

Find searches for a specific word in a document or selection, and allows you to replace it.

Flick left or right scrolls to the right or left of the screen.

Flick up or down scrolls a line to the top or bottom of the screen.

Hyperlink (circle tap) creates a hyperlink button.

Insert space adds a space.

Initial caps formats text with initial capital letters.

Insert character opens a box for adding a single letter.

Insert tab inserts a tab.

Italics italicizes words or selected text.

Insert space adds a space.

Clean makes a word or selection plain text.

New line inserts a line break.

New paragraph inserts a paragraph break.

Normal makes a word or selection plain text.

Pigtail deletes one character.

Press and drag selects text.

Proof displays alternate spellings of a word.

Quadruple tap selects a paragraph.

Scratch out deletes words.

Spell checks the spelling of a document or selection.

Tap selects one character.
USING PENPOINT

Editing Text in Documents (continued)

Triple tap selects a sentence.
Underline underlines words or selected text.
Upper case formats text as upper case.

■ Editing Text in Edit Pads
Insert space adds one or more spaces.
Line through deletes characters.
Pigtail deletes one character.
Press makes a character box active.

■ Editing Text in Boxed & Ruled Writing Pads
Insert space adds one or more spaces.
Line through deletes characters in boxed pads.
Pigtail deletes one character.
Press makes a character box active.
Scratch out deletes characters in ruled pads.

■ Editing Overwrite Fields on Forms
Insert space inserts one or more spaces.
Line through deletes the characters beneath the gesture.
Pigtail deletes a single character.

Scratch out deletes the characters beneath the gesture.

■ Editing Fill-in Fields on Forms
Caret opens a writing pad.
Circle opens an edit pad.
Cross out deletes the contents of the field.
Double tap selects the contents of the field.
Insert space inserts a space.
Pigtail deletes a character.
Press sets an insertion point for keyboard entry.
Press and drag moves text from one field to another.
Scratch out deletes the contents of the field.
Tap press and drag copies text from one field to another.
Tap opens an edit pad.

■ Getting Help
Double tap on the Help icon opens the Help Notebook.
Question Mark on icons, option sheet controls, and other objects displays Quick Help.
Tap on the Help icon opens Quick Help.
DRAWING GESTURES

- **Working with Embedded Documents**
  - Borders hides the borders.
  - Check tap displays options when borders are hidden.
  - Double caret creates an embedded document.

- **Scrolling**
  - Double flick left or right scrolls to the extreme right or left of a document.
  - Double flick up or down scrolls to the bottom or top of a document.
  - Flick left or right scrolls the document right or left.
  - Flick up or down scrolls a line to the top or bottom of the screen.

- **Setting Options for Documents, Text, & Objects**
  - Check displays options.
  - Check tap displays options for an embedded document when borders are hidden.

- **On the Bookshelf**
  - Caret opens the pop-up Create menu to create a document or notebook.
  - Check displays options for a Bookshelf icon.
  - Circle opens an edit pad for the title of an icon.
  - Cross out deletes a Bookshelf icon.

  - Hyperlink (circle tap) creates a hyperlink button.
  - Plus selects Bookshelf icons.
  - Press and drag moves Bookshelf icons.
  - Tap opens an item on the Bookshelf.
  - Tap press and drag copies a Bookshelf icon.

- **In the Document Title Line**
  - Borders hides a document's borders and menus. To show them again, check tap \( \checkmark \) in the document and use the Access option sheet.
  - Check displays options for the document.
  - Circle opens an edit pad for the document title.
  - Cork margin shows or hides the cork margin.
  - Cross out deletes the document.
  - Find searches for a specific word in the document and lets you replace it.
  - Flick up or down zooms or reduces the page view, if that preference is set.
  - Menu shows or hides the document's menu line.
  - Press and drag moves a floating document.
  - Tab shows or hides a document's Notebook tab.
On Notebook Tabs

- **Double tap** floats a document, if that preference is set.
- **Circle** opens an edit pad for the tab's name.
- **Double flick up** or **down** moves overlapped Notebook tabs to the top or bottom of the column.
- **Flick left** on any Notebook tab displays all the tabs at once.
- **Flick up** moves a Notebook tab up to show the overlapped tab below. Or **flick down** reveals an overlapped tab.

In the Scroll Margin

- **Flick left** or **right** scrolls to the right or left.
- **Flick up** or **down** scrolls a screen length to the top or bottom.
- **Double flick left** or **right** scrolls to the far right or left of a document.
- **Double flick up** or **down** scrolls to the bottom or top of a document.

In the Table of Contents

- **Caret** opens the pop-up Create menu to create a new document.
- **Check** displays options for the document.
- **Circle** opens an edit pad for the document title.
- **Cross out** deletes the document.
- **Double flick left** or **right** scrolls to the far right or left of the Table of Contents.
- **Double flick up** or **down** scrolls to the bottom or top of the Table of Contents.
- **Double tap** expands or collapses section contents. On a page number it floats a document, if that preference is set.
- **Flick left** or **right** scrolls to the right or left.
- **Flick up** or **down** scrolls a line to the top or bottom of the screen.
- **Hyperlink** (circle tap) creates a hyperlink button.
- **Press and drag** on a document title moves the document.
- **Tap** on a document's page number or icon turns to that page; on a document title selects the document.
- **Tap press and drag** on the document title copies a document.
DRAWING GESTURES

Arrow Up  Increases the point size of a word or text selection.
Arrow Down  Decreases the point size.

What Works
Use two strokes to draw an arrow.
1  Draw the arrow tip.
2  Then barely lift the pen and quickly draw the arrow shaft.
Be sure to make the arrow tip in one stroke from left to right.
The tip of the arrow must touch the word you want to change.

What Doesn’t Work
Arrows made with one stroke.
Pausing too long between strokes.
Targeting incorrectly.
Too much angle on the arrow shaft.
Making a loop at the arrow tip.
Starting the arrow tip from the right.
Cluttering the gesture with extra hooks or wiggles.

Bold/Borders  Makes text bold.
Hides an embedded document’s border.

To Make Text Bold
Make an uppercase B over the word or selected text that you want to appear as bold text.

Bold one word. ———> Bold one word.
Bold an entire selection. ———> Bold an entire selection.

To Hide an Embedded Document’s Borders
Make an uppercase B in the title line of the embedded document.

What Doesn’t Work
Making the B so that most of the gesture is above or below the line.
Putting the B over part of a word other than the one you want to format.
Making the B too much outside the selection.
Making the B in a different way than you did in Handwriting Customization.
Bracket, Left  Selects text

- If no text is selected, a left bracket drawn anywhere on a word selects it. If there's already a text selection and you draw the bracket facing the selection, the selection gets extended to the bracket. If you draw it on a word that's part of an existing selection, it reduces the selection to that word.

What Works

Draw it in one stroke. Start at the top and draw three sides of a rectangle, leaving it open to the left.

Selects a \textit{word} \quad \Rightarrow \quad \text{Selects a \textit{word}}.

Adjusts \textit{a selection} \quad \Rightarrow \quad \text{Adjusts \textit{a selection}}.

Bracket, Right  Selects text

- If no text is selected, a right bracket drawn anywhere on a word selects it. If there's already a text selection and you draw the bracket facing the selection, the selection gets extended to the bracket. If you draw it on a word that's part of an existing selection, it reduces the selection to that word.

What Works

Draw it in one stroke. Start at the top and draw three sides of a rectangle, leaving it open to the right.

Selects a \textit{word} \quad \Rightarrow \quad \text{Selects a \textit{word}}.

Adjusts \textit{a selection} \quad \Rightarrow \quad \text{Adjusts \textit{a selection}}.
Caret

Opens a small writing pad in text for adding a word.

What Works

Starting the gesture at the lower left, draw a slanted line up and then down to the right. The caret tip must point at the space between words.

A writing pad pops up above the tip of the gesture. New text appears at that same point.

What Doesn’t Work

Making two strokes.

Creating a loop at the tip.

Starting on the right side of the caret.

Cluttering the gesture with extra hooks or wiggles.

Where It Works

In a table of contents, a cork margin, or the Bookshelf, opens the Create menu to create new documents.

Caret Tap

Opens an embedded writing pad in text.

What Works

1. Starting the gesture at the lower left, draw a slanted line up and then down to the right. The caret tip must point at the space between words.

2. Barely raising the pen, quickly tap over the caret tip to complete the gesture.

The caret tip sets the insertion point for the new text.

Opens up a large writing pad.

What Doesn’t Work

Tapping too far off-center.

Making the tap too far inside the caret.

Lifting the pen tip too far before tapping.
USING PENPOINT

Check  Displays options for a word, object, or selection in text.

■ What Works
Draw the check in one gesture, with the beginning of the first downward stroke on the word or selection whose options you want to see.

✓  or  ✓

■ Where It Works
Displays options for objects and icons.
When you draw it in the title line of a document or accessory you see options for that thing.

Check Tap  Displays options for an embedded document when you’ve hidden its borders and title line.

■ What Works
1 Anywhere in the embedded document, draw the checkmark in one stroke.
2 Then, barely lifting the pen, quickly make a tap just to the right of it.

■ What Doesn’t Work
Drawing the checkmark at a horizontal or vertical angle. ✓
Hooked lines. ✓
Tapping in the middle or beneath the check mark. ✓
Lifting the pen too far before tapping.
Circle

Opens an edit pad for a word or selection in text, text fields, and labels.

- **What Works**
  Start at the top of the character, word, or series of words that you want to edit.
  Draw a neatly closed, counter-clockwise circle. Ovals also work.

- **What Doesn’t Work**
  - Not starting the circle from the top.
  - Overlapping parts of the circle too much (overlapping a little is okay).
  - Not closing the circle.

A

Ovals work too.

An edit pad appears containing the circled characters, word, or words.

- **Where It Works**
  Opens an edit pad for a document title, or a label on a tab, icon, or hyperlink button.

Circle Line

Opens a blank writing pad to replace a word or selection in text.

- **What Works**
  1. Over the word or within the selection that you want to replace, draw a circle or oval.
  2. Then, barely lifting the pen from the screen, quickly make a horizontal line across the middle of the circle.

- **What Doesn’t Work**
  - Lifting the pen too far before drawing the line.
  - Pausing too long between drawing the circle and the line.
  - Not making the circle correctly. (See circle gesture.)
  - Too much angle on the horizontal line.

- **On a single word:**
  A plain circle gesture opens a pad filled with text. A circle-line gesture opens a blank pad.

- **On a selection:**
  A plain circle gesture opens a pad filled with text. A circle-line gesture opens a blank pad.

- You may begin the line from either the right or left.
Circle Tap  Creates a hyperlink button.

**What Works**

1. First select the text, document, or object that you want the button to link to.
2. Make a circle where you want the hyperlink button to appear.
3. Then, barely lifting the pen, tap in the center of the circle.
   The link button will appear where you make the tap.

**Where It Works**

You can create hyperlink buttons almost anywhere, including documents, cork margins, and on the Bookshelf.

---

Cork Margin  Shows or hides the cork margin at the bottom of a document.

**What Works**

Make an uppercase C in the title line of the document.

**What Doesn't Work**

- Tapping outside the circle.
- Not making the circle correctly. (See circle gesture.)
- Pausing too long between drawing the circle and tapping.
- Starting with a loop at the top of the C.
- Closing it so much that it's interpreted as a circle.
**DRAWING GESTURES**

**Cross Out**  Deletes a word or selection in text, or any object directly beneath the X.

- **What Works**
  Make an X using two distinct strokes (top to bottom) over the selection or object that you want to delete.

  1. Draw the first stroke; barely lift the pen from the screen
  2. Quickly draw the second stroke.

- **Where It Works**
  Deletes the contents of a field, documents from the Table of Contents, and icons from the Bookshelf. When you draw it over a document's title line, it deletes the document. When you draw it over a disk icon or disk name in the Disk Manager, it ejects the disk.

**Double Caret**  Displays the Create menu to create a document embedded within an existing document.

- **What Works**
  Two carets, one nested beneath the other. (Either upper or lower can be made first.)

  1. Each caret gesture should be drawn from left to right with one stroke.
  2. After drawing the first caret, barely lift the pen from the screen and quickly draw the second caret.

- **What Doesn't Work**
  - Drawing the gesture in one stroke (connecting the two lines).
  - Drawing strokes that are not clean lines.
  - Making a + instead of an X.
  - Using more than two strokes to make the two carets.
  - Making either caret from right to left.
  - Making strokes with extra hooks or wiggles.
  - Lifting the pen tip too far before making the second caret.
  - Pausing too long between drawing the second caret.

  Too much overlapping.
  Too much space between carets.
DOUBLE FLECK LEFT  Scrolls to the left edge of a document.

DOUBLE FLECK RIGHT  Scrolls to the right edge.

**What Works**

1. Start the first flick on the column where you want the scroll to begin and draw a short, straight line, making a snappy flick with your pen.

2. Barely lift the pen tip and quickly make a second flick.

Flick left to scroll to the right edge; flick right to scroll to the left edge.

- Make your flicks as if you’re pushing a real piece of paper with them.

**Where It Works**

You can flick anywhere in a document (except draw and paint documents) including tables of contents.

**What Doesn’t Work**

- Flicks that are at odd angles or made in different directions.
- Lifting the pen too far or taking too long before making the second flick.
- Hooks at the beginning or end of flicks.
- Touching the screen and pausing before flicking.

DOUBLE FLECK UP  Scroll to the bottom of a document.

DOUBLE FLECK DOWN  Scrolls to the top.

**What Works**

1. Start the flick on the line where you want the scroll to begin and draw a short, straight line, making a snappy flick with your pen.

2. Barely lift the pen tip and quickly make a second flick.

Flick down to scroll to the top of the document; flick up to scroll to the bottom of the document.

- Make your flicks as if you’re pushing a real piece of paper with them.

**Where It Works**

You can flick anywhere in a document (except draw and paint documents) including tables of contents.

**What Doesn’t Work**

- Flicks that are at odd angles or made in different directions.
- Lifting the pen too far or taking too long before making the second flick.
- Hooks at the beginning or end of flicks.
- Touching the screen and pausing before flicking.
DRAWING GESTURES

Double Tap

Selects a word in text.
Expands or collapses sections in the Table of Contents.
Floats a page (if that preference is set).

What Works

Touch the screen firmly twice in the same spot, barely lifting the pen between taps. Then lift the pen.

Double tap on a word to select the word.

What Doesn't Work

Lifting the pen tip too far between taps.
Pausing between taps.
Tapping on two different objects or words.

Double tap on a section title in the Table of Contents to show documents in the section.

Where It Works

Double tap on a word to select the word. Double tap on a section title in the Table of Contents to show section contents. On a table of contents page number, floats the page. On a tab, floats the tabbed page. On a hyperlink button floats the page attached to the hyperlink button.

Eject/Export

In the Disk Manager, ejects a floppy disk.
In a Table of Contents, exports a document.

What Doesn't Work

Making the E differently from the way you practiced it in Handwriting Customization.

In the Disk Manager

Make a capital E over the disk icon or disk label.

In a Table of Contents

Make a capital E over the title of the document you wish to export. A double marquee appears around the document title. Then, drag it to the Disk Manager to export it.

Where It Works

Over the Disk Manager icon on the bookshelf.
**USING PENPOINT**

**Find**

Opens a dialogue sheet that lets you search a document or selection for a specified word, and replace it with another word.

**What Works**

Make an upper case F over the document or selection you want to search. Use three strokes even if you didn’t practice F’s that way in Handwriting Customization.

- Keep the pen tip close to the screen while making the gesture.
- Used in a title line, the gesture searches the entire document.
- Used within a document, it searches from that point to the end.
- Used anywhere in a selection, it searches the entire selection.

**Flick Left**

Scrolls documents right.
On the document title line, turns to the next page.

**Flick Right**

Scrolls documents left.
On the document title line, turns to the previous page.

- A flick left on a column moves that column to the left edge of the screen, revealing more of the right side of the page.
  On the title line it turns to the next page.
- A flick right on a column moves that column to the right edge of the screen, revealing more of the left side of the page.
  On the title line it turns to the previous page.

**What Works**

Draw a short, straight line making a snappy flick with your pen.
- Make your flicks as if you’re pushing a real piece of paper with them.

**What Doesn’t Work**

- Gestures that are at odd angles.
- Curved gestures.
- Hooks at beginning or end of flicks.
- Touching the screen and pausing before starting to flick.

**Where It Works**

In a notebook with overlapped tabs, flick left displays all of the tabs in columns. Any gesture puts them back into one column.
DRAWING GESTURES

Flick Up  Scrolls documents up.
Flick Down  Scrolls documents down.

- Scrolls documents up and down to reveal the portion not on the screen.

What Works

Draw a short, straight line, making a snappy flick with your pen. Think of it as pushing a piece of paper.

- A flick up moves the line next to it to the top of the screen, revealing more of the bottom of the page.
- A flick down moves that line to the bottom of the screen, revealing more of the top of the page.

Where It Works

A flick up on a pop-up list shows the next choice; flick down shows the previous choice. A flick up in the title line of a document zooms the page (if that preference is set). Flick on an overlapped Notebook tab to see the one below.

Initial Caps  Capitalizes a word or selection.

What Works

Starting within the word you want to format with an initial capital letter, draw a horizontal line left-to-right through most of the word, then complete the gesture with a short line up (90 degrees).

- The right angle should be made before you reach the end of the word.

What Doesn't Work

- Odd angles.
- Curves.
- Hooks.
- Touching the screen and pausing before starting to flick.

What Doesn't Work

- Making the gesture in two strokes.
- Making the gesture at odd angles.
- Underlining the words with the horizontal line instead of drawing it through the words.
Insert Character  Opens a single-character writing pad.

- **What Works**
  Beginning where you want to insert a character, draw a short line up and, without lifting the pen, complete the gesture with a short line to the right (90 degrees).
  - The place where the pen tip first touches the screen determines the insertion point.

  ![Insert Character Diagram]

- **What Doesn't Work**
  - Not 90 degrees. (The gesture must be made at a right angle to the text line.)
  - Starting the gesture too far below the text line.

Insert Space  Adds one or more spaces in boxed pads.
Inserts one space in text.

- **In Boxed Pads**
  1. Begin in the middle of the character box before which you want the space.
  2. With one stroke, draw a line down and then right.
  3. End the gesture below the next box to the right.
  - Think of it as pushing the character in the box one space to the right.

  Make the bottom line the length of one character box if you want to insert one space, two to insert two spaces, and so forth.

![Insert Space Diagram] (continued)
In Text

Draw a short line down and, without lifting the pen, complete the gesture with a short line to the right (90 degrees), ending just below the text line where you want the space.

- The beginning of the gesture sets the insertion point.
- For the best results, start the gesture in the middle of the line.
- If you’re inserting a space between characters, be precise about starting the gesture directly between them.
- To insert more than one space repeat the gesture.

What Works

1. Draw a short line down and, without lifting the pen, complete the gesture with a short line to the right (90 degrees), ending just below the text line where you want the tab.
2. Then, barely lifting the pen, make a flick right just below the horizontal line.
- The flick should be parallel to and about the same length as the horizontal line.
- Drawing this gesture through a character can split a word.

This gesture inserts a tab where you first put the pen down.

What Doesn’t Work

- Making the gesture in two strokes.
- Making the gesture at odd angles.
- Not using a right angle.
- Tilting.
- Pausing too long between strokes.
- Lifting the pen point too far from the screen.
- Making the flick in the wrong direction.
- Starting the gesture too high.

Insert Tab

Inserts a tab into a text document. The text following the gesture moves to the next tab stop.
Italic  Makes text italic.

What Works
Make an uppercase I over the word, sentence, or selected text that you want to italicize. Use three strokes, even if you didn’t practice the I that way in Handwriting Customization.

Italicize one word. ———> Italicize one word.

Italicize an entire selection. ———> Italicize an entire selection.

Line Through (Pads)  Deletes translated characters from character boxes (multiple characters only).

- Line through won’t work on a single character.
  Use a pigtail to delete single characters.

What Works
Draw a horizontal line from left to right though the letters you want to delete.

Line Through (Pads)  Deletes translated characters from character boxes (multiple characters only).

- Line through won’t work on a single character.
  Use a pigtail to delete single characters.

What Works
Draw a horizontal line from left to right though the letters you want to delete.

What Doesn’t Work
Making most of the I below the line.
Drawing over a part of a word other than the one you want to italicize.
Going too far outside the selection.
Failing to use three strokes. (A one-stroke I will be interpreted as a flick.)
Lower Case

Formats a word or selected characters as lowercase.

- **What Works**
  Starting within the word you want to make lowercase, draw a horizontal line left-to-right, through most of the word, then complete the gesture with a short line down (90 degrees).
  - The right angle should be made before you reach the end of the word.

CONVERTS TO LOWERCASE

- **What Doesn't Work**
  - Making the gesture in two strokes.
  - Making the gesture at odd angles.
  - Underlining the words with the horizontal line instead of drawing it through the words.

Menu

Hides or displays the menu line.

- If you want more room on the screen for documents, you can hide the menu line by making the M gesture in the document title line.
- When you need the menus again, the M gesture in the title line redisplays them.

- **What Works**
  Make a capital M in the title line of the document.

- **What Doesn't Work**
  - Making the M differently from the way you practiced it in Handwriting Customization.

New Line

Inserts a line break into text without beginning a new paragraph.

- **What Works**
  1. Draw a short line down and, without lifting the pen, complete the gesture with a short line to the left (90 degrees), ending just below the text line where you want the line break.
  2. Then, barely lifting the pen, quickly make a flick left just below the horizontal line.
  - The flick should be parallel to and about the same length as the horizontal line.

This gesture inserts a line break where you first put the pen down. It does not start a new paragraph.

- **What Doesn't Work**
  - Taking more than two strokes to make the gesture.
  - Pausing too long between strokes.
  - Making the gesture at odd angles.
  - Lifting the pen too far above the screen before making the flick.
  - Making the flick in the wrong direction.
USING PENPOINT

New Paragraph

Inserts a paragraph break in text.

What Works

Draw a short line down and to the left where you want the paragraph break. The line to the left should be at 90 degrees to the line down, and it should end just below the text line.

The beginning of the gesture sets the insertion point.

Start in the white space between words and use one unbroken stroke.

Use it to insert a break. To start a new paragraph...

What Doesn’t Work

Not drawing the gesture at a right angle to the text line.

Making the gesture too much like a check.

Starting the gesture at the bottom.

Normal

Formats text as normal (plain), removing styles such as bold, italic, or underline.

What Works

Make an uppercase N over the word or selected text that you want to have appear in the normal format.

What Doesn’t Work

Drawing over part of a word other than the one you want to format.

Going too much outside the selection that you want to format.

Making the N in a different way than you did in Handwriting Customization.

Changes formatted text to normal.
Pigtail   Deletes individual characters in boxed pads, in text, or in text fields.

- **In Boxed Pads**
  
  Begin the line within the character box and extend it through the top of the box, ending with a loop.
  
  The loop is the key to differentiating this gesture from a flick, so don’t worry about the length of the “tail” you leave after the loop.

- **What Doesn’t Work**
  
  Ending the gesture inside the character box.
  
  Starting the gesture below the box.

- **In Text**
  
  Draw a vertical line with a loop at the top.
  
  For the best results:
  
  1. Begin the gesture on the character you want to delete. (The place first touched by the pen tip determines what is deleted.)
  2. Draw the vertical line, create the loop above the character, and end with a straight line.

  delete a single character

- **What Doesn’t Work**
  
  Ending with a circle.
  
  Beginning above the character.
  
  Starting with a loop.
  
  Drawing through several letters.
  
  Beginning below the character.
  
  Ending with a curved line.

- **Plus**   Selects or deselects hyperlink buttons, icons on the Bookshelf, embedded documents, and other objects.

- **What Works**
  
  Make two strokes at right angles, keeping the pen tip close to the screen between strokes.
  
  1. Start with the downward line.
  2. Draw the horizontal line from either direction.
  
  The gesture’s lines should intersect directly over the selection, icon, or button you want to select or deselect.

- **What Doesn’t Work**
  
  Making an X instead of a +.
  
  Not lifting the pen enough to separate the two parts of the gesture.
  
  Lifting the pen tip too far between drawing the two lines.
  
  Pausing too long between strokes.
  
  Hooks at the beginning or end of lines.
USING PENPOINT

Press

• Begins a move.
• Begins a drag-through selection of text.
• Sets an insertion point for keyboard insertion of text.

To Move an Object or Selection

1 Touch the object or selection with the pen tip. Hold the pen there.
2 Wait until you see a marquee around the object or selection. (It doesn't hurt to lift the pen once the selection is in move mode.)
3 Drag the object or selection to its destination.

An object will be moved to the precise point on the screen where you lift the pen.
Selected text will be moved to the precise point on the screen where you lift the pen or to the space between words that's nearest to the point where you lift the pen.

To Select Text

1 Touch the pen to the screen.
2 Wait for the first character to be highlighted.
3 Without lifting the pen, drag the pen to the last character you want to include in the selection.

Select more than one word.

To Set an Insertion Point in Text

1 Touch the screen between characters where you want to insert new text.
2 Press until an I-beam appears.
3 Then lift your pen away from the screen.

What Doesn't Work

- Tapping (lifting the pen away from the screen too quickly).
- Lifting the pen before the dashed line forms around the selection.
- Lifting before you finish dragging the selection or object.
To Set an Insertion Point in Boxed Pads

1. Touch the screen in the character box that you want to make current.

2. Press until it’s underscored (about one-half second).

3. Then lift your pen away from the screen.

**Where It Works**


**Proof**

Opens a proof sheet that includes alternate spelling and translation choices for a word in text.

**What Works**

Draw a capital P anywhere within the word or selection that you want to proof.

Proof this word only

**Quadruple Tap**

Selects a paragraph in text.

**What Works**

1. Touch the screen firmly four times, barely lifting the pen between taps. Tap on the same spot on the screen each time.

2. Then lift the pen away from the screen.

This gesture lets you select a whole paragraph.

You must be careful not to lift the pen too far from the screen between taps. Only lift the pen after quickly tapping four times.

After the paragraph is selected you can perform other actions, such as moving it, making it bold, or checking the spelling in it.

**What Doesn’t Work**

Making most of the P above or below the line. Proof this word only. Proof this word only

Drawing over a portion of a word other than the one that you want to proof.

Making the P in a different way than you did in Handwriting Customization.

Lifting the pen too far between taps.

Pausing between taps.
Using PenPoint

Question Mark Opens Quick Help.

- Drawing a question mark on some areas of the screen gets you Quick Help about that object. For Quick Help about most things, tap the icon for the Help notebook (on the Bookshelf).

- What Works
  - Draw a question mark over title lines, icons, or bold option labels on the left side of option and dialogue sheets to see Quick Help for the object.
  - For best results, draw the question mark so that the loop joins the stem over the center of the target.
  - Quickly draw the dot at the bottom of the stem.

- What Doesn’t Work
  - Drawing the question mark off the center of the object.
  - Failing to dot the question mark.
  - Making an elongated stem.

Scratch Out Deletes words in text; deletes one or more translated characters in boxed pads; deletes untranslated text in ruled pads.

- What Works
  - Three horizontal lines back and forth on top of each other without lifting the pen (a very compressed Z.)

- What Doesn’t Work
  - Trying to scratch out untranslated writing in character boxes.
  - Loose zigzags.
  - A continuous loop.
  - Disconnected lines.
  - Hooks at the end.
**Spell** Checks the spelling of a document or section.

- Used in a **title line** the gesture checks the entire document.
- Used within a **document**, it checks from that point to the end.
- Used anywhere in a **selection**, it checks the entire selection.

**What Works**
- To check the spelling of a selected word or sentence, make a capital S over the selection.
  - Checks one selected word.
  - Starts checking from any word.
  - Checks an entire selection.

**What Doesn't Work**
- Making the S so that most of the gesture is above or below the character line.
- Making the S too much outside the selection.

**Tab** Shows or hides Notebook tabs.

**What Works**
- With two strokes make an uppercase T in either the document title line or on the Table of Contents title.
- When a tab is showing, the T gesture hides the tab.
- When a tab is hidden, the T gesture displays it.

**What Doesn't Work**
- Crossing the T so that it looks like a +.
Tap  Selects or activates what you touch with the pen; in text, selects one character.

- **What Works**
  Touch the screen firmly, then quickly lift the pen.
  Wait a moment for the PenPoint computer to carry out your instructions.

- **Where It Works**
  Tap to choose menus, commands, and options. Tap to turn pages, open icons, select a character, or translate text.

- **What Doesn’t Work**
  Pressing too hard.
  Tapping repeatedly.
  Coloring in the tap.
  Hovering too close to the screen after tapping.
DRAWING GESTURES

Tap Press Begins a copy.

- **To Copy an Object or Selection**
  1. Tap and then quickly touch the object or selection with the pen tip. Hold the pen there. Tap and press in the same spot on the screen.
  2. Wait until you see a double marquee around the object or selection. (It doesn't hurt to lift the pen once the selection is in copy mode.)
  3. Drag the object or selection to its destination.

A double marquee will appear around your selection double marquee.

- The object will be copied to the precise point on the screen where you lift the pen.
- Selected text will be copied to the precise point on the screen where you lift the pen or to the space between words that's nearest to the point where you lift the pen.

- **Where It Works**

---

Triple Tap Selects a sentence in text.

- **What Works**
  Touch the screen firmly three times, barely lifting the pen between taps. Make the taps in the same spot on the screen. Then lift the pen away from the screen.

A triple tap has one function, only in text. Tapping three times selects a sentence.

- **What Doesn't Work**
  Lifting the pen too far between taps. Pausing between taps.

- **Where It Works**
  On a hyperlink button, retargets the button to the current selection. On Notebook tabs, makes the tab label the same as the document title. On option or dialogue sheets, restores the sheet to its default size.
**Underline**  
Underlines text.

- **What Works**
  Make an uppercase U over the word, sentence, or selected text that you want to appear underlined.

```
Underline one word.  ➔  Underline one word.
Underline an entire selection.  ➔  Underline an entire selection.
```

**Upper Case**  
Formats a word or selected characters as capital letters.

- **What Works**
  1. Starting within the word or selection that you want to format, draw a horizontal line left-to-right through most of the word or selection, then complete the gesture with a short line up (90 degrees).
  2. Barely raising the pen, quickly make a flick up beside it.

- **What Doesn’t Work**
  Making the gesture in more than two strokes.
  Pausing too long between strokes.
  Making the gesture at odd angles.
  Underlining the words with the horizontal line instead of drawing it through the words.
  Making the flick downward instead of upward, or at an odd angle.
Installing Applications and Devices
You use the Installer to add applications, fonts, device drivers, and services to your computer. (Device drivers are instructions for printers, plotters, and modems; services include electronic mail and information services.) You can also use the Installer to customize the Notebook by creating several versions of the basic handwriting profile, personal dictionary, and set of preferences that come with the PenPoint™ operating system.

When you install something, PenPoint remembers which disk (volume) it’s on. This location is called its home. When you copy something to home, you save all the changes you’ve made to the application or utility. For example, when you copy a printer driver to its home, you save all your setup information. Similarly, when you copy an application to its home, you save all the stationery for it, including any stationery you’ve customized.

If you no longer need to work with something you’ve installed, you can deactivate (temporarily remove) it and then reactivate it later when you’re ready to use it again. If you’ve copied it to its home before deactivating it, when you reactivate it, all your settings will be the same.
Finding Out What's Installed in the Notebook

When you first open the Installer, it shows you what's currently installed in the Notebook. You'll see a sheet for each category (such as Applications, Handwriting, and Fonts), which lists what's installed and tells you which one is currently in use.

To see the Handwriting Installer sheet:

1. Tap the Installer icon to open it.
   - If the Handwriting sheet isn't displayed, tap the arrow in the title line to see a list of the other Installer sheets and tap to choose it.

Name shows which profiles are installed.

Size tells you how big each one is.

Modified tells you if you've changed it since the last time you saved it.

Current shows which one is in use. Tap to choose another set.

2. Tap the close corner to close the Installer.
You install all the applications and utilities you keep on your computer in the same way. To install something, open the Installer, turn to the appropriate sheet, and choose **Install from Disk**. PenPoint opens a Disk Manager for the connected disk and lists the items it finds on the disk for that category. Choose one by tapping it.

To install an application:

1. Connect the PenPoint computer to a disk drive and insert the disk which contains the application you want to install.

2. Tap the Install icon to open the Installer.
   - If the Applications sheet isn’t displayed, tap the arrow in the title line to see the list of Installer sheets, and tap Applications to choose it.

3. Tap **Install from Disk**. You’ll see a Disk Manager showing what’s on the disk in the drive.

4. Tap to choose the application to install.

5. Tap **Install & Eject** to install the application.
   - Tap **Install** if you want to leave the disk in the drive so you can install something else.
   - Tap **Close** when you’re done, or to close the Installer without installing anything.

6. PenPoint displays a message telling you that the application has been successfully installed. Tap **OK** to dismiss the message.
You install fonts, services, handwriting profiles, personal dictionaries, and preference sets in the same way you do applications. For example, to install a font, turn to the Fonts Installer sheet and choose Install from Disk. PenPoint searches the connected disk and lists the fonts it finds there. Tap the font you want to install, and then tap Install to add the font to your computer.

When you choose Install from Disk the Installer searches the disk for the category you’ve chosen and displays what it finds. If it doesn’t find anything, the item may be in another directory on the disk. If this happens:

- Use the computer’s Disk Manager to find the item on the disk (see chapter 11, Filing Documents for information about the Disk Manager).
- Open the Installer and choose the appropriate Installer sheet.
- Tap Install from Disk to display the Installer’s Disk Manager.
- Drag the item from the computer’s Disk Manager to a location on the Installer’s Disk Manager.

If you don’t have enough room in the Notebook to add something, PenPoint displays a message to this effect. See “Managing Memory” in chapter 12, (Learning More About PenPoint) for details.
Automatic Installation

Some disks install their software automatically when you insert the disk.

1 Connect the PenPoint computer to a disk drive and insert a disk.

You'll see a list of the disk contents, and one item may be preselected. You can install this item or tap to choose another one.

▲ To see items not visible in the list, scroll the list by drawing a flick up or by tapping the scroll arrow in the scroll margin.

2 To install an item, tap Install & Eject.

▲ If you want to install something else as well, choose Install to leave the disk in the drive.

▲ Tap Eject when you're done, or to eject the disk without installing anything. (Tapping Close closes the automatic installer, but leaves the disk in the disk drive.)

3 PenPoint displays a message telling you that the item has been successfully installed. Tap OK to dismiss the message.

If you don't see an installation message when you insert the disk, use the Installer.
The first time you use Handwriting Customization, you rename the standard handwriting profile so you can save it and the changes you make to it under your name. If someone else regularly uses the computer, you can copy the standard profile from disk and modify and rename it for that person.

Similarly, you can create sets of preferences and dictionaries by modifying the standard one. If you need several different dictionaries or sets of preferences, you can copy an existing one and rename it, or make another copy of the standard one from the PenPoint disks and change it. For example, you might copy the standard dictionary, modify it to create a district sales office dictionary, and then copy and modify that one to include specific customer and contact names for your sales region.
There's a shortcut for creating new handwriting profiles, dictionaries or preference sets: Draw a caret \( \wedge \) over the installed item on which you want to base the new version, and then assign a name and home volume on the Create dialog.

To copy a dictionary:

1. Tap the Installer icon to open it.
   - If the Dictionaries sheet isn't displayed, tap the arrow in the title line to see the list of Installer sheets, and tap Dictionaries.

2. Tap Create.

3. Write in a name.
   - You can leave the name field blank, and PenPoint will use the name of the dictionary in the Start From field and add the number 1 to it, so Dictionary becomes Dictionary 1.

4. Tap the name of the dictionary on which you want to base the new one.

5. Tap to choose a Home Volume.
   - PenPoint matches the dictionary to its home volume.
   - To choose a different home for the new dictionary, insert a disk. Tap to choose the new volume.

6. Tap Create & Close.
If you base a new version of your preferences or the personal dictionary on the one you’re currently using, it will contain any changes you’ve made to the standard ones. If you want to start fresh, connect the computer to a disk drive and use the Installer to copy the standard preference set or dictionary from the PenPoint disk.

Once you’ve made a copy under a new name, you can customize it. To learn how to:

- Customize the standard handwriting profile, read “Customizing Your Writing” in chapter 6 (Writing in the Notebook).
- Add words to the personal dictionary, read “Adding Word to the Dictionary” in chapter 5 (Creating and Using Documents).
- Set preferences, see “Customizing the Notebook” in chapter 9 (Managing the Notebook).
The Installer keeps track of any modifications to things you've installed. To save these changes copy them to the home volume. If you don't want to keep the changes, restore an earlier version by updating it from home.

To save changes to your handwriting profile:

1. Connect the PenPoint computer to a disk drive.

2. Tap the Installer icon to open it.
   - If the Handwriting sheet isn't displayed, tap the arrow in the title line to see the list of Installer sheets, and tap Handwriting.
   
   The Modified column tells you whether you've modified your profile since the last time you saved it to disk.

3. To save new changes, select your profile and choose Copy to Home from the Home menu.
   - To restore an earlier version choose Update from Home.

   PenPoint prompts you for the home disk.
   - (When you connect the home disk, you may see the automatic installation dialog. Tap Cancel to dismiss it.)

4. After saving or updating the profile, PenPoint displays a message telling you the command has been carried out. Tap OK to dismiss the message.

When you make changes to a service or application, be sure to save them to disk. (You won't see a Modified column to remind you that you've changed something).
If you want to rename something before saving it, you rename it in the usual way, by drawing a circle \( \odot \) on it and changing it in the edit pad. PenPoint considers renaming something a modification of it.

Here’s a shortcut for copying an installed item to its home: draw an \( \text{H} \) on the name of an item in the Installer.
Deactivating Applications and Utilities

You can use the memory in your computer most efficiently by deactivating the applications, handwriting profiles, and services you’re not using. Deactivating them is a way of temporarily removing them. For example, you might deactivate the applications and services you won’t be using on a trip.

When you deactivate something PenPoint deletes it from the Notebook, but leaves a placeholder and remembers its home. When you’re ready to use it again, you can reactivate it in one step instead of having to reinstall it completely. Make sure you’ve copied the most recent version to its home before you deactivate anything.

To deactivate an application:

1. Tap the Installer icon to open it.
   - If the Applications sheet isn’t displayed, tap the arrow in the title line to see the list of Installer sheets, and tap Applications.

2. Tap the name of the application you want to deactivate.

3. Choose Deactivate from the Home menu to remove the application but leave a placeholder for it.
   - Make sure you’ve copied the most recent version to its home first.

To delete something from the computer, draw a cross out on it. Since deleting it removes its placeholder, you’ll need to reinstall it when you’re ready to use it again.
When you choose **Deactivate**, PenPoint changes the menu command to **Reactivate**. When the computer is connected to a disk drive with the home disk in it, you can choose **Reactivate** to reinstall something.

When you deactivate an application, PenPoint tells you how many documents are currently using the application. If you’re working on one of those documents, save your recent changes by choosing **Checkpoint** from the Document menu or by turning to another page in the Notebook before deactivating the application. To save the changes to floating documents, close them.

If you turn to a document after you’ve deactivated its application, PenPoint asks you if you want to reactivate the application. If you tap **OK**, PenPoint prompts you for the home disk and then automatically reinstalled the application. (You may see the automatic installation dialog. Dismiss it by tapping the close corner.) When the application has been installed, the document appears on the page.

### Deactivating Fonts

The Fonts Installer sheet shows you which fonts you’ve chosen from the Fonts Preferences sheet for fields and PenPoint text, and the fonts you’ve installed for styling text. In addition to these fonts, you’ll see two symbol fonts, which PenPoint uses to display parts of the Notebook.

Don’t delete or deactivate the symbol fonts, since the Notebook and your applications probably need them. If you want to free up memory in your computer, you can delete or deactivate all but one of the other fonts.
At times you may find it convenient to set a different home volume. For example, you might decide to consolidate dictionaries from different floppy disks to a single disk. If you want to copy something to its new home as soon as you change it, make sure the computer is connected to a disk drive.

To change the home for your dictionary from one floppy disk to another:

1. Connect the PenPoint computer to a disk drive.
2. Tap the Installer icon to open it. If the Dictionaries sheet isn’t displayed, tap the arrow in the title line to see the list of Installer sheets, and tap Dictionaries.
3. Draw a check on the dictionary name.
4. Insert the floppy disk which will be the new home for the dictionary.
5. When you insert the disk, PenPoint automatically selects it as the Home Volume. (If the appropriate volume isn’t selected, tap it to choose it.)
6. Tap Apply & Close.

You can also set a new home volume by tapping the item you want and choosing Options from the Edit menu. When you change the home, PenPoint creates a new home path to its new location.

To change an item’s home volume and copy it there in one step, open the Disk Manager and copy the item from the Installer sheet to a location on the Disk Manager.
Before you can use a printer you need to install its driver with the Installer and then set options for it with Printers (located in Tools).

For information about connecting a printer to your computer, see chapter 13, Setting Up Your Computer. Also, consult the guide that comes with your equipment for specific settings you should use. To find out how to install a TOPS printer refer to Connecting to a Personal Computer.

Connecting a Printer

When you’ve installed the printer driver and attached the printer you’re ready to set options (such as the model and the printer port) with the Printers sheet. You can save all of this setup information to the home volume so that you don’t have to redo it each time you use the printer. (Tap to select the printer driver on the Services Installer sheet and choose Copy to Home.)

To set up a printer:

1. Install the printer driver with the Installer.

2. Tap the Tools icon on the Bookshelf to open it, and then tap the Printers icon.

You’ll see the Printers sheet. PenPoint lists by name any printers you’ve previously added.
3 Choose Add from the Edit menu.

4 Write in a name for the new printer.

5 Choose the type of printer you’re adding from the Type pop-up list.

6 Choose the port to which you’ll connect the printer from the Port pop-up list.

7 Tap OK to accept these settings.

After adding the printer, PenPoint displays another set of options so you can choose the appropriate model.

8 Tap the name of the printer model you’re adding from the Model pop-up list.

9 Tap OK to add the printer to the list of available printers.

You have two choices for the printer port: Printer and BaseStation port (the Option Slot is reserved for serial communications). To connect the printer to:

- the PenPoint computer directly, choose Printer port.
- the Quick Charger, choose the BaseStation port or Printer port according to which BaseStation connector you plan to use.
PenPoint lists the printer's name and type on the Printers sheet in Tools. The setup requirements for each printer may vary, so to complete the setup information, choose the appropriate printer options. For example, on the:

- Serial sheet, set options for how the data will be sent, such as the flow control or baud rate (Consult the manual that comes with your equipment for these specifications.)
- Options sheet, set options for the printer's capabilities, such as paper handling.

To set the serial options:

1. On the Printers sheet, tap the Enabled checkbox so that PenPoint can set options for the printer.

2. Draw a check ✓ on the name of the printer to see the option sheets. If the Serial sheet isn't displayed, tap the arrow in the title line to display a list of option sheets and tap Serial.

PenPoint lists the serial port you've previously chosen on the Add Printers sheet.

3. Tap to see the different choices in each category, tap to choose the appropriate ones.

Consult the guide that comes with your printer for the appropriate setting.

4. Tap Apply and Close.
To set specific printer options:

1. On the Printers sheet, tap the Enabled checkbox so that PenPoint can set options for the printer.

2. Draw a check \(\checkmark\) on the name of the printer to see the option sheets.
   - If the Printers sheet isn’t displayed, tap the arrow in the title line to display a list of option sheets and tap Printers.

   PenPoint lists the printer model and the port to which you’ll attach it.

3. Tap to see the different options. Then tap to choose the appropriate ones.

4. Tap Apply and Close.

Printing a Document

When you’re ready to print, first enable the printer from the Print dialog or the Out box. (Changing it in one place automatically changes it in the other.)

To print a document:

- Choose Print from the Document menu and choose the printer you want to use.
- Choose Yes from the Printer Enabled category if you’re connected to a printer; choose No to place the document in the Out box so you can print it at a later time.

After you enable a printer and connect it to the PenPoint computer, PenPoint automatically begins to print documents it finds in the Out box. If you want to do something else with the computer first, deactivate the printer by deselecting Enabled in the Out box before you connect the printer to the computer. When you’re ready to print, choose Enabled again.

To find out more about printing a document, read chapter 10, Printing, Sending and Receiving Documents.
CHAPTER 5

Creating and Using Documents
When you install an application in your Notebook, the PenPoint™ operating system automatically places stationery for that application in the Stationery notebook and on the Table of Contents’ Create menu.

The stationery is like a box of paper that never runs out. To create a new document you start at the Table of Contents and choose a piece of stationery from the Create menu. If you find that you routinely use a few kinds of stationery, you can customize the Create menu by changing settings in the Stationery notebook.

Most of the time you’ll work with a full-page document. But at times you may want to work with two documents at the same time, for example to compare information. You do this by floating one document above another. Floating a document temporarily detaches it from its place in the Notebook. When you’re finished working with it, you close the floating document, and it returns to its place in the Notebook.

While working on one type of document, you may want to add information using a different application. For example you might add a drawing to a written report. You can do this by embedding a second piece of stationery in your document. You can also prepare documents separately and combine them later into one document.
Using the Create Menu to Create a Document

Your PenPoint computer comes with some stationery already on the Create menu. To create a new document from the menu:

1. In the Table of Contents, tap to see the Create menu.

2. Tap to choose a piece of stationery. PenPoint inserts the new document after the current selection or, if there’s no selection, at the end of the Table of Contents.
As a shortcut to using the Create menu, you can draw a caret on the Table of Contents with the point of the caret where you want the new document to go. The PenPoint operating system displays the pop-up Create menu floating over the Table of Contents. When you tap to choose a piece of stationery PenPoint inserts it where you positioned the caret.

When you create a new document, PenPoint gives it the name of its stationery as a title, for example MiniText. If you create another document using the same stationery, PenPoint adds a number to the title, so that a second MiniText document would be called MiniText 1, and the third MiniText 2.

You can rename the document at any time. Tap the title to select it and draw a circle over it to bring up the edit pad. Or, you can choose the Rename command from the Edit menu. For a more detailed explanation, read “Renaming a Document” later in this chapter.
Using the Stationery Notebook to Create a Document

The Bookshelf contains an icon labeled Stationery. This is the Stationery notebook, which holds all the stationery installed on the PenPoint computer. Each application has a section that contains the stationery that goes with the application. You can flip through the notebook to see the different kinds of stationery, or you can go directly to a specific page by tapping its page number.

Use the Stationery notebook to:

- Create new documents
- Choose which stationery to put on the Create menu
- Add customized stationery (explained in “Creating Customized Stationery” later in this chapter).

To create a document:

1. Start from the Notebook Table of Contents.
2. Tap the Stationery icon on the Bookshelf to open the Stationery notebook.
3. Tap press \( \Rightarrow \) on the name of the stationery you want to copy.
4. When you see the double marquee, (an animated dashed line surrounding the title), drag it where you want it to appear in the Notebook Table of Contents.

The PenPoint operating system inserts the new document where you lift your pen.
Adding Stationery to the Create Menu

You can use the Stationery notebook to add to the Create menu stationery that you use frequently, so it’s more accessible.

1. Tap the Stationery icon on the Bookshelf to open the Stationery notebook.

2. To add stationery to the Create menu, tap an empty box.
   ▲ You’ll see a check mark.

   To remove the check mark, tap again.
Creating Stationery

You can use the stationery from the Stationery notebook as it is set up, or you can change the margins, the font, and other options. If you routinely make the same format changes, you might want to customize a piece of stationery and add it to the Stationery notebook. For example, you might create stationery for a weekly memo that would have preset margins and a header with spaces for the names of the recipients and the subject of the memo.

Creating Customized Stationery

You can customize stationery by adding text or graphics to it and changing options on the Document or Text option sheets. For example, to change the font for the Memo stationery:

1. Tap the Stationery icon on the Bookshelf to open the Stationery notebook, where you create the new piece of stationery.

2. Copy the stationery you want to customize:

   Tap press on the name of the stationery you want to copy and drag it to a location in the same section.

   ▲ You can rename the new stationery. (To find out how to rename a document, read “Renaming a Document” in this chapter.)

3. Turn to the new document in the Stationery notebook by tapping its page number.
Instead of copying the stationery, you can create a new piece of stationery to customize by choosing it from the Create menu.

- On the Stationery table of contents, draw a caret \( \wedge \) in the section where you want the new stationery to go.
- Tap to choose a piece of stationery from the pop-up Create menu.

Once you’ve created the new piece of stationery, you can further modify it by turning to it in the Stationery notebook and making the necessary changes using the document option sheets.
Managing the Stationery Notebook

In managing the Stationery notebook, you may want to rename stationery, save stationery you’ve customized, and delete stationery you no longer need.

To rename stationery:
- Draw a circle over the title to display the edit pad and change the title.

To back up stationery that you’ve customized so you can reinstall it if necessary:
- Connect the PenPoint computer to a disk drive.
- Tap the Installer icon on the Bookshelf to open it.
- From the Applications sheet in the Installer, tap to select the application that created the stationery. (If the Applications sheet isn’t displayed, tap the arrow in the title line to see the list of Install sheets, and tap Applications.)
- Choose Copy to Home from the Home menu.

Copying the application to disk automatically copies all the stationery that’s in the application’s section.
Deleting or Purging Stationery

When you delete stationery you have a choice of removing it from the Stationery notebook and keeping a backup copy on the home disk or removing it from both places by purging it.

For example, if you created a template for your annual report, you might delete it from the Stationery notebook, but keep a backup copy on the home disk so you can use it again next year. If, however, you customized stationery for a one-time project that ended, you might purge it.

To delete or purge stationery:

1. From the Stationery table of contents, draw a cross-out X over the title of the stationery you wish to remove.
   - You see a note asking you if it’s OK to delete the stationery.

2. Tap Delete to remove the stationery from the Stationery notebook but keep it on the home disk.
   - Tap Purge to remove it permanently from both places.

If you decide later that you want to use stationery you’ve deleted, you can reinstall the application. Reinstalling the application copies the stationery that you’ve saved on the home disk back into the Stationery notebook. (Chapter 4, Installing Applications and Devices tells you how to reinstall applications.)

To ensure that you’ll always be able to use an installed application, each application has a few pieces of stationery that you cannot delete. If you try to delete them, you see a message asking you to remove them by deinstalling the application. (Deinstalling an application also removes its stationery.)
If a document doesn't fit on the screen all at once you can use flicks to navigate within the document and bring different portions into view. You draw flicks in the body of the document to scroll the document to the beginning, end, or to any point in between.

Drawing flicks is like using the eraser on a pencil to move parts of a page into view. You pull the page toward you (flick down) to see what's at the top, or push it away (flick up) to see what's on the bottom.

You can scroll a document using flicks on a page.

Flick up 1 on a line to bring it to the top of the screen.

Some applications (like Draw) don't support flicks in the body of the document. In these applications, flick in the scroll margin.
94

Eggplant dip
(We'll need a catchy name for this.) This is a variation on babaganoush that I think will stand up well to long-term shelf storage. It involves roasting the eggplants (which we can do in bulk) and then smashing them with garlic, lemon, olive oil and spices. We currently have some problems with the oil separating out to the top of the jar, which is very unappealing, but I'm sure we can find a binding agent to solve this.

Southwestern curry sauce
This is essentially a barbecue sauce. Grilling or barbecuing vegetables like eggplant and zucchini and other squash has become very popular in the West lately. You'd spread this curry sauce over the vegetables as you grill them. Pete in the test kitchens came up with a clever way to make sure the sauce is thick enough to stay on the vegetables yet thin enough to look appealing.

Eggplant pasta
We really need a new name for this one, but it's actually a great product. It's eggplant puree mixed with garlic and other spices in a tube to use in sauces, casseroles, dips and so forth. Remember what a hit that tomato paste in a tube was that we turned it down? I think this is our chance for a big seller.

Eggplant steaks/entrees
Preparing eggplant to sell like we do in the fresh market. Frozen or vacuum-packed could be used as a substitute cut in many recipes. In fact, we should further and include sauces to "plant before" with a health.

To scroll to the beginning or end of a document:
- Draw a double-flick down \| anywhere in the document to go to the beginning of a document.
- Draw a double-flick up \| to go to the end of a document.
The scroll margin is useful for gauging your location in the document, and for jumping to a specific location in it. You may find it easier to drag the scroll handle to go to a specific part of the document. For example, if you were on page one of a four-page report, to get to the third page, you could drag the scroll handle about three-quarters of the way down the margin.

Use the position of the scroll handle to gauge your current location.

To move to the middle of the document:

Drag the scroll handle down to the middle of the scroll margin.
The **scroll arrows** let you move either one line at a time or in a continuous scroll:

- Tap the bottom arrow to see more of the page below.
- Tap the top arrow to see more of the page at the top.
- Press either arrow to scroll the page continuously.

You can scroll the document one screenful at a time by tapping in the scroll margin. Tap above the scroll handle to see more of the document that lies off the top of the screen; tap below it to see more of the document off the bottom.
Floating a Document

When you float a page the PenPoint operating system temporarily detaches it from its place in the Notebook and puts it on top of the current page. It continues to float where you can see it even as you move around the Notebook, until you close it. When you close it, it returns to its place in the Notebook.

Floating one document above another allows you to compare both documents and work with them without flipping between pages.

Before floating a document, you must first select the option for floating documents in the Preferences option sheets. You need to set this option only once to be able to float documents any time you use your PenPoint computer.

To set the floating option:

1. Tap the Preferences icon on the Bookshelf to open Preferences.
   ▲ If the Safeguards sheet isn’t displayed, tap the arrow on the title line and choose Safeguards from the list.

2. Tap Allowed for Floating Documents.

3. Tap Apply & Close.
If you’re working on the Table of Contents and want to see what’s in a document, you can float the document over the Table of Contents and then close it to put it back in place in the Notebook.

To float a document, double-tap its page number or tab.

To stop floating a document, tap its close corner. It returns to its place in the Notebook.

Sometimes you may want to float a document above the one you’re working on, for example to copy information between them. To do so:

- Temporarily float the Table of Contents by double tapping its tab.
- Double-tap the page number of the document you want to float.

If you’re working with several floating documents, and the one you want to work with next is partially hidden, tap its title line to bring it to the front.
Moving and Resizing Floating Documents

When you float a document, it sometimes covers up the information you want to see. When this happens, you can move or resize the document.

To move a floating document:

1. Press \( \text{the title line. Wait until the document border darkens. This tells you it's ready to be moved.} \)

2. Drag it to its new location.

To resize a floating document:

Drag the corner handle to the right to widen it; down to lengthen it; or diagonally to expand or reduce it in both directions.

\( \text{If you reopen a floating document after resizing or moving it, PenPoint displays it as you last left it.} \)

To find out more about resizing floating objects, see chapter 2, Fundamentals.
When you want to use the entire screen area to display a document, you can zoom a floating document so that it covers the tabs, the title, and the menu line. When you unzoom it, it returns to its previous size.

Before zooming a document, you must first choose the zoom option. You need to set this option only once to be able to zoom documents any time you use your PenPoint computer.

To set the zoom preference:

1. Tap the Preferences icon on the Bookshelf to open Preferences.
2. If the Safeguards sheet isn't displayed, tap the arrow at the top to see the list and choose Safeguards.
3. Tap Allowed for Zooming Documents.
4. Tap Apply & Close.

When you turn on zooming, the PenPoint operating system adds a close corner to the Notebook. In general you won't need to close the Notebook unless you're restoring a backup copy of it, or you're working with several Notebooks in your PenPoint computer. You'll find more on restoring the Notebook in chapter 11, Filing Documents, and more on working with multiple notebooks in chapter 12, Learning More About PenPoint.
To zoom a document:

1. Draw a flick up on the title line. Make sure the flick begins in the title line.

To return the page to its normal size, draw a flick down on its title line.
While working with a document in the Notebook you may want to:

- Rename it with a more useful title.
- Save your recent changes.
- Go back to an earlier version.
- Delete a document you no longer need.

## Renaming a Document

When you create a new document the PenPoint operating system gives it the name of its stationery. To give it a more useful name:

- From the Table of Contents, tap to select the title, and choose **Rename** from the Edit menu. Or, select the title and draw a circle ⊙ to display an edit pad and change the name there.
- From the document, draw a circle ⊙ on the document title line and change the title in the edit pad.

You can also change the title on the Title & Info document option sheet. You draw a check √ on the document title line to display the document option sheets; then you can change the title on the Title & Info sheet.

Changing the title in one place automatically changes it in the others. For example, if you edit the name of a document on the Table of Contents, the name also changes on the tab. However, if you edit the tab label, the title of the tab doesn’t automatically change when you next rename the document.
To rename a document from the Table of Contents:

1. Draw a circle on the title to bring up the edit pad.

2. Tap the Clear button to clear the pad and then write in a new title.
   - Or, you can edit the title in the edit pad.

3. If you need more room to write, drag the corner handle to the right to widen the edit pad, down to lengthen, or diagonally to expand it in both directions.

4. Tap the OK button to translate the new title in the edit pad; tap OK again to transfer the title to the page.
   - Tap the Cancel button to close the pad without renaming the title.

For more information about editing in pads or fields, see "Editing Text in Edit Pads" in chapter 7 (Editing and Formatting Text).
The PenPoint operating system automatically saves the document each time you turn to another page of the Notebook. To save your changes without turning the page, choose **Checkpoint** from the Document menu. You might want to do this periodically so that if you have to restart the computer, you won’t lose your most recent changes.

Note that PenPoint saves recent changes only if there’s nothing selected in the document. So tap to undo any selection before turning the page or using **Checkpoint**.

If you make a change that you don’t want to keep, you can go back to an earlier version by choosing **Revert** from the Document menu. PenPoint changes the document back to what it was before you last turned the page or chose **Checkpoint**.

To manage your Notebook efficiently, you can remove documents you no longer need. If you want to use a document at some future date, move it to a floppy or hard disk instead of deleting it. You can find out how to make backup versions in chapter 11, Filing Documents. If you know you’ll never need a document again, you can delete it.

To delete a document:

1. Draw a cross-out X on the title in the Table of Contents
   * Or, select the document in the Table of Contents and choose **Delete** from the Edit menu.

2. When you delete a document, PenPoint asks you to confirm the command. To go ahead, tap **OK**.
   * To change your mind, tap **Cancel**.

You can also delete a document by drawing a cross out X on the document title line.
PenPoint allows you to embed one document inside another. For example, you can work with another application such as a drawing or spreadsheet application, within a text document. There are two ways to create a compound document:

- Create a new document within an existing document.
- Move or copy an existing document into another document.

To create a new document inside an existing one:

1. Start from the document in which you want to embed another.

2. Draw the embedded document gesture (double caret) \( \land \) where you want the new document to go. You’ll see the pop-up Create menu.

3. Tap to select the stationery you want to use. PenPoint embeds a new document of the appropriate type where you drew the tip of the gesture. You can work in it in the usual ways.

   - To open the document, tap the icon.
   - To close the document, tap the close corner.
   - To delete the document, draw a cross out \( \times \) on the title line if it’s open, or on the icon if it’s closed.
Embedding an Existing Document

You may find it more convenient to work on documents separately until you’re ready to assemble them, at which point you can copy or move one document into another.

To embed a document in another document:

1. Start from the document in which you want to embed another.

2. Double tap the Contents tab to float the Table of Contents.

3. Press on the title of the second document and drag it to the place where you want it in the first document.

Notice that the document you moved is no longer listed on the Table of Contents.

Embedding a Tool

Sometimes it’s useful to embed a tool in a document. For example, you might embed the clock in a document so that it will show the date and time when you print the document. To do so, copy the clock from Tools to a location in the document. Tap to open the clock and then turn off the borders by drawing a B on the clock.
Working with Embedded Documents

**Setting Document Options**

You set document options for an embedded document in the usual way by drawing a check ✓ on the document title line.

If the title line is hidden, draw a check ✓tap ✓ anywhere on the document to see the option sheets.

**Moving an Embedded Document**

You can move an embedded document to another location in the same document by dragging it. Close the document by tapping the close corner. Then press the icon until you see the marquee, and drag it to another place in the document.

To move an embedded document to a different document, float the destination document, press the icon until you see the marquee, and then drag it to the new location.

**Making an Embedded Document a Full-page Document**

You can reverse the procedure and split compound documents into two separate documents. For example, if you decide you don’t need to illustrate sales results with a graph, you might want to remove the graph from the report but keep the graph in the Notebook.

To move an embedded document to a separate page, close the embedded document if it’s open, press and hold the icon until you see the marquee, turn to the Table of Contents, and drag the document to a location on the Table of Contents. The document goes to the point where you lift the pen from the Table of Contents. For details on moving a document to the Table of Contents, read “Rearranging the Notebook” in chapter 9, Managing the Notebook.
Floating an Embedded Document

You can decide whether to float the embedded document on the page so that when it's open it overlaps what lies beneath it. Or, you can position it so that the text of the primary document flows around it. Floating an embedded document is useful if you want to be able to refer to it while you work in another part of the primary document. To choose those options:

To float an embedded document:

1. Draw a check ✓ on the icon of the embedded document to display the option sheet. Close the document first to see the icon if you need to.
2. If you plan to work with the document where you inserted it, choose In Place from the Open category.
3. Choose Popup to see information in the embedded document while working in another part of the larger document.
4. Tap Apply & Close.

If you choose Popup for an embedded document it floats only while you work with the container document. If you turn the page, the floating embedded document closes and returns to the location where you embedded it.

However, if you choose In Place for an embedded document and later float it by double-tapping its title line, PenPoint treats it just as any floating document; when you turn to a different page, it floats on the new page.
Printing an Embedded Document

When you print the container document, usually only the portion of the embedded document that shows on the screen gets printed. You can control how much of the embedded document PenPoint prints by resizing it before printing. To print the entire document regardless of how much is showing, or to start it on a new page, choose the appropriate Formatting option from the embedded document’s Print Setup Layout sheet.

To set print options for an embedded document:

1. Choose Print Setup from the embedded document’s Document menu.
   - If the Layout sheet isn’t displayed, tap the arrow at the top of the option sheet and tap Layout from the list.

2. Choose the appropriate options from the Formatting category on the Layout sheet.
   - To print the entire document, choose Print Entire Document.
   - If an embedded document is near the end of a page and you want to prevent the contents from being split between two pages, choose Keep on Same Page.
   - To make sure that an embedded document always begins on a new page, choose Begin on New Page.

3. Tap Apply & Close.

If you don’t see the menu line for the embedded document, draw an M on the title line. If neither the title nor menu line is visible, draw a check tap anywhere in the document to display the Document option sheets, then choose Show from the Borders & Controls category of the Access sheet to make the title and menu lines visible.
USING PENPOINT
WORKING WITH EMBEDDED DOCUMENTS

If the embedded document is closed, PenPoint prints the icon and title. To avoid printing them, close the document and move the icon to the cork margin while you print. You can find out how to use the cork margin in the next section of this chapter.

If the embedded document is open, the PenPoint operating system normally doesn't print the menu and title line, borders, and scroll margins. However, some applications may treat these elements differently. See the guide that comes with the application.

The container document's Print Setup option sheets set the orientation and paper size for the embedded document and suppresses other Print Setup options for the embedded document, such as margins, headers, and footers.

If you want to format the embedded document with its own margins and headers and footers, you can do so:

- Choose Print Setup from the embedded document's Document menu.
- Choose the appropriate options on the Header and Layout sheets.
- Choose Print Entire Document from the Formatting category on the Layout sheet, and tap Apply & Close.

PenPoint prints the embedded document starting on a new page using the settings you've selected and then returns to the options for the document that contains it.

To print the embedded document without printing the document that contains it, choose Print from the embedded document's Document menu.
The cork margin is an area at the bottom of the document where you can put hyperlink buttons, new or embedded documents, and accessories. You can easily use things you've placed there no matter where you are in the document.

The PenPoint operating system doesn't print what's on the cork margin, so you can move buttons and closed embedded documents there when you don't want to print the title or icon.

The cork margin is always part of a document, but it's usually hidden.

To display it, draw a C in the document's title line.

Draw a C again to hide it and everything on it.

You can also show the cork margin by drawing a check ✓ on the document title line to display the Document option sheets and then selecting Cork Margin on the Access sheet.
Use the cork margin when you want to annotate a document by inserting notes and instructions there. To create a new document, draw a caret \( \wedge \) in the cork margin to display the Create menu and then tap to select a new piece of stationery.

You might also move an existing document, such as a to do list, to the cork margin so you can update it while working on the current document. To put a document in the cork margin, copy or move it from the Table of Contents.

Place hyperlink buttons in the cork margin to turn quickly to parts of the document you want to see without having to scroll through the document to find them. To insert a hyperlink button in the same document, select a word and draw the gesture for a hyperlink button \( \bigcirc \) in the cork margin. To insert a hyperlink button for a different document, select the document in the Table of Contents and then draw the hyperlink button gesture \( \bigcirc \) in the cork margin of the first document.

You can change the location of a hyperlink button in the same document by selecting a new word and triple tapping \( \bigcirc \) the button. PenPoint changes the label on the button to reflect the new location.

To have easy access to an accessory, such as the calculator, copy the icon for it to the cork margin.
Customizing a Document

You can change the look and behavior of a document to suit what you’re using it for. For example, if you embed a drawing in a report, you might choose not to display its menu line. If you’re referring frequently to a document during a meeting, you might want to shorten the time it takes to turn to it.

You can decide whether to:

- Show the title line, menu line, scroll margin, or borders
- Shorten the time it takes to turn to a document
- Add a cork margin where you can store hyperlink buttons and embedded documents.

To customize a document:

1. Draw a check ✓ on the document title.
   - You see the Document option sheets.

2. Tap on the arrow in the title line to see the list of sheets and tap on the option sheet you want to use.
   - Most of the customization options mentioned above are on the Access sheet.

3. Tap to select each option you want.
   - When you display the Document option sheets, you see a dimmed check mark next to each currently selected option. Tap an option to deselect it.

4. Tap Apply & Close to apply the options to the new document and close the option sheets.

Applications you install on the PenPoint computer may add their own options to the document option sheets or remove inappropriate ones.

You can also display the document option sheets by choosing About from the Document menu.
CHAPTER 6

Writing in the Notebook
If you've never written with a pen on a computer screen before, you might want to spend a few minutes using the Letter Practice tool to get the feel of writing on glass.

To use Letter Practice:

1. Tap the Tools icon on the Bookshelf to open it, and then tap Letter Practice.

You'll see instructions for using Letter Practice.

Before starting to write, find a comfortable position.

2. Print one character per box.

Hold the pen as you would normally and write naturally. Don’t press too hard with the pen.

As you print your letters, the PenPoint™ operating system translates the results. Experiment with different ways of making the same letter to see what works best.

- Tap Clear to erase what you’ve written.
- Tap Quit to close Letter Practice and end the practice session.

If you normally print in upper case, practice writing that way. Later you can set a preference which translates your upper case writing into appropriate upper and lower case letters. (See the next section, “Printing in Upper Case.”)

You can also set the size of the boxes so that you can write easily within them. To learn how to change the size, read “Choosing a Writing Pad Style” later in this chapter.

When you’re comfortable writing on the screen, you can customize your printing with the Handwriting Customization tool. (See “Customizing Your Handwriting” in this chapter.) You’ll find tips on how to write in pads in the next section, “Printing in Writing Pads.”
You print in the Notebook on a writing pad as you would on a paper pad. When you’re done, the PenPoint operating system converts what you’ve written into typed, electronic text which you can then easily correct and edit.

Some applications, such as MiniText, have writing pads on them when you first turn to a newly created documents. The Notebook has other pads which you can also use to insert text. The section on “Getting a Writing Pad” in this chapter explains how to get and use each pad.

The standard writing pad contains separate boxes for each character. After translation the characters remain in their boxes so you can correct them before you transfer the text to the page.

At some point you may find it easier to write on ruled pads or to use a keyboard to enter text. To learn how to adjust the size and style of boxed and ruled pads, read “Choosing a Writing Pad Style”; to find out how to use the software keyboard read “Using a Keyboard to Write,” both in this chapter.
Newly created MiniText documents contain a writing pad. (Read chapter 5, Creating and Using Documents to find out how to create a document.) Before practicing the following tips, turn to a MiniText document.

To print in a writing pad:

Start the letter in the character box and print clearly.

Write naturally; PenPoint will keep up with you.

You can leave extra spaces at the end of the line. (The PenPoint operating system converts them to a single space.)

Leave a space between words. If you finish a word in the last character box, skip a box on the next line before starting the next word.

To start a new paragraph, leave a space between lines.

If you get to the end of a line in the middle of a word, continue it on the next line. Don’t hyphenate it or the PenPoint operating system will translate the hyphen.

Find a comfortable position, relax and write the way you normally do. (Don’t press too hard with the pen.)
# Some Tips on Writing in Pads

**What Works**

Write neatly and at a normal speed, making your letters a consistent size. Sometimes when you’re writing you’ll make the first letter of a word larger than the others. PenPoint translates this as a capital letter.

<table>
<thead>
<tr>
<th>write them</th>
<th>Write Them</th>
</tr>
</thead>
</table>

Make your letters the same way each time. For example, don’t use one stroke sometimes for an *r* and two strokes at other times.

<table>
<thead>
<tr>
<th>early rain</th>
<th>early rain</th>
</tr>
</thead>
</table>

When tall and short letters come next to each other, make sure there’s a visible difference in their heights. For many letters, height is the only difference between upper and lower case.

<table>
<thead>
<tr>
<th>Philadelphia</th>
<th>Philadelphia</th>
</tr>
</thead>
</table>

Letters with curves in them should curve at the top if it’s a capital letter or midway for a lower case letter.

<table>
<thead>
<tr>
<th>bathed</th>
<th>Bathed</th>
</tr>
</thead>
</table>

Make sure that letters with descenders (g, j, p, q, and y) extend clearly below the baseline of the box or ruled line. They can even go outside the pad. When you print a descending letter, its tail may dip into the box or space below it. You can still write in this area when you get to it.

<table>
<thead>
<tr>
<th>my group</th>
<th>my group</th>
</tr>
</thead>
</table>

You can cross your *t’s* and dot your *i’s* after writing a line and before starting a new one.

<table>
<thead>
<tr>
<th>Subject:</th>
<th>Subject:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>cc:</th>
<th>cc:</th>
</tr>
</thead>
</table>
What Works | What Doesn’t Work

- Writing in boxed pads:
  Always start your letters within the box where you want that letter to go in. Any time you put the tip of the pen down on the writing or edit pad, you’re starting a letter.

  ![Right Box](image1) ![Wrong Box](image2)

- Writing in ruled pads:
  Write as neatly as you do in the character boxes.

  ![clearly](image3) ![clearly](image4)

  Don’t let letters touch each other.

  ![Washington](image5) ![Washington](image6)

  Leave a small, consistent amount of space between letters and more space between words.

  ![Washington was the](image7) ![Washington was the](image8)

  If you run out of room when you’re in the middle of a word, scratch it out and begin the word again on the next line. (Don’t hyphenate it or the PenPoint operating system will translate the hyphen.)

  ![visit to Philadelphia](image9) ![visit to Philadelphia](image10)

  Write vertically rather than on a slant. PenPoint sometimes translates overlapping letters as one letter.

  ![translating](image11) ![translating](image12)

  Connect the strokes that you make to form a letter such as a t or k. Otherwise, the PenPoint operating system may translate each stroke as a separate character.

  ![truck](image13) ![truck](image14)
Printing in Upper Case

If you normally print in upper case, you can do so and the PenPoint operating system will translate your writing into upper and lower case letters. To set this option:

1. Tap the Preferences icon on the Bookshelf to open Preferences.
   - If the Handwriting sheet isn't displayed, tap the arrow in the title of the option sheet and tap Handwriting.

2. Choose Upper Case Only from the Writing Style category pop-up list.

3. Tap Apply & Close.
You can translate your printing in a boxed or ruled-boxed writing pad at any time. This allows you to see if the translation is correct before you transfer the words to the page.

Tap OK when you’re ready to translate your writing in the writing pad.

If PenPoint mistranslated any letters, you can correct them in the writing pad. (See “Correcting the Translation” later in this chapter.)

When you’re ready to transfer the letters to the page, tap OK again.

Tap Cancel to close the pad without translating your writing.

The single character pad translates your handwriting automatically when you lift the pen away from the screen.
To get the best translation results:

- Review the handwriting tips in this chapter.
- Train PenPoint some more with Handwriting Customization, which you’ll find in Tools.
- Align the pen with the Pen sheet of the Preferences notebook.

To align the pen:

1. Tap the Preferences icon on the Bookshelf.
   - If the Pen sheet isn’t displayed, tap the arrow on the title line to see a list of sheets and tap Pen.

2. Touch the pen to the middle of the cross-hairs of the Tap to Align Pen category.

3. Tap Apply & Close.

If you continue writing in the pad after translating your writing, the PenPoint operating system translates the text as you write. If the letters seem to disappear after you write them, the time interval is not long enough for you to complete a word before PenPoint translates it. You can increase the interval by changing the handwriting **timeout** option.

- Tap the Preferences icon on the Bookshelf.
- If the Timeouts sheet isn’t displayed, tap the arrow on the title line to see a list of sheets and tap Timeouts.
- Write in an amount for the Handwriting Timeout. Or change the number by writing a new number over it.
- Tap Apply & Close.
Correcting the Translation

If PenPoint mistranslates a word, you can correct it in the writing pad before you transfer what you’ve written to the page. Or, you can wait and correct it later on the page with the proof sheet or with editing gestures.

Correcting the Translation in the Writing Pad

If PenPoint doesn’t recognize a letter, it replaces the letter with a symbol:  .

To correct unrecognized or mistranslated letters:

- Write over a mistranslated letter.
- Or, use gestures to correct it.

1. When you draw a gesture, begin it within the character box and end it outside the box. Otherwise, PenPoint will try to interpret your gesture as a letter.

- Insert a space with the insert space gesture . The number of empty boxes you add depends on the length of the bottom of the gesture.
- Draw a vertical pigtail to delete unwanted characters.
- Draw a horizontal line through the characters you want to delete.

You can choose a different symbol—an underscore—for the unrecognized character:

- Tap the Preferences icon on the Bookshelf. If the Handwriting sheet isn’t displayed, tap the arrow on the title line to see a list of option sheets and tap Handwriting.
- Choose the underscore symbol from the Unrecognized Character pop-up list.
- Tap Apply & Close.
Correcting the Translation with the Proof Sheet

If a word on the page is incorrect, you can often find the correct one on the Proof sheet.

1. Draw a P over the incorrect word to display the proof sheet.

2. Tap to select the correct word from the list of suggested alternatives.

   If one of the alternatives is close to the word you want, double tap the word to put it in the edit pad and display a list of further alternatives.

The list of alternatives may include combinations of letters the PenPoint operating system doesn't recognize as a word, since the word you wrote may be an acronym or personal noun not found in its dictionary. Choosing it from the Proof sheet adds it to the personal dictionary so that the next time you write the word, PenPoint will translate it correctly.

Instead of selecting a word from the list of suggested alternatives, you can also edit the word in the edit pad. To do so:

- Write over a mistranslated letter
- Or, use the same gestures you use to correct the text in the writing pad. (Insert a space with the insert space gesture; delete a single character with the vertical pigtail; delete several characters by drawing a horizontal line through them.)
- Tap the OK button to replace the incorrect word with the corrected one.

It's sometimes easier to correct the translation directly on the page, particularly when only one or two characters are mistranslated. You can read about editing gestures that let you correct and revise the text in chapter 7, Editing and Formatting Text.
Getting a Writing Pad

There are two kinds of writing pads, pop-up and embedded. Use a pop-up pad to add a single character or several words to a document. The pop-up pad floats on the page. Before doing something else in the document, you need to translate your writing or close the pad.

Use an embedded pad to add several sentences. The embedded pad begins where you draw the gesture and the text that’s already in the document flows around it. Unlike the pop-up pads, the embedded pads stay open so you can move around the document and still continue using the pad.

To get a single character pad, draw the insert character gesture $\rightarrow$.

To get a pop-up pad, draw a caret $\wedge$.

As soon as you finish writing the character, PenPoint transfers the text to the page and dismisses the pad.

If you decide not to write in the pad, dismiss it by tapping anywhere outside it.

To make the pad bigger, press the pen on the corner handle to see an outline around it which tells you it’s ready to be resized.

Drag the corner handle to the right to widen the pad, down to lengthen it, and diagonally to increase it in both directions. Do the opposite to decrease the writing area.
TO: Dick Hopkins
FROM: Enrique Fabbro
DATE: February 2, 1991
RE: New Product Ideas
CC: Test Kitchens, Sara Schwartz

Dick -- I was fiddling around with some old recipes and came up with some ways we might market eggplant, which is a good stable vegetable. Let me know what you think. -- Enrique

Most of the time when you work with pop-up and embedded pads, you tap buttons to translate your writing, and resize the pad when you need more room to write. Pads designed for a specific task may vary somewhat. For example, the single character pad doesn’t have translation buttons or a resize handle.

To get an embedded pad, draw a caret tap \( \wedge \).

- To make the pad bigger, press the pen on the bottom handle to see an outline around it which tells you it’s ready to be resized.
- Drag the handle down to expand the writing area.

After writing in the pad, tap the appropriate button.
- Tap OK to translate the writing in the pad; tap it again to transfer it to the page.
- Tap Clear to erase the pad.
- Tap Cancel to dismiss it without translating what you’ve written.

If you are working in a MiniText document, you can get a writing pad by selecting the appropriate pad from the Insert menu.
Choosing a Writing Pad Style

In the standard writing pad, you write in boxes. But after writing in the Notebook with the boxed pads, you may find it easier to use a ruled or ruled-boxed pad. In boxed pads, you write in boxes and then translate the text in the boxes. This allows you to see the results of your translation and edit any mistranslated characters before transferring it to the page. In ruled pads, you write on ruled lines and the PenPoint operating system translates your writing directly to the page.

Ruled-boxed pads combine both styles. You write on ruled lines, and then PenPoint translates your writing into boxes so you can edit the text before transferring it to the page.

When you choose a writing pad style you can also adjust its shape, size, and spacing to accommodate your handwriting by selecting the appropriate options on the Preferences Handwriting sheet.

Choosing Boxed Pads

In boxed pads you write a single character in each box, translate your writing in the boxes, and then transfer the text to the page.

To find out how to translate your writing and correct the translation, read “Translating Your Handwriting” and “Correcting the Translation,” both in this chapter.

To choose a boxed pad:

1. Tap Preferences to open it.
   - If the Handwriting sheet isn’t displayed, tap the arrow on the title line and choose Handwriting from the list.

2. Choose Boxed from the Writing Pad pop-up list.

3. Tap Apply & Close.
   - The next time you insert a pad or turn to one on a newly created document, you’ll get a boxed pad.
Choosing a Ruled Pad

Once you get used to writing in the Notebook, you may find it more convenient to write on a ruled pop-up or embedded pad.

Ruled pads differ from boxed pads:

- The PenPoint operating system doesn’t translate the writing in the pad before transferring it to the page.
- You can’t use the keyboard to enter text. (If you’d rather enter text with the keyboard, you can do so directly in the document.)

To choose a ruled pad:

1. Tap the Preferences icon on the Bookshelf to open it.
   ▲ If the Handwriting sheet isn’t displayed, tap the arrow on the title line and choose Handwriting from the list.
2. Tap Ruled from the Writing Pad pop-up list.
3. Tap Apply & Close.
   ▲ The next time you insert a pad or turn to one on a newly created document, you’ll get a ruled pad.

To write in a ruled pad:

4. Draw a caret tap \ to display an embedded pad.
5. Write naturally. Leave space between words.
   ▲ Draw a scratch out − to erase what you’ve written; tap Clear to erase the pad.
6. Tap the OK button to transfer your writing to the page.
   ▲ Tap Cancel to dismiss the pad without translating your writing.
If in translating your writing to the page, PenPoint doesn’t recognize a letter, it replaces it with a symbol •. You can correct mistranslated words with editing gestures or the Proof sheet. You’ll find an explanation of correcting words in the Proof sheet in this chapter and of editing text in chapter 7, Editing and Formatting Text.

For tips on how to get the best translation results when writing on the ruled pads, read “Printing in Writing Pads” in this chapter.

You can change the writing pad style but not the edit pad style. The text in edit pads always appears in boxes.
Choosing a Ruled-Boxed Pad

If you like writing on a ruled pad but prefer to translate and edit the text before transferring it to the page, choose a ruled-boxed pad style.

To choose a ruled-boxed pad:

1 Tap the Preferences icon on the Bookshelf to open it.
   ▲ If the Handwriting sheet isn’t displayed, tap the arrow on the title line and choose Handwriting from the list.
2 Tap Ruled-Boxed on the Writing Pad pop-up list.
3 Tap Apply & Close.
   ▲ The next time you insert a pad or turn to one on a newly created document, you’ll get a ruled-boxed pad.

To write in a ruled-boxed pad:

4 Draw a caret \( \_ \) to display an embedded pad.
5 Write naturally. Leave space between words.
   ▲ Draw a scratch out \( \_ \) to erase what you’ve written; tap Clear to erase the pad.
6 Tap OK to translate your writing into boxes.
Recently, an executive of a supermarket chain took a box of our samples home in order to try them before ordering our line. He briefly left the box on the kitchen floor where his son ran into it with a tricycle.

Our bottles should have been able to withstand the impact from a tricycle powered by a three-year-old.

The executive never got a chance to try our product.

7 Edit any mistranslated characters, as described in “Correcting the Translation” in this chapter.

Tap OK to transfer the text to the document.

* Tap Cancel to dismiss the pad without translating your writing.
Choosing a Writing Pad Size and Shape

Your Notebook comes with certain options preset, such as the size and shape of writing pads.

To adjust the writing pad size and shape:

1. Tap the Preferences icon on the Bookshelf to open it.
   - If the Handwriting sheet isn’t displayed, tap the arrow on the title line and choose Handwriting from the list.

2. If you’ve chosen Boxed or Ruled-Box writing pad style, choose the appropriate Box Size and Box Shape from the pop-up lists.

3. If you’ve chosen Ruled writing pad style, choose a height from the Ruled Height pop-up list.

4. Tap Apply & Close.

The PenPoint operating system applies the settings to newly created pop-up or embedded writing pads (not to the one you’re presently using).
At times you may find it easier to insert text by typing it. You can use the PenPoint operating system’s software keyboard or a regular PS/2 keyboard that you plug into the GO Quick Charger to add text directly to a document or to correct translated text in a writing pad.

When you use the keyboard to insert text in a writing pad, field, or on the page, you first tell PenPoint where to begin typing by setting the insertion point. If instead of adding text you want to replace text, select the text you want to replace and then begin typing.

Typing Text Directly onto the Page

To type text directly onto the page:

1 Tap the software keyboard icon on the Bookshelf. (If the keyboard icon is not visible, tap Tools and tap the keyboard icon).

2 Press ‣ to set an insertion point in the text. (Tap to locate the insertion point if you’ve set the Primary Input to keyboard on the Pen Preferences sheet.)

3 Tap a character on the keyboard.
   PenPoint inserts it in the text.
   ▲ To replace a character, tap it to select it and then tap the appropriate key.
   ▲ To delete a character, tap the backspace key.
   ▲ To move the keyboard, press and drag the title line.

4 Tap the close corner to close the keyboard.
Correcting Text in the Writing Pad by Typing

You can correct text in a boxed or ruled-boxed writing pad by typing with the keyboard.

1. Tap the keyboard icon on the Bookshelf. (If the keyboard icon is not visible, tap Tools and tap the keyboard icon).

2. Press ▼ to make a box active. (Tap to make it current if you've set the Primary Input to keyboard on the Pen Preferences sheet.)

   Tap the appropriate key on the keyboard.

   PenPoint inserts it in the box.

   If you continue typing PenPoint replaces the characters in the subsequent boxes with what you type.

   △ To delete a character, tap the backspace key.

Depending on your writing task, you may want to choose a different keyboard layout. Draw a check ✓ on the title of the current keyboard and tap to select an alphabetical or PC compatible layout or a numeric keypad.

To use a regular PS/2 keyboard, plug it into the GO Quick Charger and follow the same procedure as you do for the software keyboard. You'll find a diagram of how to attach the keyboard in chapter 13, Setting Up Your Computer.

The PenPoint operating system doesn't use the function, {Alt}, and {Ctrl} keys on the keyboard.
Customizing Your Handwriting

The Handwriting Customization tool contains sample sentences which you copy to show PenPoint how you write.

If you’ve never written with a pen on a computer screen before, you might want to spend a few minutes using the Letter Practice tool to get the feel of writing on glass.

Once you’re accustomed to writing on the screen, you’ll be able to train PenPoint in the writing style you’ll actually use in the Notebook.
To use Letter Practice:

1. Tap the Tools icon to open it.
2. Open Handwriting Customization by tapping its icon.

3. Enter a name for your handwriting profile by tapping each letter of your name on the keyboard. (To delete a previous letter, tap the backspace key.)

4. Tap Begin to start.

5. Tap a button to choose a customization set. PenPoint suggests which set you do Next, but you may choose any set.

If you decide not to customize PenPoint at this time, tap Exit Handwriting Customization to close it.

You'll probably find it easiest to use the keyboard to enter your profile name, but you can also write it in the field. If you make a mistake, cross it out or use the backspace key on the keyboard to delete the text. You can also put the text in an edit pad by tapping the name field. (See “Editing Text in Fields” in chapter 7 (Editing and Formatting Text) for information on editing text.)
Using a Customization Set

A set consists of a series of sentences or letters, numbers, and symbols which you copy.

<table>
<thead>
<tr>
<th>Freshly</th>
<th>Freshly</th>
</tr>
</thead>
<tbody>
<tr>
<td>squeezed</td>
<td>squeezed</td>
</tr>
<tr>
<td>Orange juice</td>
<td>Orange juice</td>
</tr>
<tr>
<td>Will improve</td>
<td>Will improve</td>
</tr>
<tr>
<td>An excellent</td>
<td>An excellent</td>
</tr>
<tr>
<td>Breakfast</td>
<td>Breakfast</td>
</tr>
</tbody>
</table>

1. Copy each letter in the box below it. If you make a mistake, tap Clear to erase the last word you wrote. (If you tap it again it erases the previous word and so on.)

2. Tap Accept when you’ve completed the sentence.

If you normally write in uppercase letters, choose Upper Case Only from the Handwriting sheet in Preferences when you’re finished with Customization. On this sheet you can also adjust the character box shape and width to suit your natural writing style.
You may find that the size of the box isn't the right size for your writing style. To learn how to set the size of the boxes so that you can write easily within them, read "Choosing a Writing Pad Style" in this chapter.

If you choose a larger box size, you may need to scroll the page to bring the areas off the screen into view. Flick up on the page to bring the bottom of the page into view; flick down to bring the top of the page into view. To find out more details about scrolling, read "Scrolling Documents" in chapter 5 (Creating and Using Documents).

PenPoint highlights letters that it doesn't recognize.

A light gray highlight indicates that PenPoint modified an existing shape.

A dark gray highlight means that PenPoint learned a new shape for the letter.

Tap Next to proceed to the next practice sentence.

After completing the sentences in the set, tap Exit to return to the main menu.

If at any time you find that PenPoint mistranslates a few specific characters, you can brush up on those characters with the Individual Character customization.

If you want to quit Customization in the middle, tap Exit, then tap Exit Handwriting Customization to return to the Notebook Table of Contents. To resume Customization, tap Tools to open it, and then tap the Handwriting Customization icon.
Analyzing Your Progress

When you complete a set of sentences or letters, PenPoint displays a status report. Below each category you’ll find recommendations about whether or not it would be useful for you to continue to work on sentences or individual characters.

<table>
<thead>
<tr>
<th>Customization Status Report</th>
<th>Lower Case</th>
<th>Upper Case</th>
<th>Num &amp; Symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sets recommended</td>
<td>6</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Sets completed</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Successfully recognized:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>first session</td>
<td>70-75%</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>last 3 sentences</td>
<td>80-85%</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>This profile:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>new letter shapes learned</td>
<td>31</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>letters shapes adjusted</td>
<td>59</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Last 3 sentences:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>new letter shapes learned</td>
<td>5</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>letters shapes adjusted</td>
<td>19</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Characters needing most attention</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recommendation</td>
<td>Further training</td>
<td>Further training</td>
<td>Further training</td>
</tr>
<tr>
<td></td>
<td>will be helpful</td>
<td>will be helpful</td>
<td>will be helpful</td>
</tr>
</tbody>
</table>

Tap to choose another set or tap the Exit Handwriting Customization button.

If you end the customization session before completing it, PenPoint remembers the statistics from your previous session when you resume it.

You can end a customization set at any time by tapping the Exit button. If you exit before finishing the set, you’ll start with the first sentence of the set when you resume. (The PenPoint operating system displays new text for you to copy when you begin the set again.)
Accommodating Multiple Users

If you’re sharing your Notebook with others, each of you can create your own handwriting profile.

The first person who uses the Notebook creates a profile by renaming the standard one in Handwriting Customization. After that, you’ll find a copy of the standard profile—which you can customize and rename—in the Installer. When you switch users you activate your individual profile from the Installer.

You’ll find a further explanation on how to create, backup, and rename profiles in chapter 4, Installing Applications and Devices.
CHAPTER 7

Editing and Formatting Text
Selecting Text

Sometimes the object of your commands is obvious. For example, to delete a single word you draw a cross out \( \times \) over it. At other times, you need to tell the PenPoint™ operating system what to act upon by first selecting it. For example, to delete several lines of text, you first need to select them.

Our bottles should be able to withstand the impact from a tricycle powered by a three year old. But four bottles of our new salsa broke, spilling their contents all over the floor.

Tap to select a single character.

Our bottles should be able to withstand the impact from a tricycle powered by a three year old. But four bottles of our new salsa broke, spilling their contents all over the floor.

Double tap to select a word.

Our bottles should be able to withstand the impact from a tricycle powered by a three year old. But four bottles of our new salsa broke, spilling their contents all over the floor.

Triple tap to select a sentence.

Our bottles should be able to withstand the impact from a tricycle powered by a three year old. But four bottles of our new salsa broke, spilling their contents all over the floor.

Quadruple tap to select a paragraph.

To select the entire document, choose Select All from the Edit menu.
You can specify how much text is selected with two other gestures: brackets [], and press \( \boldsymbol{P} \) and drag.

Press \( \boldsymbol{P} \) on a character until you see the insertion point—you'll see a vertical line where you pressed—and then drag to select the text. You end the selection by lifting the pen.

Or, draw a left bracket [ and then a right bracket ] to select enclosed text. (Drawing a bracket anywhere on the word selects the whole word.)

Redraw either bracket to adjust the selection.

Selecting the text by pressing and dragging works best when you want to define a selection that begins or ends with an individual character. The brackets are more efficient when you're working with whole words. They also let you scroll to another part of the document before completing the selection.

When you redraw a bracket to shorten the selection, you can redraw it on a character. This is useful, for example, when you want to select text without the comma, period, or other punctuation that follows it.
Editing Text

Once the PenPoint operating system has translated your handwriting into text, you can change the text directly on the page, or correct or replace the text in an edit pad. Make corrections in the edit pad when only a few characters need to be corrected. Use the replace gesture when it’s easier to rewrite the text than edit it or when you want to replace it with new text.

Styling and formatting text are covered later in this chapter.
Adding Text

To add text to a document, you use the writing pad that best accommodates the amount of text you want to add.

To add one character, draw an insert character gesture | and write in the pad that appears.

PenPoint translates your writing when you lift the pen away from the screen.

To insert one or more words, use a pop-up pad. To get one, draw a caret ^.

Tap OK to translate your writing in the pad; tap OK again to transfer it to the page.

To add several lines of text, use an embedded pad. To get one, draw a caret tap ^.

Tap OK to translate your writing in the pad; tap OK again to transfer it to the page.

▲ If you want to close it without translating what you’ve written, tap Cancel.

PenPoint inserts the text where you drew the gesture to get the pad.

You can find out more about how to use writing pads in chapter 6, Writing in the Notebook.
Deleting Text

The delete gestures operate directly on a character, word, or a selection.

- Draw a vertical pigtail  to delete a single character.
- Draw a cross out  to delete the word or selection beneath the gesture.
- Or, scratch it out ..

Inserting Spaces in Text

- To add a single space, draw an insert space gesture  .
- Repeat this gesture to add more spaces.
Editing Text in Edit Pads

If the text you want to change contains several mistranslated letters, you might find it easier to change the text in an edit pad.

1. To edit a word, draw a circle over it.
   - To edit more than a single word, select the text and then draw the circle over the selection. An edit pad opens with your selection in it.

2. You can edit the word or words in several different ways:
   - Write the correct letters over the incorrect ones.
   - Clear the pad by tapping Clear and then write in new text.
   - Edit the text with:
     - a vertical pigtail to delete a single character.
     - a horizontal line — to delete a series of letters.
     - an insert space gesture to insert one or more spaces (the length of the horizontal stroke at the bottom determines the number of spaces).

3. Tap OK to replace the text.
   - To dismiss the edit pad without translating your printing, tap Cancel.

If you need more room to write, resize the edit pad by dragging its corner handle. (Resizing pads is explained in chapter 2, Fundamentals.)

To replace a word: Draw the replace gesture over the word to display an empty edit pad; write in the new word, tap OK, and if the word is correct, tap OK again. PenPoint replaces the original word with the new one.
Editing Text in Labels and Document Titles

Edit labels and document titles the same way you do text in documents: draw a circle over the text and change it in the edit pad.

Use the edit pad to edit:
- Tab, icon, and hyperlink labels
- Document and section titles in the Notebook Table of Contents
- Titles in the document title line.

Editing Text in Fields

You can also change text written in fields on forms, option sheets, and lists. To change text in fields, edit it in the edit pad or change it directly on the page.

To use the edit pad:
- Tap the text in the field or draw a circle over it to put the text in an edit pad.
- Edit the text using the vertical pigtail, horizontal line, and insert space gestures.

You can edit the text in a fill-in field (a field that looks like a line) directly on the page.

To delete the contents of the field, cross it out or scratch it out.

To add text, draw a caret.

To edit the text directly, draw a vertical pigtail to delete a single character.

To add a space, draw an insert space gesture. Repeat this gesture to add more spaces.
You can also change the text in a field with boxes (an **overwrite field**) directly on the page.

To change text by overwriting, write the correct character over the incorrect one.

To delete a single character, draw a vertical pigtail _vertical bar_.

To delete several characters, draw a horizontal line or a scratch out _scratch out_ through the characters you want to delete.

To add one or more spaces, draw an insert space gesture _the length of the horizontal stroke at the bottom determines the number of spaces_.

Sometimes it’s more convenient to copy text from the document to a fill-in field. For example, you might copy text from a document to the Find field on the Find dialog sheet. To do this, select the text to copy, and then tap press and drag the text to the field.

If you find it easier to use the software keyboard to add text:

- Tap the keyboard located on the Bookshelf or in Tools.
- Press _press_ to tell the PenPoint operating system where to enter the text. (If you’ve set keyboard as the Primary Input on the Pen sheet in Preferences, then tap to set an insertion point).
- Type in the text.
You can move or copy text within a document or to another document by using gestures or by choosing the appropriate command from the Edit menu. For example, you can rearrange the order of an itemized list by moving the paragraphs, or you can copy text you want to use again from one document to another one.

Moving Text

To move text:

1. Select the text you want to move.
2. Press your pen on the selection and hold it there until you see a single marquee surrounding the text (or a portion of it, if the selection is longer than a few words).
3. Drag the text to a new location in the document.

To accurately position the text you’re moving or copying, lift the pen where you want the text to go: between words, sentences, or paragraphs. To cancel a move or copy, tap anywhere on the page before dragging the text.
You copy text almost the same way you move it. To copy text:

- Select the text.
- Tap the selection and then touch the pen to the screen again and hold it until you see the double marquee surrounding the text. This is the tap press gesture.
- Drag the copied text to its new location.

If you find it easier to use the menu commands, select the text, choose Copy from the Edit menu, and then drag the marquee to its destination.

You can also move or copy text to a part of the document that’s not currently displayed or to another page. To do so:

- Select the text.
- Press on the text until you see the marquee if you’re moving it; tap press until you see the double marquee if you’re copying it.
- Scroll to another location, or turn to another page (the text in the marquee floats above the new location).
- Drag the text to its destination.
You can change the appearance of text by using gestures or the text option sheets to:

- change the text style to bold, italics, or underlined
- choose a different font (the typeface) or point size
- change cases, for example to turn upper case words into lower case.

**Styling Text Directly**

You use gestures to style text directly on the page. If you select a range of text, the gesture applies to the selection; otherwise, it applies to the word that lies beneath the gesture.

To restore the text to its previous style, draw the same gesture again on the word or selection.
To style text

**B** to bold the text

*I* to italicize it

**U** to underline the text

**N** restores the text to its normal settings by removing styles such as bold type, italics, and underlining.

To increase the size of the characters by 2 points—the next available size on the font option menu—draw an arrow up ↑.

To decrease the size of the characters by 2 points, draw an arrow down ↓.

To change the text to upper case, draw a –↑.

To convert the text to lower case, draw a –↓.

To change the text to initial capitals, draw a –↓.

In MiniText documents, you can also change the case by selecting the text and then choosing the appropriate case from the Case menu.

For more information about how to draw these gestures, see chapter 3, Drawing Gestures.
Styling Text with Text Option Sheets

When you want to make several changes to a document or a range of text, you might find it more convenient to use the Character option sheet.

1. Select the text to style and draw a check over the selection.
   - If the Character option sheet isn’t displayed, tap the arrow in the title line of the option sheet to see the list of option sheets, and tap Character.

2. Tap to select an option.
   - Some options present several further choices. These appear on pop-up lists.

3. Tap Apply & Close.

You can also display the text option sheets by selecting text and choosing Options from the Edit menu.

When you display the text option sheets, the check marks next to the options that apply to the current selection are dimmed. Check marks for your new choices are dark (if you deselect an option, the line next to the option turns dark). This enables you to easily see which new attributes you’re applying to a selection that contains several different styles. When you tap Apply, PenPoint applies only the new choices.
You can change the placement of text on the page by setting paragraph options. For example, you can indent a paragraph or center a title.

### Setting Margins

1. Select the text to format and draw a check mark over the selection.
   - If the Paragraph option sheet isn’t displayed, tap the arrow on the title line and choose Paragraph.

2. Write in the number of inches for the Right and Left Margin. (This specifies how much the text will be indented from the document page margin, not from the edge of the page itself.)
   - Set the document page margins with the Print Setup command on the Document menu.

3. Tap Apply & Close.

You can also change the alignment of the margins and center text within the margins. For details, see “Positioning Text” later in this chapter.
### Changing Line Spacing

You change line spacing and paragraph spacing on the Paragraph option sheet.

1. Select the text to format and draw a check ✓ over the selection.
   - If the Paragraph option sheet isn’t displayed, tap the arrow on the title line and choose Paragraph.

2. You can alter the line spacing in several ways:
   - Increase the **Line Height** when you have several fonts on a line and want more space around the letters.
   - Change the spacing **Between Lines** by writing an amount in inches.
   - Indent the first line of each paragraph by writing an amount in inches for the **1st Line Offset**.
   - Change the spacing between paragraphs by adding **Space Before** the first line of the paragraph or **Space After** the last line.

3. Tap Apply & Close.

Use the line spacing offset to adjust the spacing around an embedded document so it isn’t flush against the preceding text and, similarly, to add more space to a line if a font you’ve chosen looks crowded. To add space between the top of a document and the first paragraph, change the line spacing before the first line.
Positioning Text

You change the placement of text on the page by selecting the appropriate Alignment option on the Paragraph option sheet.

1. Select the text to format and draw a check ✓ over the selection.
   - If the Paragraph option sheet isn't displayed, tap the arrow on the title line and choose Paragraph.

2. Tap to choose an Alignment:
   - Align the text flush left.
   - Center the text.
   - Align the text flush right.
   - Align the text evenly on both margins.

3. Tap Apply & Close.
Setting Tab Stops

You specify the position of tabs on the Tab Stops option sheet and set tabs directly on the page.

1. Select the text and draw a check \( \checkmark \) over the selection to see the option sheets.
   - If the Tab Stops sheet isn't displayed, tap the arrow in the title line and choose Tab Stops from the list.

2. Write a number in inches for each tab stop. To change the current tab stop, write a new number over the existing one.

3. Draw a caret \( \wedge \) to insert a new tab stop.
   - Draw a cross out \( \times \) to delete a tab stop.

4. Tap Apply & Close.

5. To insert a tab on a page, draw an insert tab gesture \( \underline{\text{L}} \) before the text you want to indent. PenPoint sets the tab stops based on the amounts you entered in the Tab Stops option sheet.

In MiniText documents, you can also insert a tab on a page by setting an insertion point—press \( \uparrow \) to set it—and then choosing Tab from the Insert menu.
Starting a New Line, Paragraph, or Page

By using a gesture or equivalent menu command you can start a new line, paragraph, or page. You might start a new line to add blank lines or to split an item on a list into two items. When you start a new paragraph, PenPoint applies the current paragraph formatting options to it, such as the amount to indent the first line.

To insert a paragraph break and make a new paragraph, draw an insert paragraph gesture.

To insert a line break and start a new line, draw an insert new line gesture.

In MiniText documents, you can also start a new line or paragraph by tapping to select a location and then choosing the appropriate command from the Insert menu.

To add a page break to a MiniText document:

- Press $ to set the insertion point (or tap $ if you’ve set keyboard as the Primary Input on the Pen Preference sheet).
- Choose Page Break from the Insert menu.
Copying a Format or Style

Sometimes you may want to apply the same format or style to a different selection. For example, you might copy the format of a section title in the beginning of a report to a title that appears later in the report. To copy a format or style:

- Select the text which has the format or style you want to copy.
- Draw a check \(\checkmark\) to display its option sheet.
- Turn to the option sheet that has the formats you want to copy. For example, to apply the character styles you used in the heading, turn to the Character option sheet.
- Scroll to the part of the document, that contains the text you want to format.
- Select the text.
- Tap Apply.

You can copy formats and styles of objects as well as text. For example, in a drawing of a floor plan you might want to change the pen width and fill pattern you’re using for windows to match the one you used on a previous drawing.
Viewing Text

The View options change the page display. With these options you can increase or decrease the magnification and show hidden text or symbols that tell you how the text is formatted.

You display the View option sheet in the usual way: draw a check ✓ on the text, tap the arrow at the top of the sheet to see the list, tap View, and then choose the appropriate options. When you apply the View options, they apply to the whole document rather than a selection.

Tap Yes from the Show Special Characters pop-up menu to show symbols on the screen, such as:

- line breaks
- paragraph marks.

To hide text, use the Character option sheet; to view or print it, use the View option sheet. For example, to add to a document notes or comments that you don't want to show or print, select the text and choose Hidden from the Character option sheet. To view or print that text, choose Show Hidden Text from the View option sheet.
Magnifying the Text

You can increase the size of the text by magnifying it. When you magnify text, the letters become bigger without increasing their font size. That makes it easier to work with the document on screen without changing how it will look when it’s printed.

To magnify text:

- Draw a ✓ on a word to display the text option sheets
- Tap the option name to select the View sheet if it’s not displayed
- Tap to see the different magnification amounts and tap to select a magnification size.

Before printing a document, you may want to see what it will look like when it’s printed. To preview it:

Choose For Printer from the Format menu to see how the page will look when it’s printed.

- If you’ve set margins that are wider than the PenPoint computer screen, draw a flick left to scroll to the part of the document that’s off the screen.

Choose For Screen to see the page as it usually appears on the screen.
You can check the spelling of anything you’ve written in the notebook. For example, in a document you can check the spelling of a single word, selected text, or the entire document.

When you check the spelling of a document or selection, the spell dialog shows each misspelled word in an edit pad. If you don’t find the correct word among the alternatives, you can correct it in the edit pad using the editing gestures described in “Editing Text in Edit Pads” in this chapter. Or, you can write a new word over the old one.

1. To check the spelling of an entire document, draw an S on the title line or choose Spell from the Edit menu.

   - To check a word or part of a document, select the text and draw an S over the selection.

   PenPoint displays the Spell dialog and puts the first misspelled word it finds in the edit pad.

2. Tap on an alternate word.

   PenPoint substitutes the correctly spelled word and continues checking the text.

   Tap Ignore to skip a word without correcting it and continue checking.

3. At any time you can tap Cancel to close the spelling checker.

You can check the spelling of a document from any point forward by drawing an S there. (Before drawing the gesture, deselect any selected text by tapping it, or the PenPoint operating system will check the spelling of the selected text.)

Sometimes it’s easier to edit the word in the edit pad than to find its alternative in the list. For example, you might be able to correct a word by deleting a single character. Then tap Replace to transfer the edited word to the page and continue checking.

If the word you want isn’t on the list, you might find it in a list of further alternatives. Double tap any alternate word to display more alternatives. The alternate word you tapped goes into the edit pad.
**Adding a Word to the Dictionary**

PenPoint refers to the 77,000 word Proximity/Merriam-Webster Linguibase when it translates your writing and checks your spelling. You can add words, such as company names or acronyms, to a separate personal dictionary so PenPoint will recognize them. You can add words to your personal dictionary from the spelling checker, from the proof sheet, or by writing them directly in the personal dictionary which is found in Tools.

Each time you tap the OK button on the proof sheet or the Replace button on the spelling checker to accept the word, you automatically add it to your personal dictionary.

To see the words you’ve added to the dictionary, open the personal dictionary in Tools. You can add to, delete, or edit the words there.

1. Tap to open Tools.
2. Tap to open the personal dictionary.
3. To view the list of words, flick the page or tap the scroll arrows.
4. Delete a word by drawing a cross out \( \times \) over it.
   - To add a new word, draw a caret \( \wedge \) and write in the new word.
   - To edit words, draw a circle \( \circ \) to open an edit pad and make changes there.

Read “Editing Text in Edit Pads” in this chapter to find out how to revise text in the edit pad.
Adding your Signature to a Document

In many kinds of documents you can add a signature to your correspondence with the signature pad. Whatever you write on this pad appears untranslated in the printed document, as if you had written it directly on the page. You'll need a graphics printer to be able to print your signature.

1. To add a signature to a MiniText document, tap to select a location in the document.

2. Choose Signature Pad from the Insert menu.
   - If necessary, resize the pad by dragging the corner handle.

3. Write your signature naturally, in whatever style you normally use within the borders of the signature pad. The borders won’t be printed.
   - To delete a signature pad, tap the space immediately above the pad to select it. Then choose Delete from the Edit menu.
   - To move the pad, select the pad by tapping the space immediately above it, and then press and drag the signature pad to where you want it to go.

Once you've added a signature to a document you can fax it or print it with a graphics printer.
CHAPTER 8

Finding and Replacing Text
The PenPoint™ operating system's Search command can find a specific word or phrase every time it appears in a document. If you wish, it will also replace it with different text. You can search an entire document or limit the scope of a search.

1. To search the whole document, draw an F on the title line (or, choose Find from the Edit menu).
   
   You'll see the Find dialog sheet.

2. Write in the text you want PenPoint to find.

3. Tap Find to find the first occurrence of the text.
   
   Repeat this procedure until the message in the Status line tells you that the search is completed.

4. At any point you can tap Close to close the sheet and end the search.

If the Find field is filled in from the last time you searched the document, delete the text by drawing a cross out X on it and write in the new text. Or, tap J on the text to open an edit pad and change it there. Refer to “Editing Text in Fields” in chapter 7 (Editing and Formatting Text) for the details of editing text in fields.

You can also search for text by copying the text from the document to the Find field: select the text, copy it with the tap press gesture J, and drag it to the Find field.

If PenPoint can’t find the text, you’ll see the message Reached End in the Status line.
Use the Find & Replace sheet when you want to replace the text you find with other text.

At times you'll want to stop at each occurrence to decide whether to replace it. For example, if you're replacing a word with another one, you might want to check the usage in each sentence to make sure it's correct. In this case tap \( \text{Find} \) and then \( \text{Replace} \) each time.

If you want to replace all occurrences of a word automatically throughout the document, tap \( \text{Replace All} \). For example, if you're revising a contract for a new client, you can substitute the current client's name for the old one.

1. To search the whole document, draw an F on the title line. Or, choose \( \text{Find} \) from the Edit menu. You'll see the Find dialog sheet.

2. Tap the arrow on the title line to see the list of sheets. Tap \( \text{Find} \& \text{Replace} \).

Dear Ms. Huerta:

This is our agreement concerning your involvement in a new bottle design for New World Foods, Inc.

1. You draw in your design.
2. You become a part of our design team.
3. New World will pay each invoice from an approved estimate within thirty (30) days.
4. You and your assistants at FastPak Design are not and will not be employees of New World Foods, Inc. This is a contract for services for hire.
3 Write in the text you want PenPoint to find in the Find field. Or, copy the text into the Find field.

Write in the replacement text in the Replace field.

4 To stop at each occurrence:
   ▲ Tap Find to locate the first occurrence of the text.
   ▲ Tap Replace if you want to insert the new text.
      If you don’t want to insert the text, tap Find to locate the next occurrence.
   ▲ Tap Find to continue the search.
   ▲ Repeat this procedure until the message in the Status line tells you that the search is completed.

To replace every occurrence automatically, tap Replace All.

At any point you can tap Close to close the sheet and end the search.

If the text in either the Find or Replace fields is filled in from the last time, delete the text by drawing a cross out X on it and write in the new text, or tap , the text to open an edit pad and change it there. See “Editing Text in Fields” in chapter 7 (Editing and Formatting Text) for details.
The search options on the Find & Replace sheet set the extent and direction of the search and the attributes to look for, such as whole words or words whose case matches exactly.

Setting the Search Range and Direction

You can tell PenPoint what part of the document to search, where to start the search, and in what direction to search.

To set the search range:

- To search forward from any point in a document, draw an F in the body of the document. PenPoint searches from the place you drew the gesture to the end of the document. To continue searching from the beginning of the document, tap Find again.
- To search a selection, select the text and draw an F over it.
- PenPoint searches the document itself and any embedded documents. However, you can restrict the search to the document by choosing Document Only from the Search category pop-up list.
To set the direction and starting point of a search, use the Find & Replace sheet.

To search towards the end of the document, tap **Forward** from the **Direction** category pop-up list.

To search toward the beginning of the document, tap **Backward** from the **Direction** category pop-up list.

To start the search at the last place PenPoint found the text, tap **Last Match** from the **Start From** category pop-up list.

To start the search at the beginning of the document, tap **Beginning** from the **Start From** category pop-up list.
Refining the Search

PenPoint gives you several other ways to refine the search. For example, you can tell PenPoint to locate only those instances where the text forms a complete word. This is helpful when you want to find a word such as *pen* without stopping for words such as *depend* and *peninsula*.

To refine the search, use the Find & Replace sheet.

- **Same case only** finds the text if it has the same case as the original text.
- **Complete word** only finds the text if it forms a whole word.
- **Original word** replaces text using the case of the original text.
- **Replacement word** replaces text with the case you used in the Replace field.
CHAPTER 9

Managing the Notebook
The Table of Contents lists all the documents in your Notebook and lets you organize them. You can find out more about the documents with the Table of Contents’ menus, such as the Show menu, which tells you the document’s size and when you last modified it.

From the Table of Contents, you can organize the Notebook by moving documents and sections from one location to another and by placing related documents in sections. You can also customize the PenPoint™ operating system to suit your work habits by setting preferences such as the writing pad style and screen layout.

When you use the Notebook you’ll often work with more than one document at a time. There are several ways to do this. Each method offers its own advantages.

- The Table of Contents shows all the documents in the Notebook organized by section, which makes it easy to identify and turn to or float the one you want.
- Notebook tabs let you use a single tap to turn to a page or float it from anywhere in the Notebook.
- Page arrows in the title line let you navigate quickly from one page to another.
- Hyperlink buttons let you move directly to another location within the same document or a different document.

Before you can float documents, you must choose the Document Floating option on the Preferences Safeguards sheet.
The Table of Contents lists all the documents and sections for the entire Notebook in the order in which they appear. Page numbers refer to the page in the Notebook where you can find the document.

In both the Notebook and the section tables of contents, you can use menus instead of double tapping to see what’s in a section. Tap its title to select it and then choose Expand from the View menu. Choose Collapse from the View menu to hide the document titles again. To see all the titles in the Notebook, make sure nothing is selected on the Notebook Table of Contents and then choose Expand. (If a title is selected, tap it to deselect it.) To hide all the titles, make sure nothing is selected, and then choose Collapse.

As you create documents in the Notebook, the titles may not all fit on the screen. You can see more of them by using smaller icons next to the titles (and therefore decreasing the amount of space between titles). To change the size of the icons, choose Button from the Show menu.

To see a list of the documents contained in a section, double tap the section's title. To float a document or section, double tap its page number or icon.
The document option sheets and the Table of Contents Show menu give you two tools for getting information about a document, such as its size, the date you created it, and the program you used to create it. The Show menu gives you basic information about all the documents at once, whereas the document options sheets give you more detailed information about an individual document.

Using the Show menu

1. Tap \( \triangleright \) to display the Show menu.
2. Tap each kind of information you want to see; tap again to hide it.
   - A single vertical line next to the choices indicates a check list from which you can choose one option. A double line indicates a multiple check list from which you can choose more than one.

   Tap Icon to show the standard sized application icon.

   Tap Button to display a smaller icon next to the title.

   Tap Type to see the application name.

   Tap Date to find out the date on which you last modified the document.

   Tap Size to tell how large the document is in kilobytes (a kilobyte contains approximately 250 words).

   Tap Tab Box to display the column of tab boxes (tap to add or remove a Notebook tab).
Using the Document Option Sheets

The document option sheets supplement the information in the Table of Contents. Refer to them to see information such as the size of the document when it's active and to change things such as the page display.

1. Turn to the document.
2. Draw a check ✓ on the title line.
3. Tap the arrow on the option sheet's title line to see the other option sheets and make changes if necessary.
4. Tap Apply & Close.

Use the Title & Info sheet to enter information about the document and to find out when you created or last changed it. You can also find out how much space the document occupies in the Notebook when you're not using it (Filed Size) and how much memory it takes up when you're working with it (Active Size).

The Access sheet determines what areas of the page PenPoint displays. This is also where you protect the document from being accidentally deleted or edited. An Access Speed option lets you cut down the time it takes to turn to a document. (Note that this option uses more memory than the normal page turn speed.)

Refer to the Application sheet for information such as the version of the application you're using.

You can also open the document option sheets by choosing About from the Document menu. Choosing About from the Table of Contents displays the option sheet for the Table of Contents.
Commands in the Sort menu let you rearrange the Table of Contents, reordering the titles by different criteria to more easily see what's in your Notebook. For example, you can list documents in order of size so you can decide which ones to store outside of the Notebook.

Tap the Sort menu, then tap:

- **By Page** to display the documents in the order they appear in the Notebook (the default order unless you change it).
- **By Name** to list the documents alphabetically.
- **By Type** to group the documents by application.
- **By Date** to put the documents in order by the date you last modified them.
- **By Size** to arrange the documents according to the amount of memory they occupy in the Notebook.

The Sort commands for **Type**, **Date**, and **Size** also appear on the Show menu. Choose the same command from the Show menu to see the information for the titles you're sorting.

Sorting documents rearranges their order in the Table of Contents but not their page location in the Notebook.
You can rearrange documents in the Notebook by moving pages and placing related documents in sections. Rearranging pages changes their location in the Notebook.

**Moving Pages**

The easiest way to reorder documents is to move them in the Table of Contents.

Press ▼ until you see the marquee, and then drag the document where you want it to go.

PenPoint inserts the new document where you lift your pen.

▲ To move it between two documents, lift the pen in the space between them.

▲ To move it into a section, lift the pen when the marquee is aligned with the other documents in the section.

▲ To move it out of a section, lift the pen when the marquee is lined up with a title or blank space outside the section.
You can organize your computer Notebook as you would a paper notebook, placing related pages together in sections and subsections.

Creating a Section

1. Turn to the Table of Contents.
2. Draw a caret \( \wedge \) where you want the new section.
   The pop-up Create menu appears.
3. Choose Section from the pop-up Create menu.
   PenPoint inserts the new section where you drew the caret.

To rename a section, draw a circle \( \bigcirc \) on the title to put it into an edit pad where you can change it. Or select the section by tapping on it and then choose Rename from the File menu.

When you create a section, PenPoint automatically inserts a section divider that lists the section's documents and works exactly like the Notebook Table of Contents.

To delete a section, draw a cross out \( \times \) on the section title. If you intend to use the section again, back it up to a disk before deleting it from the Notebook.
Moving a Document into a Section

Once you create a new section you can create documents there or move existing documents into it.

To create a new document inside a section, double tap the section title to expand it, draw a caret where you want the new document to go, and then choose a piece of stationery from the Create menu. (Or tap to select a location—tap Empty if there are no documents—and then choose a piece of stationery from the Create menu).

To move a document into a section, press the title until you see the marquee, then drag the document to a location in the section.

To move a document out of a section, press the title until you see the marquee, and then drag the document out of the section. (Lift the pen when the tip of the pen is lined up with the beginning of a title outside a section.)
Creating a Subsection

Sections can contain subsections. To create a subsection, open a section, select a location in it, and choose Section from the Create menu.

Subsections work the same way sections do. Each subsection has its own table of contents that lists the documents it contains. This information is repeated in the section and Notebook Table of Contents.

You can make an existing section into a subsection by moving it into another section. For example, you might move a section you’d created for a prospective client into a section for new clients.

You can also do the reverse and make a subsection a section by selecting it and moving it out of the section to another location on the Table of Contents.

Creating Multiple Notebooks

If you find that you’re creating many sections in your Notebook, you may find it simpler to organize your work by creating notebooks for each primary topic, for example, for each major client or project. Similarly, if you’re sharing the Notebook with several other people, you may find it convenient to create a notebook for each user.

To find out how to create and use multiple notebooks, read chapter 12, Learning More About PenPoint.
The Table of Contents displays all the documents in the Notebook. From the Table of Contents you can use gestures to turn to a document or to float a document.

Turn to a page by tapping the document's:

- icon
- page number
- Notebook tab.

Float a page by double-tapping the page number, icon, or Notebook tab.

Before you can float a document, you need to choose the option for floating documents on the Safeguards option sheet in Preferences. You need to set this option only once to be able to float documents any time you use the Notebook.
Instead of using gestures to turn to or float a page, you can choose equivalent commands (Turn to and Bring to) from the View menu. Select the title in the Table of Contents by tapping it and then choose the appropriate command.

If you’re not working on the Table of Contents you can thumb through the Notebook by pressing the arrows near the page number.

You can also draw flicks in the title line to turn to the next page (flick left) — or go back to the previous page (flick right) —. Think of this as thumbing through a notebook; you turn a page to the left to see the next page, and to the right to go back toward the beginning.
Using Notebook Tabs to Mark Pages

Notebook tabs offer a quick way to identify a page and turn to it or float it. You can attach a tab to any document or section by drawing a T on the title or by displaying the column of tab boxes and tapping the one for that document.

Attaching and Deleting Notebook Tabs

1. Turn to the Table of Contents.

2. To attach a tab, draw a T on the document or section title.
   ▲ To remove it, draw the T again.

When you attach a tab, PenPoint automatically labels it with the document title. However, a long document title may not fit on the tab, so you can rename the tab with a shorter or more useful title. Draw a circle • on the tab to display the title in the edit pad and change it there.

Usually renaming a document automatically changes its tab label as well. However, if you change the document title after editing the tab label, PenPoint doesn’t automatically change the tab label. (That way you don’t lose the shorter tab label.)

For details on editing tab labels, see “Editing Text in Labels and Document Titles” in chapter 7 (Editing and Formatting Text).
Attc;\[eling Several Notebook Tabs

In managing the Notebook, you may find it more convenient to attach and remove several tabs at once.

1. Turn to the Table of Contents.

2. Tap Tab Box on the Show menu.

- A check mark in the box indicates the page has a tab.
  
To attach a tab, tap inside the box.

- To remove it, tap again.
Displaying Notebook Tabs

When you have more tabs than can fit along the edge of the notebook, they appear overlapped. To see the hidden labels, draw flicks on the tabs.

- Flick left — to see all the tabs at once.
- ▲ Tap a tab to turn to its page.
- ▲ Tap anywhere outside the tabs to collapse the rows into one.

To push the overlapped tabs to the top, double flick up anywhere in the row.
- ▲ To shove the overlapped tabs to the bottom, double flick down anywhere in the row.

To see an overlapped tab, flick down on the overlapped tab.
- ▲ Or, flick up on the tab above it.
Using Hyperlink Buttons to Move between Pages

Hyperlink buttons give you a way to turn quickly to another document or a location in the same document. For example, if you're working on the conclusion to a monthly report and want to refer to a table earlier in the document, you might insert a button at the concluding paragraph to scroll to the table and one on the table to go back to the paragraph.

1. Start in the document where you want to add a hyperlink button.

2. Float the Table of Contents by double-tapping its tab. (You must have the floating option turned on.)

3. Tap to select the document you want to jump to. If you tap the document title, the hyperlink button takes you to the top of the document.

   ▲ To go to a specific place within the document, float it and tap to select a location.

4. Draw a hyperlink gesture on the first document where you want the button.

The Hyperlink buttons work like page numbers in the Table of Contents: Tap the button to turn to the linked document or double-tap to float the linked document over the first.
Once you've created a button, you can move it to another location or redefine it. To move it, press \( \mathcal{P} \) on it until you see the marquee, then drag it to a new location. To copy it, tap press \( \mathcal{P} \) until you see the double marquee and then drag it to where you want it.

By redefining a button, you can turn a hyperlink button into a temporary marker. To reset it for another location, select the new location by tapping it, and then triple tap \( \mathcal{P} \) on the button. The button title then changes to reflect the new location.

To make a link to an embedded document, float the document that contains the embedded document, draw a plus \( + \) on the embedded document’s icon to select it, and then draw a hyperlink button gesture \( \mathcal{C} \) on the first document.

If you're working on part of the document where the button is out of view, you can move the button to the cork margin where it’s always available. To find out how to use the cork margin, see chapter 5, Creating and Using Documents.

To delete a hyperlink button, draw a cross out \( \chi \) over it. You can rename the button label by drawing a circle \( \贸易战 \) on it and editing the text. See “Editing Text in Labels and Document Titles” in chapter 7 (Editing and Formatting Text).
Setting Preferences

Your Notebook comes with certain options preset, such as the screen layout. You can change the preset options in Preferences on the Bookshelf. The options are grouped on separate sheets in Preferences.

<table>
<thead>
<tr>
<th>Preference sheet</th>
<th>Options on sheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>PenPoint</td>
<td>Find out information about the PenPoint operating system such as the company name and version number.</td>
</tr>
<tr>
<td>Handwriting</td>
<td>Choose a case (all upper case or mixed). Choose a writing pad style and adjust the size and shape of the boxes or the distance between lines (covered in chapter 6, Writing in the Notebook). Choose a symbol for the unrecognized character (covered in chapter 6, Writing in the Notebook).</td>
</tr>
<tr>
<td>Pen</td>
<td>Set the angle of the pen for the way you normally write. Choose the pen or keyboard as the primary way to enter text (covered in chapter 6, Writing in the Notebook).</td>
</tr>
<tr>
<td>Fonts &amp; Layout</td>
<td>Choose a portrait or landscape screen orientation, or a left- or right-handed layout. Choose a system font and a font for text in fields, and a size for both.</td>
</tr>
<tr>
<td>Time</td>
<td>Set the time.</td>
</tr>
<tr>
<td>Date</td>
<td>Set the date.</td>
</tr>
<tr>
<td>Safeguards</td>
<td>Turn on floating and zooming (covered in chapter 5, Creating and Using Documents). Turn on the warning beep. Set auto shutoff to have the computer automatically turn off after a certain period of inactivity.</td>
</tr>
<tr>
<td>Timeouts</td>
<td>Lengthen or shorten the time PenPoint waits before interpreting your gestures or writing.</td>
</tr>
<tr>
<td>Memory Usage</td>
<td>Find out how much memory is available (covered in chapter 12, Learning More About PenPoint).</td>
</tr>
</tbody>
</table>

If more than one person uses the computer, you can have PenPoint remember each user’s choices. To find out how to save your preferences, read chapter 4, Installing Applications and Devices.
Setting the Time

Applications and accessories that display the time and date use the settings on the Preferences option sheet.

To reset the time:

1. Tap the Preferences icon on the Bookshelf.
   - If the Time option sheet isn’t displayed, tap the arrow on the title line and choose Time.

2. Tap the current Time Zone choice to see a list of other time zones and tap to choose one.
   - Tap to choose a 12- or 24-hour Time Format.
   - Tap Displayed in the Seconds category to show the seconds; tap Not Displayed to hide this information.

3. Write in the new Hour, Minute, and Second.
4. Tap to choose A.M. or P.M.

2. Tap Apply & Close.

If you change time zones, you don’t need to reset the time. Choose a time zone and PenPoint automatically calculates the new time.
USING PENPOINT
SETTING PREFERENCES

Setting the Date

To change the date:

1. Tap the Preferences icon on the Bookshelf.
   ▲ If the Date sheet is not displayed, tap the arrow on the title line to see the other Preferences sheets and tap Date.
   
   Tap the current Date Format to see a list of other formats and tap to choose one.
   
   Tap the name of the month and tap to choose the correct one.
   
   Write in the numbers for the correct Day and Year. To change a number, write a new number over the old one.
   
   2. Tap Apply & Close.

Setting the Response Time

You can lengthen or shorten the interval, or timeout, before PenPoint interprets a gesture, translates your writing, or displays the marquee that appears when you use the press gesture to move something. By resetting the timeout interval, you can better accommodate the rate at which you naturally work.

To change the response time:

- Tap the Preferences icon on the Bookshelf to open it.
- If the Timeouts sheet is not displayed, tap the arrow on the title line to see the other Preferences sheets and tap Timeouts.
- To change the Gesture, Handwriting, or Press timeout interval, write in the number of seconds you want PenPoint to wait before responding to an action. To change what’s already written in a box, write a new number over the old one.
Using the Auto Shut Off Option

When you don’t have the PenPoint computer attached to a battery charger, you can conserve battery power by having the computer turn off automatically when you’re not using it. To do so:

- Tap the Preferences icon on the Bookshelf to open it.
- If the Safeguards sheet is not displayed, tap the arrow on the title line to see the other Preferences sheets Safeguards.
- Tap Yes for the Auto Shut Off option. If you tap Yes, PenPoint adds a Shut Off After category.
- If you want the computer to stay on, tap No.
- Write in the number of minutes the computer can be inactive before it automatically turns off. To change what’s already written in a box, write a new number over the old one.

Turning On the Warning Beep

When PenPoint displays a confirmation or error message, you must respond to it before PenPoint can continue. As an additional signal, you can have PenPoint sound a warning beep when it displays a message.

To turn on the warning beep, display the Safeguards sheet in Preferences and tap On.
Choosing PenPoint Fonts and Field Fonts

The PenPoint operating system uses a system font to display information such as menu commands and titles on the Table of Contents and Notebook tabs. The field font is for the information you enter in writing pads and fields on option sheets and forms.

You can choose a different PenPoint and field font. Whatever size you choose, however, applies to both fonts.

1 Tap the Preferences icon on the Bookshelf.
   ▲ If the Fonts & Layout sheet isn’t displayed, tap the arrow on the title line to see the other Preferences sheets and tap Fonts & Layout.

2 To change the font:
   ▲ Tap to choose a PenPoint and Field font.
   ▲ Tap to choose a font size.

3 Tap Apply & Close.

Choose text fonts for documents from the Text option sheets. To find out how to style text by changing fonts, read chapter 7, Editing and Formatting Text.
Choosing a Screen Layout

PenPoint offers several screen layouts to accommodate different writing tasks and writing preferences.

1. Tap the Preferences icon on the Bookshelf.
   - If the Fonts & Layout sheet isn’t displayed, tap the arrow on the title line and tap to choose the Fonts & Layout sheet.

2. Tap the appropriate option:
   - Tap to choose a Landscape Orientation when you’re working on a drawing or a task that requires more horizontal than vertical space on the page.
   - Tap to choose a Portrait Orientation to work with a vertical screen layout.
   - Tap to choose the Hand Preference that corresponds to the hand you write with. Choosing Left places the scroll margin on the left side of the screen.

3. Tap Apply & Close. The screen will change to reflect the layout or preference you’ve chosen.
You'll probably find that you use some items on the Bookshelf more frequently than others. You can move the ones you use less often to a second shelf and also rearrange the order to suit you.

For example, once you've customized the notebook and the Create menu, you might move the Preferences icon and Stationery notebook to the second shelf and put in their place the In and Out boxes you use daily to send and receive faxes.

To rearrange items on the Bookshelf:

1. Drag the bottom handle of the current page up to see the second shelf.

2. Press the icon until you see the marquee and then drag it to the second shelf.

To hide all the Bookshelf items, drag the handle down until it covers both shelves.

To move an icon to another position on the shelf, press it until you see the marquee and then drag it to the new position. Note that if you change the icon size you may need to reposition the icons since changing the size of one icon changes them all. (To change the icon size, draw a check on any icon to display the icon option sheet and tap to choose a different icon Style.)
When you’re working with the Help notebook, you may find it useful to annotate it with tips and information you’ve discovered while working with the PenPoint operating system.

To add a new document, draw a caret ‹ on the Table of Contents where you want it to go and choose a piece of stationery from the Create menu. (To find out more about how to create a document, see chapter 5, Creating and Using Documents.)

If you no longer need to refer to a document, you can delete it by drawing a cross out ✗ on its entry in the Table of Contents.

If you find you no longer use Quick Help or the Help notebook, you can delete both by crossing out ✗ the Help icon on the Bookshelf. If you’ve customized the Help notebook you might want to copy it onto a disk before you delete it. (See chapter 11, Filing Documents to find out how to use the Disk Manager to make a backup copy.)
To display the time and date, use the clock, which is in Tools on the bookshelf. You can set the alarm to beep or to show reminder messages, and you can put other documents, like to-do lists and calendars on the clock’s cork margin, which appears with the reminder messages.

1. Tap Tools to open it.
2. Tap the Clock icon.

To move it, put the pen down anywhere on the clock and drag it.

To have it always on display, move it to the Bookshelf or to the document title line.

Tap the close corner to close it.

You can also use the clock to date or time stamp a document automatically when you print it. To do that, copy the clock to a location in a document.

Set the time and date for the clock on the Time sheet in Preferences as explained in “Setting Preferences” earlier in this chapter.
Changing the Display

Use the clock’s option sheets to choose a different display format.

1. Draw a check ✓ on the clock.
   - If the Display option sheet isn’t showing, tap the arrow on the title line and choose Display.

2. Tap the Show option to see a list of other choices; tap to choose one.
   - Tap to choose a font for the date and time.
   - Choose a separate font size for the date and time.

3. Tap Apply & Close.

To hide the clock’s borders or title line, draw a B on the clock or choose the appropriate options on the Access sheet. To close the clock tap its close corner.
Setting the Alarm

The alarm has several settings; you can decide when and how frequently you want the alarm to sound and whether to display a message. You can also set the alarm to display a message without a beep.

1. Draw a check ✓ on the clock.

   ▲ If the Alarm sheet isn’t showing, tap the arrow on the title line to see the list and tap Alarm.

You’ll see a sheet with settings for turning the alarm on and off, setting the time and the day of the week, writing the message you want to see, and determining how often the alarm will sound.

Place any documents, buttons, or accessories you want to appear with the reminder message in the Cork margin.

If you decide you don’t want the alarm to go off at the time you’ve set, open the clock option sheet and turn off the Alarm. To revise a message, open the clock option sheet and delete or edit the message. If the Notebook is turned off, the alarm will turn on the computer so you can see any reminder messages. (Be sure to turn on the Auto Shut Off option on the Preferences Safeguard sheet so that when the alarm turns on the computer, the computer won’t stay on if you’re not there.)

You can set the alarm so it goes off regularly at the date and time you’ve set by choosing Reset for same time. To have the alarm sound again in a few minutes after it first goes off, write in a number of minutes in the Repeat field.

For an explanation of editing text in fields, read “Editing Text in Fields” in chapter 7 (Editing and Formatting Text).
CHAPTER 10

Printing, Sending, and Receiving Documents
Once you create a document you can print it, fax it, or send it as electronic mail. You can also receive incoming documents and faxes. If you’re connected to a printer or a fax/data modem, you can print or send documents as soon as you’ve finished them. If you’re not connected, the PenPoint™ operating system stores the document in the Out box with your printing or mailing instructions.

Printers come with printer drivers which tell the PenPoint computer how to use the printer. You need to install the printer driver with the Installer the same way you install other applications in your Notebook.

After installing the driver in your Notebook, you set options for it with the Printers tool so that the PenPoint operating system knows, for example, to which port you’ll connect. You only set these options once for each printer you plan to use. Thereafter, just choose the Print command.

To find out how to connect the printer to your computer, read chapter 13, Setting up Your Computer. To learn how to copy the printer driver to your Notebook and set options for it, read chapter 4, Installing Applications and Devices. If you plan to use a printer on a network, refer to Connecting to a Personal Computer.
Before you print a document you can format it by setting margins and adding headers and footers with the Print Setup command on the Document menu. Then, when you're ready to print it, choose the Print command, also on the Document menu.

Choosing a Page Layout

1. Choose Print Setup from the Document menu.
   ▲ If the Layout sheet isn't displayed, tap the arrow on the title line to see the list of sheets and tap Layout.

2. Set the appropriate options.
   ▲ Choose a page layout from the Orientation pop-up list.
     Choose Portrait to position the document vertically on the screen; Landscape to position it horizontally.
   ▲ Choose a Paper Size.
   ▲ Write in the number of inches for each margin.

3. Tap Apply & Close.

You can print the document without changing the Print Setup options. (The PenPoint operating system uses the default settings.) When you change the options, PenPoint applies them to each subsequent printing of that document.

To change the number in any of the boxed fields, write a new number over the old one. See “Editing Text in Fields” in chapter 7 (Editing and Formatting Text) for more information on how to edit text in boxes.
Adding Headers and Footers

1. Choose Print Setup from the Document menu.
   ▲ If the Headers & Footers sheet isn’t displayed, tap the arrow on the title line to see the list of sheets and tap Headers & Footers.

2. Set the appropriate options.
   ▲ Choose a Header Font and Header Size. (Whatever font and size you select will also be used for the footer.)
   ▲ Write in the number of inches for the Header Margin from the top of the page to header, and for the Footer Margin from the bottom of the page to the footer.
   ▲ Choose Yes to print a header or footer on the First Page.
   ▲ Write in the text for the Header and Footer.
     You can enter text for one or more positions (left, center, right).
     To print the current page number, write pg., including the period.
     To print the current date, write dt., including the period.
     To print the document name, write nm., including the period.

3. Tap Apply & Close.

Then print the document to see the headers and footers.
Printing a Document

You can print a document from its page in the Notebook or from the Table of Contents.

To print a document from its page in the Notebook:

1. From the document, choose **Print** from the Document menu.
2. Choose the appropriate options.
   - Tap to choose a printer from the **Printer** pop-up list.
   - If you’re connected to the printer, tap **Yes** from the **Printer Enabled** pop-up list. If not, tap **No** and PenPoint places the document in the Out box.
   - Choose a **Paper Size**.
     - If you’re printing on a size not included on the pop-up list, write in the dimensions for the paper’s width (w) and height (h) in the **Other** category.
   - To print the entire document, choose **All** from the **Pages** pop-up list. Or, write in the range of pages.
To print a document from the Table of Contents, select the document title, choose Print from the Document menu, and then follow the steps for printing a document.

1. Write in the page number that should appear on the First Page you print. (Use this to paginate separate documents continuously.)
   - To change a number, write the new number on top of the old one.
2. Write in the number of Copies you want printed.
3. If you're printing more than one copy, choose Yes from the Collate pop-up list.
   - Tap Print & Close.
If you don’t see the printer you want to use on the Printer pop-up list, you need to install a printer driver for it. Refer to chapter 4, Installing Applications and Devices for information. To find out more about how to edit text in boxes, read “Editing Text in Fields” in chapter 7 (Editing and Formatting Text).

When you’re printing on letterhead stationery, check to see how much space you need to leave for the imprint and adjust the document, header, and footer margins accordingly. If you routinely print your documents on letterhead, you might create stationery for it with the margins preset. To find out how to do this, read “Creating Customized Stationery” in chapter 5, (Creating and Using Documents).

Printing from the Out Box

If you’re connected to a printer, PenPoint prints the document; otherwise it stores the document in the Out box with your print instructions. Later when you’re connected to the printer, PenPoint prints the documents in the order that they’re listed in the Out box. To tell PenPoint you’re ready to print:

- tap the Out icon on the Bookshelf to open the Out box.
- tap the box next to the printer name in the Enabled column.

When you do so, PenPoint begins printing the documents. (If you connect to a TOPS printer, PenPoint automatically prints the documents even if you don’t check the Enabled box.)

If you need to print one of the documents that appears later in the queue, you can change the printing order by moving the document you want to print to the top of the list.

Printing Embedded Documents

When you print a document, the PenPoint operating system also prints all its embedded documents. If the embedded document is closed, PenPoint prints only its icon and title. If the embedded document is open, PenPoint prints the portion that’s showing. You can resize the embedded document to print more or less of it, or you can use the Print Entire Document command on the embedded document’s Print Setup menu.

The main document’s Print Setup option sheets set the orientation and paper size for the embedded document and suppress other Print Setup options for the embedded document, such as margins, headers, and footers. If you want to format the embedded document with its own margins and headers and footers, you can do so by setting the Print Setup options for the embedded document and then selecting Print Entire Document. The PenPoint operating system prints the embedded document starting on a new page using the settings you’ve selected and then returns to the options for the document that contains it.
To see how the embedded document gets printed within the container document:

1. Choose Print Setup from the embedded document’s Document menu.
   ▶ If the Layout sheet isn’t displayed, tap the arrow on the title line to see the list of sheets and tap Layout.

2. The PenPoint operating system prints whatever shows on the screen.
   ▶ To change what portion of the document PenPoint prints, resize it.
   ▶ Or, print the entire document without resizing it by choosing Print Entire Document from the Formatting category.
   ▶ If an embedded document is near the end of a page, select Keep on Same Page to prevent the contents from being split between two pages.
   ▶ To make sure that an embedded document always begins on a new page, select Begin on New Page.

3. Tap Apply & Close.

To avoid printing an embedded document (open or closed), you can move it to the cork margin. See chapter 5, Creating and Using Documents, for details.

To print the embedded document without printing the main document, choose Print from the embedded document’s Document menu.

If an embedded document is open, PenPoint normally doesn’t print the menu and title line, borders, and scroll margins. However, some applications may print these elements. The guide that comes with the application will tell you how the application treats these elements when you print a document.
To send or receive documents and information, connect the PenPoint computer to equipment such as the GO Fax/Data cartridge. After you install a driver for the equipment, you can use applications such as a fax or electronic mail service, or an information service.

As you do with the Print command, you can choose the Send command for a document at any time. If you're not connected to a fax/data modem, the PenPoint operating system stores the documents in the Out box with your mailing instructions. When you reconnect the modem, PenPoint automatically sends mail from the Out box and receives incoming mail which it places in the In box in the section for the appropriate service.

To send mail, select a document from the Table of Contents (or turn to the document) and choose Send from the Document menu. You'll see a pop-up list of the services you've installed on the computer. When you choose a service, you'll see a dialog sheet asking you for the appropriate mailing information. Consult the guide that comes with the application for instructions on addressing and sending your mail.

To read incoming mail, copy it from the In box to the Table of Contents. When you do so, PenPoint displays the Import sheet so you can choose an application to use with it.

Further information on sending and receiving documents will be included in the next version of Using PenPoint.
CHAPTER 11

Filing Documents
Managing the contents of the PenPoint computer is similar to managing the contents of a loose leaf binder. Periodically, you remove pages you've finished working with or won't need until a later date. Some documents get discarded, others copied for your files or for a colleague. You perform these filing tasks by copying and moving documents to and from disks.

You'll most often transfer documents from the PenPoint computer to a disk:
- to keep backup copies on a disk
- to use the space in the Notebook most efficiently
- to work with them on a PC.

You'll most often transfer documents to the PenPoint computer from a disk:
- to move documents stored on a disk back to the PenPoint computer so you can work on them again
- to work on a document created by someone else
- to restore an earlier version of a document
- to work on documents created on a PC.

You can transfer documents between the PenPoint computer and any connected volume (disk), such as the GO floppy disk. If you're using a new floppy disk, PenPoint will prompt you to format it when you insert the disk in the disk drive. If you have PenPoint TOPS, you can transfer documents to and from a PC disk or network disk. (Chapter 13, Setting up Your Computer explains how to connect the PenPoint computer to a GO floppy disk or to a PC; Connecting to a Personal Computer explains how to use TOPS with a PenPoint computer.)

You transfer documents by copying or moving them from the Notebook Table of Contents to the Disk Manager which is a table of contents for the documents on a disk.

The PenPoint™ operating system stores documents in its own format, but if you have compatible applications you can continue working on them on a PC by changing the file format on the export sheet when you copy it to disk. Conversely, you can work on documents created on a PC by choosing a PenPoint application on the import sheet when you copy it to the Notebook.
To copy a document to a floppy disk:

1. Connect the PenPoint computer to a disk drive. (If the disk you inserted displays the automatic installation dialog, tap \( \text{Close} \) to dismiss it.)

2. Tap \( \text{Disks} \) icon on the Bookshelf.

The Disk Manager floats on the page.

3. Tap \( \text{the icon for the connected disk} \) to see what’s on the disk.

4. From the Notebook Table of Contents, tap press \( \text{the document} \) or section you want to copy, and then drag it where you want it to go on the Disk Manager table of contents.

5. Tap \( \text{the close corner when you’re done.} \)
Using The Disk Manager

Whenever the PenPoint computer is connected to a disk, you can display a Disk Manager to find out what’s on that disk.

You’ll usually open the Disk Manager from the Bookshelf by tapping the Disks icon. (The Disk Manager is also in Tools.)

You’ll see an icon for each type of connected disk drive at the top of the Disk Manager. For example, if you have both a floppy and hard disk drive connected to the PenPoint computer, you’ll see the icon and the name of each drive.
1 Connect the PenPoint computer to a disk drive. (If a disk you insert in a floppy drive displays the automatic installation dialog, tap \textbf{Close} to dismiss it.)

2 Tap \textbf{the Disks icon on the Bookshelf} to float the Disk Manager.

3 Tap \textbf{the disk icon} to open the disk and see what’s on it; tap it again to close it.

- Flick up \textbf{on the page} to scroll the Disk Manager’s table of contents.

Directories organize information on a disk. They may contain PenPoint documents and sections as well as PC files and subdirectories.

- Document created on a PenPoint computer.
- Document created on a PC.
- Document created on a PenPoint computer but exported in a PC file format.

4 To see the contents of another floppy disk, draw a cross out \textbf{X} over the disk icon to eject the disk and insert another floppy disk.

5 Tap \textbf{the close corner} when you’re done.

If you connect to another disk drive while working with the Disk Manager or reconnect to a volume on a network and you don’t see the volume’s icon, choose \textbf{Refresh} from the View menu to display it.
When you copy or move a PenPoint section to a disk, PenPoint treats it as a unit, not as separate documents. When it’s on a disk, you can’t expand the section or move the contents around within it as you can on the Notebook Table of Contents. To see the documents contained in the section, move it back to the Notebook.

You can eject a disk by drawing a cross out X on the disk icon (or by choosing Eject & Forget). When you do so, PenPoint closes the icon and ejects the disk. If you want to copy documents from that floppy to another, draw the letter E on the icon (or choose Eject & Remember). PenPoint ejects the disk but remembers what’s on it so you can copy the contents to another disk. To close the disk icon without copying anything at all, tap it.

Here’s a shortcut for ejecting a disk: draw the letter E on the Disks icon on the Bookshelf. You can do this even if the Disk Manager is closed.
Finding Out More About What's on a Disk

The Disk Manager menus are similar to the Table of Contents menus. Commands on the View, Sort, and Show menus give you more information about a document, such as its size, the type of application used to create it, and the date on which you last changed it. You can use these commands, for example, to see which is the most recent version of a document you’ve stored on a disk.

Use the Show menu to display the Size or Date on which a document or section was last modified.

Use the Sort menu to sort the contents by Name, Date, Size, or Type from the Sort menu.

Expand or Collapse the contents of a directory from the View menu.

To find out the total space on a disk and the amount of space remaining, draw a check \( \checkmark \) on the disk icon.

If the Volume sheet isn’t displayed, tap the arrow on the title line to see the list of option sheets and tap Volume.

The Volume sheet also tells you whether the disk is Read Only; that is whether you can copy or move information onto the disk (if you can, Read Only will be No).

The position of the tab on the upper right side of the disk determines whether a disk is read only. If the tab blocks the hole, the disk is read only. Push it down to copy or move information to the disk.

Just as you can choose an icon style for Bookshelf icons, you can choose an icon style for disk icons from the Icon option sheet. (Draw a check \( \checkmark \) on the icon. If the Icon option sheet isn’t displayed, tap the arrow on the title line to see the list of option sheets and tap Icon. Tap to choose an icon style.)

You can also choose About from the Volume menu to see the option sheets.
Creating New Directories

You can organize the contents of a disk by creating a directory and then moving PenPoint sections, and documents, as well as PC files, into it.

1. Tap the Disks icon on the Bookshelf to float the Disk Manager. Tap the icon for the connected disk to see what’s on the disk.

2. Choose Create Directory from the Edit menu.

3. Double tap to open the directory.

4. Move a document into the directory by pressing on the document title and then dragging it so that the pen point is aligned with the Empty placeholder document.

The Disk Manager is preset to list titles alphabetically, so the new directory is placed under the d’s. You can rename it in the usual way.
Renaming a Disk and its Documents

You can rename the label for the entire disk by drawing a circle ◎ on the icon and changing it in the edit pad or by choosing About from the Volume menu and writing in a new name of up to 11 characters. To rename a document or directory, draw a ◎ on the title and change it in the edit pad or choose the Rename command from the Edit menu.

To review the procedures for renaming a document see chapter 5, Creating and Using Documents and “Editing Fields” in chapter 7 (Editing and Formatting Text).

Deleting Documents from the Disk Manager

To delete a document from a disk, draw a cross out X through the title, or select the title and choose Delete from the Edit menu. You’ll see a confirmation message.

Creating Disk Manager Stationery

If you often connect the PenPoint computer to several disks, for example to a PC on a network, you may find it more convenient to create Disk Manager stationery that’s preset for the disk you use most often.

You create Disk Manager stationery by copying the Disk Manager into the stationery notebook. If you want, you can add it to the Create menu by tapping its Menu box in the stationery notebook. You can then create a new document in the usual way by drawing a caret ^ in the table of contents where you want the stationery to go, and selecting a piece of Disk Manager stationery from the Create menu.

You work with the Disk Manager document as you would any document. That is, you can float it, move it to a different location in the Notebook, and attach a tab to it.
Transferring Documents and Sections to and from the Notebook

You transfer documents and sections from the PenPoint computer to a PenPoint or PC disk by copying or moving them from the Notebook to the disk’s table of contents as shown on the Disk Manager.

Transfer documents to disk to make backup copies, free up more room on the PenPoint computer, and keep the notebook up-to-date. If you want to continue working on a document on another computer, you need to export it in the appropriate file format. See “Converting a PenPoint Document to a PC Format” in this chapter. You can copy all of the contents of a PC directory to the PenPoint computer, but not the directory itself.

To copy a document or section to a disk:

1. Connect the PenPoint computer to a disk drive.

2. Tap the Disks icon on the Bookshelf to float the Disk Manager.

3. Tap the icon for the connected disk to see what’s on it.

4. From the Notebook Table of Contents, tap press the title of the document or section you want to copy, and then drag it where you want it to go on the Disk Manager table of contents.

5. Tap the close corner when you’re done.
If you already have a copy of the document on a disk, PenPoint gives it the same name and adds a number, for example Document 1. To delete the previous version, draw a cross out $\times$ on its title.

Most of the time you'll want to see what's on a disk before you copy or move a document to it, so you can see where to put the document. However, you can transfer a document to a disk even when the icon is closed. When you open the icon later, you'll see the document listed alphabetically with the other contents on disk.

To copy a document or section to the Notebook, reverse the procedure for copying to a disk. If you're copying a file from another computer, Penpoint displays the Import sheet. You choose an application from it to use the document on the PenPoint computer.
Transferring Documents Between Disks

You can use the Disk Manager to transfer documents between disks. You might do this to consolidate all the client documents stored on various floppy disks to one disk, or to make a copy of a document you keep on your hard disk.

To copy a document from a hard disk to a floppy disk:

1. Connect the PenPoint computer to both floppy and hard disk drives, and insert a floppy disk.

2. Tap the Disks icon on the Bookshelf to open the Disk Manager.

3. Tap the icon for each connected disk.

4. Tap press then drag the document to its destination.
Sometimes the document you want to transfer to a floppy disk is stored on another floppy disk. Since you’re using a single disk drive, you’ll need to eject the first disk and insert the second to transfer the information.

To transfer a document from one floppy to another:

1. Connect the PenPoint computer to a disk drive and tap the Disks icon to open the Disk Manager.
2. Tap the floppy disk icon to open it.
3. Choose Eject & Remember from the Volume menu (or draw the letter E on the icon to eject the disk).
4. Insert a second floppy disk.
5. Tap the icon to see its contents.
6. Copy or move the document from one disk to the other in the usual way. (PenPoint prompts you to reinsert the disk. Continue swapping disks until PenPoint completes copying the data.)

To close an icon, tap it.
The Volume menu has two commands that let you copy the contents of one disk to another disk.

Choose the **Duplicate** command to make an exact copy of a floppy disk onto another floppy. If you duplicate a disk onto an unformatted disk, PenPoint automatically formats the disk.

Choose the **Copy Contents** command to copy the entire contents of a disk to a location on another disk. When you do this, PenPoint creates a directory on the second or target disk with the same name as the disk you're copying and places the contents in it. You might choose this command, for example, if you wanted to back up the contents of your sales reports disk to your hard disk.

To duplicate a floppy disk:

1. Connect the PenPoint computer to a disk drive.
2. Tap the Disks icon to float the Disk Manager.
3. Tap the floppy disk icon to open it.
4. Choose **Duplicate** from the Volume menu.

PenPoint begins to duplicate the disk and shows you the amount it's copied.

Insert a second floppy disk when PenPoint prompts you for the destination disk. (If the disk is unformatted PenPoint formats it.)

Insert the first floppy disk when PenPoint prompts you for the source disk.

5. Continue swapping disks until the percent completed is 100% and the message is no longer on the screen.
To copy the entire contents of a floppy disk to a directory on a hard disk:

1. Connect the PenPoint computer to both a floppy and a hard disk drive, and insert a floppy disk.

2. Tap the Disks icon to float the Disk Manager. Tap the hard disk icon to open it.

3. Tap press the floppy disk icon until you see the double marquee.

4. Drag the disk icon to its destination on the hard disk.

(If you're dragging it into a directory, lift the pen when the disk icon is aligned with other documents within the directory.)

You can also copy the contents of a disk by choosing Copy Contents from the Volume menu, and then dragging the disk icon to another volume or directory on the Disk Manager.
PenPoint stores your documents in the PenPoint format. To work with a PenPoint document on a different computer, you need to convert the document from a PenPoint file format to one that is compatible with the application that you'll be using. Consult the manual that comes with your PC application if you're not sure what file formats the PC application accepts.

You copy a document to disk with a different file format by exporting it.

To export a document:

1. Connect the PenPoint computer to a disk drive.
2. Tap the Disks icon to float the Disk Manager and tap to open the icon for the connected disk.
3. Select a document from the Table of Contents.
4. From the Table of Contents, choose Export from the Edit menu.

You'll see the title of the document you've selected surrounded by the double marquee which tells you it's ready to be copied.
5 Drag the document to its destination.

If you’re dragging it into a directory, lift the pen when the marquee is aligned with other documents in the directory.

When you lift the pen, PenPoint displays the Export dialog sheet.

6 To rename the document, tap the title to change it in the edit pad.
   ▲ Or, draw a X through the title and write in a new name.

7 Tap to select a file format.

8 Tap Export to export the document

PenPoint transfers the document to disk, lists it alphabetically, and closes the Export sheet.
   ▲ Tap Cancel to close the Export sheet without exporting the document.

Refer to “Editing Text in Fields” in chapter 7 (Editing and Formatting Text) to learn more about editing document names in fields.
In your Notebook you can have a document title that includes several words with spaces between them. On many PCs, however, the convention for naming documents requires titles of 8 characters followed by a period and 3-letter extension to identify the file format, for example NewProd.RTF.

If you don’t shorten a long title and give it a file format extension, the PC may truncate it when you export it and the application you’re using may not recognize it as a file.

For example, if you export a document called New Bottle Design in ASCII format, when you look at the document on your PC directory, you’ll see a document entitled New_Bott with no file format extension. To avoid this, rename a document with a meaningful name followed by an appropriate 3-letter extension for the file format.
Converting a PC Document to a PenPoint Document

Sometimes you’ll want to work on documents originally created on the PC. For example, you might wish to add details to a sales plan prepared by a colleague. Or, you might decide to work further on a document you’d already exported to the PC.

You transfer documents back to your Notebook by copying or moving them from a disk to the Notebook. If you’re copying a PC file or a document you previously exported, PenPoint automatically displays the Import sheet. You can then choose an application to use with it.

1. Connect the PenPoint computer to a disk drive.

2. Tap the Disks icon to display the Disk Manager and tap to open the icon for the connected disk.

3. Tap press the document you wish to import, and then drag it to a location on the Table of Contents.

PenPoint displays the Import sheet.
4 To change the document name, tap \( \triangleright \) the title to change it in the edit pad.
   \- Or, draw a \( \times \) through the title and write in a new name.

5 Tap \( \triangleright \) to select an application.

6 Tap \( \triangleright \) Import to import the document.

PenPoint copies the document to the Notebook and closes the Import sheet.
   \- Tap \( \triangleright \) Cancel to close the Import sheet without importing the document.

If you want to copy a file to the Notebook without converting it to a PenPoint format, choose Placeholder from the Import to options. You might do this, for example, to use the Notebook to transfer a file from one PC to another. If you turn to the document in the Notebook, PenPoint asks you which application to use with it.
Before you can use a disk in the GO Floppy disk drive, you need to format it. The first time you put an unformatted disk into the GO floppy drive you'll see a message asking you to choose a disk size for formatting.

1. Connect the PenPoint computer to a floppy disk drive and insert an unformatted disk into the drive.

   You'll see a message informing you that the disk needs to be formatted.

2. Choose a disk size.

   (If you don't know what the size is, eject the disk and check the size that's written on the metal shutter).

   If you've mistakenly inserted a disk with information on it you want to keep, tap \cancel to eject the disk.

3. Write in a name (up to 11 characters) for the disk (Or, tap \edit the field to display an edit pad and write it in the pad.)

4. Tap \continue.

   You'll see a message that shows you that the format is in progress.

   When PenPoint finishes formatting the disk, the message disappears and if you have the Disk Manager open, the disk icon appears there.

You can also format a disk from the Disk Manager by choosing Format from the Volume menu. You might do this to format a disk to a lower density or to quickly erase its contents.

If you get a message telling you that the disk is a write protected volume, make sure you don't need the information on it. Then push up the tab covering the hole on the upper right side of the disk.
If you have to restart the computer while you’re working with a document, you’ll lose your most recent changes unless you have saved the document. PenPoint automatically saves your current changes each time you turn to another page of the Notebook.

If you have something selected in a document, PenPoint doesn’t save your changes even when you turn the page. You can make sure the changes are saved by selecting something on the page you turn to, or by undoing the selection in the document you’re turning away from.

To save your changes periodically without turning the page, choose **Checkpoint** from the Document menu.

Sometimes you’ll make changes to a document that you don’t want to keep. You can go back to an earlier version of the document by choosing **Revert** from the Document menu. When you do this, PenPoint restores the document to what it was the last time you saved it.

To save your current changes while working on a document, choose **Checkpoint** from the Document menu.

To restore an earlier version, choose **Revert** from the Document menu.
As with any computer, it's advisable to back up your Notebook periodically by copying it to a disk. Then if you have an error that causes you to lose data, you can restore your Notebook to its original configuration.

To find out how much space the Notebook will occupy on the disk, choose About from the Table of Contents' Document menu and check the Filed Size.

To back up the Notebook:

1. Tap the Disks icon to open the Disk Manager.
2. Tap to open the icon for the disk to which you want to copy the Notebook.
3. Drag the bottom handle of the page up to see the Notebook icon.
4. Tap press the Notebook icon until you see the double marquee, which tells you it's ready to be copied.
5. Drag the Notebook icon to the disk.

Once you've copied a notebook to a disk, PenPoint treats it as if it were a section. You can't open it unless you move or copy it back to the Notebook.

If you have turned on Zooming Documents on the Safeguards Preferences sheet, you can close the Notebook by tapping the close corner and then drag the Notebook icon to a location on the Disk Manager.
Restoring Your Notebook

When you have an error that causes you to boot the computer, PenPoint installs the default Notebook. If you've backed up your Notebook, you can copy it to the computer and delete the default Notebook. (Booting the computer is covered in chapter 12, Learning More About PenPoint.)

To restore your Notebook after booting the computer:

1. Connect the PenPoint computer to a disk drive.

2. Tap \( \rightarrow \) the default Notebook's close corner.
   - If you don't see a close corner, tap Allowed for the Zooming Documents category on the Safeguards Preferences sheet.

3. Tap \( \rightarrow \) Disks to open the Disk Manager and tap \( \rightarrow \) the icon for the connected disk to open it.

4. Tap press \( \rightarrow \) the title of the Notebook you want to copy and drag it to the Bookshelf.
5 Tap ‚ the Notebook icon to open it. Draw a flick up ‚ on the title line to zoom the Notebook so that it fills the screen.

6 If you won’t be using it, you can delete the default Notebook by drawing a cross out X over it.

If you’re sharing your computer you might have several notebooks in it at the same time—one for each person. To learn how to create multiple notebooks, read “Accommodating Multiple Users” in chapter 12 (Learning More About PenPoint).
CHAPTER 12

Learning More About PenPoint
Managing Memory

As you install applications and services in your Notebook and create more documents, you may reach a point where you are using most of the memory in your computer. Before you run out of memory, you’ll see a message advising you to save your current work and make more room in the Notebook. To work with the memory in your computer most effectively:

- Delete documents you’re no longer using.
- Deactivate applications, services, and handwriting profiles you’re not currently using and deactivate or delete items on the Bookshelf.

Finding Out How Much Memory Something Uses

The items in the Notebook use different amounts of memory. Before deleting or deactivating something, you might check to see how much room it occupies.

To find out which items you’ve installed in the Notebook take up the most room, check the size in the Installer. To do so:

- Tap the Installer icon to open the Installer. You’ll see a column for the size on each sheet of the Installer.
- To see a different sheet, tap the arrow on the title line and tap the name of the sheet you want to see.

To find out the size (in kilobytes) of a document you have stored on a disk choose Size from the Show menu. You can sort the titles by size choosing Size from the Table of Content’s Sort menu.

To see how much memory you have available in the Notebook, look at the Memory Usage Preferences sheet. To do so, tap Preferences on the Bookshelf and tap the arrow on the title line to see the list of sheets. Then tap Memory Usage. To have enough memory for standard operations, make sure you have at least 500K free.
Things You Can Safely Delete or Deactivate

The most efficient way to use the memory in your computer is to deactivate applications, handwriting profiles, and services you're not using. Deactivating them is a way of temporarily removing them; they're easy to reactivate.

When you deactivate something, the PenPoint\textsuperscript{TM} operating system deletes it from the computer but leaves a placeholder for it. Since PenPoint remembers the home volume, you can reactivate it in one step. To deactivate and reactivate something, use the Installer. (See chapter 4, Installing Programs and Devices for details.)

Periodically, you can gain more room in the computer by deleting documents or sections you're no longer using. Before doing so, you might make a backup copy on a disk so that you can work with the documents at a later time. (See chapter 11, Filing Documents for information on transferring documents to and from the computer.)

To make more room in the Notebook, you can also delete items on the Bookshelf. For example, you can delete Help, which removes both Quick Help and the Help notebook, and copies of tools, such as Disks, the Keyboard, and the Clock. There are some Bookshelf items you can't delete: the contents of Tools, the Installer, the In and Out boxes, and the Stationery notebook.

Other Ways to Use Memory Efficiently

If you've set the Access Speed to \textbf{Accelerated} on the Access document option sheet, you can turn to the document more quickly. But this option takes more memory than using the standard page turn speed. If you're low on memory, turn off this option.

Some operations fragment memory. That is, PenPoint saves the information in smaller blocks distributed over a greater area than if it were in one continuous block. Thus PenPoint may sometimes not have enough contiguous memory to perform a task. If you get an out of memory warning, save your current changes by choosing \textbf{Checkpoint} from the Document menu and restart (warm boot) the computer as explained in the next section.
When You Get an Out of Memory Message

When PenPoint displays an out of memory message, restart (warm boot) the computer. Then you can free more memory by deactivating applications and services you're not using.

To restart:

- Before restarting the computer, choose Checkpoint from the Document menu to save your current changes.
- Turn off the computer by pressing the Off button.
- To restart it, press the On button. Hold it down for a few seconds before releasing it.
- When you release the button, you'll see a message telling you that PenPoint is warm booting the computer.
- When the warm boot is completed, the message disappears and you'll see the Table of Contents.
If you're working with a document or tool and you find you can't continue working with it, the document may have frozen. You can still use other documents you created with the same application. However, you may have to take some steps to continue working with this one.

When the document freezes:

- Turn to the Table of Contents.
- Turn back to the document. You should be able to use it, but you may have lost changes you made since you last saved it. (It's a good idea to save your changes periodically by choosing Checkpoint from the Document menu or by turning the page.)
- If you turn back to the document and you still can't use it, PenPoint displays a message telling you that an error has occurred and then automatically turns to the Table of Contents.
- Restart the computer. (Press the On/Off button at the top right corner of the computer. Hold the button down for a few seconds and then release it. You'll see a message telling you that PenPoint is warm booting.)

If you're unable to use the document after restarting the computer, duplicate the document by copying it on the Table of Contents and then try using the copy. If that doesn't work, go back to a copy you've stored on a disk, or use a document recovery utility.
Booting PenPoint When PenPoint Freezes

If the screen goes blank or you find you can’t do anything in the Notebook, then PenPoint may have frozen. First try restarting the computer. If you’re still unable to use the Notebook, you’ll need to copy the PenPoint operating system from a GO floppy disk or hard disk. (This is called booting or cold booting the computer.)

To boot the computer:

1. Connect your computer to a GO floppy disk. (See chapter 13, Setting Up Your Computer to learn how to connect it).

2. Turn on the computer.

3. Put the first PenPoint disk into the floppy drive.

4. Insert the end of a straightened paper clip into the hole that contains the reset button on the back of the computer.

You’ll hear a beep and the computer will display a message showing the PenPoint copyright information.

PenPoint prompts you to insert the remaining disks.

When PenPoint has been successfully installed you’ll see the Table of Contents.

When you copy PenPoint onto your computer, you’ll see the default Notebook. To customize it, reinstall the applications and accessories you normally use, your handwriting profile and any preferences or personal dictionaries you’ve stored on a disk. You’ll also need to copy the documents and sections you were last using back to your Notebook.
Accommodating Multiple Users

When several people share the same computer, each person may want to set it up differently. You can do this by:

- Creating an individual Notebook for each user.
- Creating an individual handwriting profile, personal dictionary, and preference set as described in chapter 4, Installing Programs and Devices.

Before beginning to work, each person can copy her or his Notebook to the computer from a disk and then activate a handwriting profile, personal dictionary, and preference set.

Creating Individual Notebooks

Even when you don’t share the computer with several other people, you may find it more convenient to organize your work by creating individual notebooks for each primary topic, for example for each major client or project.

The PenPoint computer comes with a default Notebook which you can replace with another notebook. The default Notebook and any additional notebooks you create are kept on the Bookshelf.

To create a Notebook:

1. Draw a caret \( \wedge \) on the Bookshelf where you want the new notebook to go.
2. Choose Notebook from the Create menu.
3 Tap to open the notebook.

4 To close the default Notebook, tap the close corner. To remove it, move it to a disk using the Disk Manager.

(You need to choose the Document Zooming option on the Safeguards Preferences sheet before you can close the current Notebook.)

5 To zoom the new Notebook to its full size, draw a flick up I. (Draw a flick down I to unzoom it.)

- To close it, tap the close corner

You treat the new Notebook as you do other items on the Bookshelf. To:

- Open it, tap its icon.
- Move it, press the icon, then drag it. To copy it, tap press the icon, then drag it.
- Set the icon options, draw a check on the icon.
- Change the title, draw a circle on the title to get the edit pad, and change it there.

Once you’ve created a Notebook, you can keep a backup copy on a disk. Use the Disk Manager to copy it to a floppy or hard disk. See chapter 11, Filing Documents for information about the Disk Manager.
Most of the time when you navigate from one place to another in the Notebook, you use the Table of Contents, tabs, or hyperlink buttons. While working on a document, you might refer to other information by embedding a second document or tool in the cork margin.

By combining these techniques for navigation and reference, you can make your work more efficient. For example, you can turn the Table of Contents into a control panel which contains embedded tools and documents or create a customized index that contains hyperlink buttons to documents.

### Turning the Table of Contents into a Control Panel

The Table of Contents is the principal navigation tool in the Notebook, since from it you can turn to any page.

To make it easier to refer to the Table of Contents while working with other documents, you can float it and then resize and position it in a convenient location. Whenever you next float the Table of Contents, it will reappear in the same place on the screen. (To float it from anywhere in the Notebook, double tap the Contents tab.)

To turn it into a control panel, display the cork margin and embed hyperlink buttons, documents, and tools you routinely use while working on documents.
To turn the Table of Contents into a control panel:

1. Double tap the Contents tab to float the Table of Contents. (Make sure the floating preference is turned on.)

2. Resize the Table of Contents by dragging the bottom or lower right hand corner. Position it by dragging the title line.

   Each time you float the Table of Contents it will appear in the same place until you reposition or resize it.

   To make it smaller, hide the menu line by drawing an M on the title line. (To display it when you need to choose a command, draw another M on the title line.)

3. Draw a C on the title line to show the cork margin.

   In the cork margin you can copy tools you want to use, create new documents or embed existing ones, and insert hyperlink buttons to other documents.

Instead of using gestures to display or hide the cork margin and menu line, you can also choose Cork Margin and Menu Line from the Show category on the Access document option sheet.
Creating a Customized Index

You can make an index by creating a document on the Bookshelf that contains hyperlink buttons to documents or places in documents to which you want to refer.

When working with the index, you can float it on top of the current document, or resize the document and the index so that the index is tiled—arranged next to the document on the screen.

To create a tiled index:

1. Drag the bottom handle of the current document up.

2. Create a document on the Bookshelf. (Draw a caret \ on the Bookshelf and tap \ a piece of stationery.)

3. Tap \ to open the new document, and resize it so it fits beneath the current document. (Reposition the document by dragging the title line. Drag the corner handle diagonally to make it bigger.)

To create more space in the index for hyperlink buttons, hide the menu line by drawing an M on the title line. (To display it when you need to choose a command, draw another M on the title line.)
4 Select a document from the Table of Contents or turn to the document you want to place in the index and select a location in it.

5 Draw the hyperlink gesture $\circ$ in the index.

As you add buttons to the index, you can rename or rearrange them so that the index works like a menu.

You can change the reference of a hyperlink button. In this way, you leave the button on the index, but reset the place to which it takes you. To reset the button, select a new location, and then triple tap $\mathbf{p}$ the button to redefine the link and to relabel the button with the new location.
Setting Up Your Computer
This chapter contains information about connecting your GO Computer to various BaseStation modules, printers, and networks, and about caring for your computer. The diagrams show you how to make the physical connections to these devices. For information about how to use those connections once you’ve made them—how to print documents, install applications, and copy files to disk, see the appropriate chapters in this manual.
Recharging the Battery

The battery will normally provide power for your GO Computer for four to five hours. If you use the battery to run a disk drive or other external device, you reduce that time.

When the battery needs recharging, the computer sends you a message. There are two ways to recharge your computer's battery:

- The GO Travel Charger recharges a battery in eight hours.
- The GO Quick Charger charges a battery in about one and a half hours, and lets you operate the computer with external devices while charging.

You may find it useful to buy a second battery, so you can always have one charged and ready.
Using the GO Travel Charger

You can connect the GO Travel Charger directly to the computer to:

- recharge the battery in eight hours
- operate the computer while conserving its battery power.

The Travel Charger operates on current from 100-240 volts, and from 50-60 cycles, so you won’t need an adapter for the current in other countries. The Travel Charger starts charging when you plug it into the computer. If you interrupt the charging cycle by connecting a GO Floppy Drive or other device, you’ll need to disconnect the drive or device, and remove and then reinsert the Travel Charger jack to start the charge cycle again.

For this procedure you’ll need the GO Travel Charger and its detachable power cord, which come with every GO computer.

To use the Travel Charger to recharge the battery:

1. Unplug the Quick Charger or anything else that’s attached to your GO Computer. The Travel Charger only charges your battery when it’s the only thing attached to the computer.

2. Plug the small end of the Travel Charger’s cord into the Travel Charger jack on the top edge of the computer.

3. Plug the other end of the Travel Charger’s cord into a standard wall outlet.
Using the GO Quick Charger

The GO Quick Charger is an optional BaseStation module which you can use to:

- recharge the battery in one and a half hours
- power GO Computer and disk drive operations while recharging the battery
- connect to printers
- connect to a PC
- connect to a TOPS FlashCard
- connect to a disk drive
- attach a keyboard.

Like the GO Travel Charger, the Quick Charger operates on current from 100-200 volts, and from 50-60 cycles, so you shouldn’t need an adapter for the current in other countries. As with the Travel Charger, you start a charge cycle when you plug the Quick Charger into the GO Computer. However, the Quick Charger will continue to charge the computer (at a much slower rate) even if you attach other devices.

For this procedure you’ll need a GO Quick Charger and a BaseStation cable.

To recharge your GO Computer’s battery with the Quick Charger:

1. Plug the Quick Charger into a standard wall outlet.

2. Plug the BaseStation cable into the BaseStation connector on the side of the Quick Charger and into the computer. Use either end of the cable; they’re the same.
Replacing the Battery

You may need to install a fresh battery pack if you:

• use your computer for long periods of time without access to an outlet for recharging
• use the battery in your computer to run a disk drive for any length of time
• see a message on the screen telling you your battery is low.

Removing a Battery

When you turn the computer over you'll see the rectangular outline of the battery pack.

Before you remove the battery pack, choose Checkpoint from the Document menu to save your work. Or you can turn the page. (The PenPoint™ operating system records the data as long as nothing is selected on the page before you turn away from it.)

To remove the battery pack:

1. Turn the computer off. If you remove the battery while the computer is on, you may lose data.

2. Tip the computer up so that the battery pack is on top, facing you.

3. Use your thumbs to press the top edge of the battery pack (the bottom edge of the computer) down and towards you until it comes out.
Installing a Battery

With the computer turned face down, gently but firmly press the battery pack into its slot until it slips comfortably behind the retaining lip of the computer.
You can connect your GO Computer to a printer in the following ways:

- Use a GO Serial Printer Cable to connect directly to a serial printer.
- Use the GO Quick Charger and a standard serial cable to connect to a serial printer.
- Use a GO PC Cable—FlashCard to connect to a PC with a TOPS FlashCard and a connected printer. (For more information see “Connecting to a TOPS Network” later in this chapter and in Connecting to a Personal Computer.)

Consult the GO Release Notes for a list of supported printers. Your printer must be on this list, be compatible with one that is, or be supported with an appropriate printer driver by GO or an independent vendor.

Once you have a printer hooked up, you’ll need to install it so that the PenPoint operating system will recognize it. For more information, see chapter 10 (Printing, Sending and Receiving Documents).

Connecting Directly to a Serial Printer

For this procedure you’ll need a GO Serial Printer Cable. You may also need an adapter. See the list of adapters below.

To connect your computer directly to a serial printer:

1. Plug the GO Serial Printer Cable’s nine-pin (male DB9) plug into the printer’s serial connector.
   - If your printer has a female DB9 connector, you don’t need an adapter. Otherwise you do.

2. Plug the other end of the serial cable into the BaseStation Connector on your computer.
### Serial Printer Connectors And Adapters

If your printer has a female DB9 connector, you don’t need an adapter for the GO Serial Printer Cable’s male DB9 plug. If it has any other kind of connector, you need an adapter that has a DB9 connector on one end (for the GO cable) and the appropriate adapter on the other end.

<table>
<thead>
<tr>
<th>Printer’s Connector</th>
<th>Adapter Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male DB9</td>
<td>DB9 female on both ends</td>
</tr>
<tr>
<td>Female DB9</td>
<td>Adapter Needed</td>
</tr>
<tr>
<td>Male DB25</td>
<td>DB9 female on one end, DB25 female on the other</td>
</tr>
<tr>
<td>Female DB25</td>
<td>DB9 female on one end, DB25 male on the other</td>
</tr>
</tbody>
</table>
Connecting to a Serial Printer Through the GO Quick Charger

For this procedure you'll need a standard serial cable, a Quick Charger, and a BaseStation cable.

1. Plug a standard serial cable into the serial connector on the side of the Quick Charger.

2. Plug the other end of the serial cable into the serial connector of the printer.

3. Connect the Quick Charger to the computer with the BaseStation cable.

* You can also use the Quick Charger to connect to both serial and parallel printers via a TOPS network. See "Connecting to a TOPS Network" later in this chapter.
Using a GO Floppy Drive

You use the GO Floppy Drive to transfer documents and applications to and from floppy disks. You can connect the drive to the GO Computer directly or through the Quick Charger. With the disk drive you can:

- install new applications
- store documents created on the GO Computer
- free up more memory by transferring applications or documents to a floppy disk
- exchange documents with colleagues.

Use the Installer to move applications to and from floppy disks, and the Disk Manager to move documents. For more details, see chapter 11, Filing Documents and chapter 4, Installing Applications and Devices.

You can also connect to a floppy drive through a TOPS connection to a PC. For more information, see Connecting to a Personal Computer.

Connecting a GO Floppy Drive through the GO Quick Charger

For this procedure you'll need a GO Quick Charger, a GO Floppy Drive, and a BaseStation cable.

To connect to a floppy drive through the Quick Charger:

1. Slip the latch on the front of the Floppy Drive into the connector on the Quick Charger.

2. Press the backs of the floppy drive and Quick Charger together. The units click into place when they're properly connected.

3. Plug the BaseStation cable into the computer's BaseStation connector and the BaseStation connector on the Quick Charger.

To separate the units, press the release button on top of the disk drive, then unhook the backs of the units and the latch at the front of the disk drive.
Connecting Directly to a Disk Drive

You can connect the GO Floppy Drive directly to the GO Computer, but it will run down your battery rapidly, so it's advisable only for short periods. Remember that if you connect the floppy drive to the computer while you're charging it, you'll have to disconnect the drive, remove and then re-connect the Travel Charger or Quick Charger to start the charge cycle again.

For this procedure you'll need a GO Floppy Drive and a BaseStation Cable.

To make the direct connection:

1. Push one end of the BaseStation Cable into the computer's BaseStation connector. Both ends of the cable are the same.

2. Push the other end of the cable into the floppy drive's BaseStation connector.

Caution: Make sure the disk drive is on a stable surface. If it tips over while it's running, it might damage the floppy disk.
If you’re unfamiliar with floppy disks, take a moment to examine one. The metal shutter goes into the drive first. The disk’s label area creates an obvious front or top side. The GO Floppy Drive stands vertically, so make sure that the large label area is facing left when you slip the floppy disk into the disk drive slot.

The GO Floppy Drive uses 3.5 inch disks that hold 1.44 megabytes of information. These are compatible with the 3.5 inch disk drives of IBM-compatible computers. This means that IBM-compatible computers (using DOS) can read disks formatted by a GO computer or any PenPoint computer.

- A GO Computer or any computer using the PenPoint operating system can read 3.5 inch DOS-formatted floppy disks from PCs and perform basic file functions on them, such as copy, rename and transfer.
- You can work with data on compatible disks whenever the applications are compatible.

If the GO Computer doesn’t recognize a disk, you’ll see a message asking you whether to format or eject it. If the disk has some data on it that you want to keep, choose Eject, because formatting will erase everything.

For more about formatting and using disks, see chapter 11, Filing Documents and chapter 4, Installing Applications and Devices.

For this procedure you’ll need a GO Floppy Drive connected to a GO Computer, either directly or through a Quick Charger, and a 3.5 inch floppy disk. In either case, you use the BaseStation cable to connect to the GO Computer.

To use floppy disks in a GO Floppy Drive:

1. Insert the floppy disk into the drive, metal shutter first, with the label facing the release button.

2. Push the disk into the drive until you hear it click into place.

The disk should go easily into the drive. If it doesn’t, you’ve probably tried to insert it upside down.
Manually Ejecting a Disk from the GO Floppy Drive

You normally eject floppy disks from the GO Floppy Drive with the Disk Manager's Eject command, or by drawing an E over the disk icon. If that fails for some reason, you can eject a floppy disk manually.

Use a straightened paper clip to push the manual eject button (inside the hole) until the disk pops out.
You can connect to a SCSI hard drive through the GO Floppy Drive. You can also connect to a hard drive through a TOPS connection to a PC. For more information, see Connecting to a Personal Computer.

For this procedure you’ll need a GO Floppy Drive and a SCSI-II to SCSI-I connector cable.

To connect a SCSI hard drive to your GO Computer:

1. Use the SCSI-II to SCSI-I cable to connect the hard drive to the SCSI connector on the back of the GO Floppy Drive.

2. Connect the floppy drive to the computer with the BaseStation cable.

With most types of SCSI drives (generally older ones) you may need a small-to-large (SCSI-I to SCSI-II) adapter.
Connecting to a PC

You can connect your GO Computer to a PC equipped with a TOPS FlashCard to:

- exchange documents (files) with colleagues
- rename, move, copy, and delete documents
- use the PC’s disk drives to store and back up PenPoint documents
- work with the contents of documents, when the PenPoint and PC applications are compatible
- use the PC as a gateway to a network.

You can use a GO PC Cable—FlashCard to connect the computer to a TOPS FlashCard installed on a PC. You can also connect a Quick Charger to a FlashCard by using standard AppleTalk connectors. For more information about using TOPS to transfer files to a PC, or to use that PC as a gateway to a network, see Connecting to a Personal Computer.
Connecting Directly to a TOPS FlashCard

You should mount the TOPS FlashCard in a slot on your PC and connect a TOPS TeleConnector to the DB9 connector on the FlashCard, and install TOPS network software on the PC before proceeding. For information, see your TOPS manual and *Connecting to a Personal Computer*.

For this procedure you'll need TOPS software, a TOPS FlashCard for the PC, two TOPS TeleConnectors (one with a MiniDin8 connection and one with a DB9 connection, both supplied with the FlashCard) a length of phone line, and a GO PC Cable—FlashCard. You may also need the terminator resistor that comes with the DB9 TeleConnector.

To connect your GO Computer to a TOPS FlashCard:

1. Plug the GO PC cable's BaseStation connector into the top end of the GO Computer.

2. The PC—FlashCard cable ends in a MiniDin8 connector. Attach that to the appropriate TeleConnector.

3. Plug the ends of a telephone line into the MiniDin8 TeleConnector at one end, and the DB9 TeleConnector at the other.

4. Then plug the DB9 TeleConnector into the FlashCard on the PC.

A This TeleConnector has two plugs. If you’re not attaching another device, you’ll need to insert the terminating resistor supplied with the TeleConnector.
Connecting to a TOPS FlashCard through the GO Quick Charger

You should mount the TOPS FlashCard in a slot on your PC and install TOPS network software on the PC before proceeding. See your TOPS manual and Connecting to a Personal Computer for details.

For this procedure you'll need TOPS software and a TOPS FlashCard for the PC, a GO Quick Charger and BaseStation cable, a length of phone line, and two TOPS TeleConnectors. You may also need the terminator resistor that comes with the DB9 TeleConnector.

To connect your GO Computer to the TOPS FlashCard through a Quick Charger:

1. Plug the BaseStation cable into the top end of the GO Computer and the Quick Charger's BaseStation connector.
2. Plug the round end (MiniDin8) of the TeleConnector into the connector on the end of the Quick Charger.
3. Plug the ends of a telephone line into the MiniDin8 TeleConnector at one end, and the DB9 TeleConnector at the other.
4. Then plug the DB9 TeleConnector into the FlashCard on the PC.

* This TeleConnector has two plugs. If you're not attaching another device, you'll need to insert the terminating resistor supplied with the TeleConnector.
Using Option Cartridges

With option cartridges you can add capabilities to your PenPoint computer, such as a modem used for E-mail or fax.

For this procedure you'll need: an option cartridge, such as the GO Fax/Data Modem.

To install an option cartridge:

1. Turn off the GO Computer.
2. Slide the cartridge into the slot until you hear a click.

To remove a cartridge, squeeze the edges together to release it, then slide it out.
With a GO Quick Charger, you can connect an IBM PS/2 keyboard to your computer.

1. Plug the PS/2 keyboard cable into the PS/2 connector on the side of the Quick Charger.

2. Attach the Quick Charger to the GO Computer with the BaseStation cable.

3. Plug the Quick Charger into a wall outlet.
The GO Computer has been designed and tested to high standards; it’s built to travel. You can operate it while you’re carrying it around. You can turn it upside down, store it on its side, pack it in a suitcase—treat it like a notebook.

High humidity shouldn’t be a problem, but the computer is not hermetically sealed and shouldn’t be used outside in the rain, or if you see droplets inside the screen. The computer will operate over a wide range of temperatures (0-45 degrees C.; 32-113 degrees F.) and you can transport and store it in sub-zero conditions. However, it’s a good idea to let the computer reach room temperature before you turn it on.

Of course, it’s best to avoid testing the computer with sharp shocks, severe static electricity, or spilled liquids. The screen, in particular, has been constructed from very thin glass.

A GO Leather Cover is available to protect the screen from being cracked or punctured. Watch out for sharp-cornered objects when you’re packing the computer. Use the GO Carrying Case that comes with every computer for additional protection. When you need to clean the screen, use the spray solution we’ve provided. Avoid soap and water.

Store the GO pen in its compartment in the top end of the computer to avoid losing it. Regular pens won’t work with the GO Computer, so you might want to buy a spare to keep in a safe place.
Hardware Appendix
USING PENPOINT

TOP EDGE VIEW
- Option slot
- BaseStation connector
- Screen contrast
- Pen storage slot (cover shown in closed position)

FRONT VIEW
- On/Off button
- Pen-sensitive screen
- The GO pen

FACE-DOWN VIEW (battery pack removed)
- Battery pack retaining lip
- Battery power contacts
- Battery pack (Contact points and insertion direction arrows located on underside)
The GO Floppy Drive

**FRONT VIEW**
- Release button
- BaseStation Connector
to Quick Charger or GO Computer
- Latch for coupling to Quick Charger

**REAR VIEW**
- SCSI II - SCSI I connector (to external hard drive)
- Manual eject button (inside hole)
- Floppy disk insertion slot
- LED disk activity indicator

**SCSI II - SCSI I** connector (to external hard drive)
The GO Quick Charger

FRONT/RIGHT-SIDE VIEW

- PS/2 keyboard plug
- Serial printer connector
- BaseStation cable connector

REAR/LEFT-SIDE VIEW

- Coupling latch for GO Floppy Drive
- RS422 AppleTalk connector (serial/network port)
- Connector to GO Floppy Drive
- AC power connector

BaseStation cable
Power cord to wall socket
The GO Travel Charger

Power cord to Travel Charger jack on GO Computer

AC power connector

AC power cord to wall outlet
Glossary
Access Speed  An option on the Access document option sheet that shortens the time it takes to turn to a document. This option uses more memory than the normal page turn speed.

Alignment  An option on the Paragraph text option sheet that changes the placement of text within the margins of the page. Use this option, for example, to center a title or align text along the right margin rather than the left margin.

Application  A software program you install on your PenPoint computer. Applications add new capabilities to your computer. For example, if you add a spreadsheet application, you can work with spreadsheets on the computer. The MiniText application comes with the GO Computer.

Apply  A button on option sheets and some items of the Bookshelf. Tap to tell the PenPoint™ operating system to carry out the options you’ve chosen. Before turning to another option sheet, be sure to tap Apply on the current sheet if you want PenPoint to apply your choices.

Bookshelf  An area at the bottom of the screen that contains tools and auxiliary notebooks to use while working with documents. Each item on the Bookshelf is represented by an icon—a small picture.

Booting  A procedure to restart PenPoint if an error prevents you from continuing to use the computer.

Borders & Controls  An option on the Access document option sheet that tells PenPoint whether to display the border (the outline surrounding the document), the title and menu line, and the scroll margins for an embedded document or tool.

Boxed pad  A writing pad divided into character boxes. In boxed pads, you write a single character in each box and then translate the text in the boxes before transferring it to the page.

Busy clock  An animated clock symbol that appears when PenPoint is carrying out a command that takes any length of time.

Cancel  A button on a dialog sheet or message that closes the sheet or message without changing anything.

Character box  A box in an edit pad or writing pad into which you write one character (letter, number, or punctuation mark).

Checklist  A list of choices on a menu, option sheet, or dialog sheet. A single line along the left edge of a checklist indicates that you can choose one option from it; a double line indicates you can choose one or more options.

Checkpoint  A command on the Document menu which you choose to save your current changes to a document.

Close corner  A gray triangle in the upper-left corner of a floating document, Bookshelf item, or Notebook. Tap the close corner to close something. (The Notebook has a close corner when you’ve chosen the zooming option).

Collapse  A command on the View menu that closes a section in a table of contents so the titles in it are not displayed.

Command  A choice on a menu. Commands tell the PenPoint operating system what to do next.

Cork margin  An area at the bottom of all documents where you can put aside hyperlink buttons, new documents, embedded documents, or tools. The cork margin may be hidden. Draw a C in the title line to show it.

Create menu  A list of the stationery you can use to create new documents. You add or remove stationery from the Create menu with the Stationery notebook, which holds all the stationery in the computer.

Customized stationery  A stationery document that you have modified and added to the Stationery notebook. You might customize stationery to add text such as a company address to a piece of stationery or to change the standard text and document options.

Customization set  A set of practice sentences in the Handwriting Customization tool that you copy to teach PenPoint how you write.

Deactivate  An Installer command that deletes something from the Notebook but leaves a placeholder for it so that you can easily reactivate it later.

Deselect  The action you take to make a selection go away, usually by tapping it. For example, on the Table of Contents you tap to select a document title and tap it again to deselect it.

Dialog sheet  A form that the PenPoint operating system displays when you choose commands followed by an ellipsis (...). You use the dialog sheet to choose options and enter information that’s needed before PenPoint can carry out a command.
**Dictionary**  A personal dictionary to which you can add words, such as company names and acronyms.

**Directory**  A container for organizing documents on a disk. You can place PenPoint documents and sections as well as PC files and subdirectories in a directory.

**Disk Manager**  An auxiliary notebook on the Bookshelf that shows you what's contained on a floppy disk, hard disk, or network to which you've connected the PenPoint computer.

**Document**  A piece of stationery on which you enter information. Each time you choose a piece of stationery from the Create menu or Stationery notebook, you create a new document that occupies one page of the Notebook.

**Document option sheets**  Option sheets on which you note information about a document and set options for how PenPoint displays the document on the page. Document option sheets also provide information about the application.

**Drag**  The action of moving the pen across the screen without lifting it.

**Edit pad**  A boxed pad that contains text you want to change. You open an edit pad by drawing a circle over the text.

**Embedded document**  A document inserted within another document, such as a spreadsheet table inserted in a text document. You can hide the borders of the embedded portion so that the printed result looks like one document.

**Embedded pad**  A large writing pad that you get by drawing a caret tap. The embedded pad begins where you draw the gesture and the text that's already in the document flows around it.

**Enable**  An option on the Page Setup dialog sheet, Print dialog sheet, and Printers option sheet in Tools that tells PenPoint that a printer is connected to the computer. Enabling a printer in one location automatically activates it in the other places.

**Expand**  A command on the View menu that opens a section in a table of contents so the titles in it are displayed.

**Export**  A command on the Table of Contents' Edit menu that lets you copy a document to a disk and simultaneously convert the file format to one you can use on another computer.

**Field**  The text area on forms, option and dialog sheets, and lists. You can write text directly in a field or tap the field to open an edit pad. Fields often have specific functions and labels, such as Name field, Address field, and Telephone field.

**File Format**  The way an application stores information. A file format is usually indicated by a three letter extension at the end of a file name, for example, .TXT indicates that a document uses an ASCII text file format.

**First line offset**  The amount of space by which you indent the first line of a paragraph.

**Float**  To place a document, option sheet, dialog sheet, or Bookshelf item on top of the current page. Option sheets, dialog sheets, and Bookshelf items automatically float when you open them. You float documents by first choosing the document floating option on the Safeguards Preferences sheet and then double tapping the document's page number, icon, or tab. Float documents when you want to use two documents at the same time.

**Floppy disk**  A 3.5-inch disk that you format to use on the PenPoint computer.

**Font**  A text typeface that's used to display a document on the screen and to print it. You choose fonts for documents from the Text option sheets. Choose an on-screen PenPoint font and field text font from the Fonts & Layout Preferences sheet.

**Footer**  The text that runs along the bottom of each page. You can see the footer only when you print the document.

**Format (disk)**  To erase a disk and prepare it so PenPoint can record information on it.

**Format (text)**  To style text and position it on the page, for example, by selecting font and character styles and adjusting margins and line spacing. You format text with the Text option sheets.

**Gestures**  A symbol or letter you make on the computer screen with the special GO Pen. Gestures are a kind of shorthand that bypass or supplement the menu commands. Individual gestures are defined, with examples, in chapter 3, Drawing Gestures.

**GO Pen**  The special pen you use to write on the GO Computer's screen.

**Handwriting customization**  A sheet located in Tools to teach PenPoint how you make your letters.

**Handwriting profile**  The information that tells PenPoint how you write your letters. When you use Handwriting Customization, you modify the standard handwriting profile to create a personalized one which records the way you form letters.

**Header**  The text that runs along the top of each page. You can see the header only when you print the document.
**Home path** The location on a disk where the PenPoint operating system expects to find a file. PenPoint creates a home path when you first install an application or utility on the computer.

**Home volume** The disk from which you installed applications or utilities on the PenPoint computer. PenPoint refers to the home volume when you save or update something, or when you deactivate and then reactivate it.

**Hyperlink button** A marker you attach to a document so that you can instantly jump to it from elsewhere in the same document or different document.

**Icon** A symbol—usually a small picture—that represents a document, an item on the Bookshelf, or an embedded document.

**Import** To copy a PC document to the PenPoint computer. When you copy a PC document, PenPoint automatically displays an import sheet that lists the applications you can use with the document.

**In place** An option on the Access Document option sheet for displaying an embedded document. When you choose In Place PenPoint displays the document where you embedded it instead of floating it on top of the page.

**Insertion point** The place at which text is added to the page. For example, to use the software keyboard to add words to a document, you press ~ in the document where you want the new words to go. Doing so sets an insertion point that looks like a vertical line.

**Installer** An auxiliary notebook on the Bookshelf that you use to add, remove, deactivate, and reactivate such items as applications, services, fonts, handwriting profiles, dictionaries, and preference sets.

**Keyboard** A Notebook accessory that displays a software keyboard on the screen. You can tap on a key to place a character in text. You can also use an IBM PS/2 keyboard with the GO Computer.

**Label** The text that identifies icons, tabs, hyperlink buttons, and categories of choices on option and dialog sheets.

**Magnified text** A command on the View text options sheet to increase the size of text on the screen without increasing the font size used for printing.

**Menu** A list of commands located on the menu line. You choose a command by tapping ~ it. Most menu commands have equivalent gestures.

**Menu line** The area at the top of the page that contains commands you choose to tell PenPoint what to do next.

**Notebook** The structure that holds the documents you create. The first page of the Notebook is a Table of Contents. Each succeeding page contains a different document.

**Notebook tab** An identifying label that you attach to any page in the Notebook for easy access. Tabs are arranged along the right side of the screen. You can turn directly to a page by tapping ~ its tab.

**Option sheet** A PenPoint form that you use to set attributes for a document or for a selection in the document. For example, you can choose a font style for the text in a document from the Text option sheets.

**Page turn arrows** Symbols on either side of the page number in the top-right corner of the page. Tap ~ one of these two arrows to turn one page forward or backward.

**Pop-up pad** A small writing pad that you get by drawing a caret ~. The pop-up pad floats above the text.

**Pop-up list** Choices on an option sheet that are hidden until you display them by tapping ~ the current choice.

**Preferences** A set of option sheets located on the Bookshelf that you use to customize the PenPoint operating system. For example, you can choose a different writing pad style from the Handwriting Preference sheet.

**Primary input** An option on the Pen Preference sheet that sets the way you’ll usually enter text. The choices are pen and software keyboard.

**Printers** An option sheet in Tools that lets you set up a printer after you have installed its printer driver. You only set the printer options once for each printer you plan to use.

**Proof sheet** A sheet you use to correct text on the page. You display it by choosing Proof from the Edit menu or by drawing a P over the text. The Proof sheet includes a list of alternatives for a mistranslated, misspelled, or unrecognized word as well as an edit pad.

**Reactivate** An Installer command that copies a deactivated application or utility to the PenPoint computer.

**Restart** To switch the computer off and then on again when you’re working with a document or tool and you find you can’t continue working with it. To restart, you press the On/Off button once. Then press it again and hold it down until you see the message that tells you the computer is warm booting.

**Revert** A command on the Document menu that allows you to restore an earlier version of the document. Choosing this command changes the document back to what it was before you last turned the page or chose the Checkpoint command.
**Ruled-Boxed pad**  A ruled writing pad in which you translate your writing into boxes so you can edit it if necessary before you transfer the text to the page.

**Ruled pad**  A writing pad with lines. The PenPoint operating system translates handwriting directly from a ruled pad to the page.

**Scroll**  To move a document to see parts of it that do not fit on the screen. Use flicks in the document, or the scroll handle, or arrows in the scroll margin to see the part of the document that's off the screen.

**Scroll margin**  The bar at the right or bottom of the screen that you use to see the part of the document that's off the screen. Drag the scroll handle—the small horizontal bar in the scroll margin—to bring the off screen portion into view. You can also flick on the scroll margin or the document.

**Search range**  The amount of a document you want PenPoint to search when it looks for text. You can search a whole document and its embedded documents, or you can limit the search by your choices in the Find & Replace sheet.

**Section**  A container you create on the Table of Contents for documents that you want to keep together. Section names appear in bold. Each section also has its own divider, which lists the documents it contains. A section can be expanded to show all the documents in it or closed to show the section name only.

**Select**  To indicate something for the next command to act on. Something that's selected looks different; usually the background darkens.

**Selection**  Something you've chosen on the screen, such as a title in the Table of Contents, that the next PenPoint command will affect.

**Signature pad**  A writing pad you use to add a signature to your correspondence. Your signature is printed as you wrote it; it isn't translated into typed text. Choose Signature Pad from the Insert menu of a MiniText document.

**Special characters**  Symbols that the PenPoint operating system uses to indicate line breaks and paragraph marks. To see the special characters, choose this option from the View Text option sheet.

**Stationery**  A document you choose from the Create Menu or Stationery notebook to create a new, blank document of a specific type.

**Tab**  A marker attached to a document or section in the Notebook. Tap a tab to go to the attached page.

**Tab stops**  A preset indentation in text. You set tab stops on the Tab Stops Text option sheet. To insert them in text, you draw an insert tab gesture in front of the text you want to indent.

**Text option sheets**  Option sheets that allow you to style and format text. For example, you use Text option sheets to select a different font style and to change the placement of text on a page.

**Table of Contents**  A list of all the documents and sections in the Notebook.

**Title line**  The area of a document at the top of the page that contains the name of the document and the page-turn arrows.

**Tools**  Accessories including Handwriting Customization, the Disk Manager, a clock, and a software keyboard. You can add commercially available tools to Tools.

**Translate**  To convert your handwriting into typed, electronic text. You translate your writing by tapping the OK button on the writing or editing pad.

**Unrecognized character**  The symbol PenPoint displays if it doesn't recognize a letter you wrote in a writing or editing pad. The standard symbol is a question mark in a circle. You can change the symbol for the unrecognized character to an underscore symbol with the Unrecognized Character category on the Handwriting Preferences sheet.

**Volume**  A floppy disk, a hard disk, or any section of a hard disk designated as a separate drive.

**Writing pad**  A pad on which you write text that the PenPoint operating system translates into typed, electronic text. Writing pads come in different sizes and styles, such as boxed or ruled.

**Zoom**  An option that you can choose from the Safeguards Preferences sheet to increase the size of the document to fill the entire screen area.
Index

A
About (Document menu), 113, 181, 237
About (Volume menu), 221, 223
Accelerated (Access Speed), 243
Accept, using customization sets and, 138
accessories, using cork margin and, 111
Access sheet
  Access Speed, 181
  Borders & Controls category, 109
  changing display and, 203
  Cork Margin, 111
  customizing documents and, 113
  other ways to use memory efficiently and, 243
  turning Table of Contents into control panel and, 250
  using Document sheet and, 181
Access Speed (Access sheet), 181
  Accelerated, 243
accommodating multiple users, 247–248
Active Size (Title & Info sheet), 181
adapters, serial printer, 261
Add (Edit menu), 80
adding
  footers, 208
  headers, 208
  page breaks to MiniText documents, 161
  signatures to documents, 167
  stationery to Create menu, 88
  text, 147
  words to dictionary, 166
Add Printers sheet, 81
adjusting writing pad size and shape, 133
alarm, setting, 204. See also Clock
Alarm sheet, setting alarm and, 204
aligning pen, 123
Alignment (Paragraph sheet), 159
All (Pages pop-up list), 209
Allowed (Zooming Documents category), 238
  floating documents and, 97
  zooming documents and, 100

{Alt}, correcting text in writing pads by typing and, 135
A.M., setting time and, 195
applications
  changes to, 74
  deactivating, 76–77
  described, 7
  installing, 66–82
    from disk, 68–70
Applications sheet, 68, 76
  backing up stationery and, 91
  using Document sheet and, 181
Apply
  choosing options with, 25, 26
  copying formats or styles and, 162
Apply & Close
  choosing options with, 26
  arrow down, gesture profile for, 41
  arrows. See page arrows; scroll arrows
  arrow up, gesture profile for, 41
  attaching Notebook tabs, 189, 190
attributes, described, 23
automatic installation, 70
  copying documents to floppy disk and, 217
  using Disk Manager and, 219
Auto Shut Off option
  No, 197
  setting alarm and, 204
  using, 179
  Yes, 197

B
backing up
  Notebook, 237–239
  stationery, 91
Backward (Direction category pop-up list), 174
BaseStation cable
  connecting directly to disk drive and, 264
  connecting GO Floppy Drive through GO Quick Charger and, 263
  connecting keyboard and, 272
INDEX

connecting to serial printers through GO Quick Charger and, 262
using floppy disks and, 265
using GO Quick Charger and, 257
BaseStation modules. See specific BaseStation module
BaseStation port, 80
basic gestures, 36
batter(ies)
installing, 259
recharging, 255–257
with GO Quick Charger, 257
with GO Travel Charger, 256
removing, 258
replacing, 258–259
battery pack, removing, 258
Begin, using Letter Practice and, 137
Begin on New Page (Formatting category), 109, 212
Beginning (Start From category pop-up list), 174
Between Lines (Paragraph sheet), 158
bigger, making objects, 15
black checkmark, 26
bold
gesture profile for, 41
making text, 41
styling text directly and, 155
Bookshelf
described, 6
gestures on, 39
illustrated, 6
moving icons on, 28
moving items on, 200
seeing what’s on, 16–22
See also Disks; Help; In box; Installer; Keyboard; Out box; Preferences; Stationery; Tools
booting
described, 246
PenPoint, when frozen, 246
restoring Notebook after, 238–239
See also cold booting
borders, gesture profile for, 41
Borders & Controls category (Access sheet), 109
Show, 109
borders of embedded documents, hiding, 41
bottom handles, making objects bigger or smaller with, 15
Boxed (Writing Pad pop-up list), 128
boxed pads
choosing, 128
described, 128
editing text in, gestures for, 38
insert space in, 52
pigtail in, 57
setting insertion point in, with press, 59
writing in, 120
See also writing pad(s)
Box Shape pop-up list, adjusting writing pad size and shape and, 133
Box Size pop-up list, adjusting writing pad size and shape and, 133
bracket, left, gesture profile for, 42
bracket, right, gesture profile for, 42
breaks
line, inserting, 161
page, adding to MiniText documents, 161
paragraph, inserting, 161
Bring to (View menu), 188
busy clock, described, 11. See also Clock
Button (Show menu), 179, 180
buttons, dismissing objects with, 13. See also specific button
By Date (Sort menu), 182
By Name (Sort menu), 182
By Page (Sort menu), 182
By Size (Sort menu), 182
By Type (Sort menu), 182
C

 cables
BaseStation cable, 257, 262, 263, 264, 265, 272
GO PC Cable—FlashCard, 260–262, 268–270
GO Serial Printer Cable, 260–262
SCSI-II to SCSI-I connector cable, 267
Cancel
deleting documents and, 104
dismissing objects with, 13
editing text in edit pads, 149
translating handwriting and, 122
writing in ruled pads and, 129
caret, gesture profile for, 43
caret tap, gesture profile for, 43
USING PENPOINT

caring for GO computer, 273
carrying case. See GO Carrying Case
case. See GO Carrying Case
Case menu, styling text directly and, 155
changes
saving, 74–75
to applications, 74
to services, 74
changing
date, 196
display, 203
edit pad style, 130
home volume, 78
icon size, 200
line spacing, 158
paragraph spacing, 158
response time, 196
time zones, 195
writing pad style, 130
characters
adding, 147
deleting, 124, 125, 148, 149
selecting, 144
Character sheet
creating customized stationery and, 90
Hidden, 163
styling text with Text sheet and, 156
changers. See GO Quick Charger; GO Travel Charger
check, gesture profile for, 44
checking spelling, 165–166
check lists, choosing options from, 25
check marks
dimmed, customizing documents and, 113
styling text with Text sheet and, 156
Checkpoint (Document menu), 77, 104, 236, 243, 244, 245, 258
check tap, gesture profile for, 44
choosing
boxed pads, 128
field fonts, 198
fonts, 198
menu commands, 10
options, 25–26
page layouts, 207
ruled-boxed pads, 131–132
ruled pads, 129–130
screen layouts, 199
style of writing pads, 128–133
writing pad size and shape, 133
circle, gesture profile for, 45
circle line, gesture profile for, 45
circles, concentric, 11, 34
circle tap, gesture profile for, 46. See also hyperlink buttons
cleaning screen, 273
Clear
choosing ruled-boxed pads and, 131
editing text in edit pads, 149
using customization sets and, 138
writing in ruled pads and, 129
Clock
described, 18
using, 202–204
See also alarm; busy clock; date(s); time; Tools
clock sheet
changing display and, 203
setting alarm and, 204
Close
automatic installation and, 70
choosing options with, 26
closing Preferences sheet with, 17
closing Tools with, 18
copying documents to floppy disks and, 217
dismissing objects with, 13
finding text and, 170
installing applications with, 68
replacing text and, 172
using Disk Manager and, 219
close corners, dismissing objects with, 13
closing
icons, 227
menus, 10
cold booting, described, 246. See also booting
Collapse (View menu), 179, 221
Collate pop-up list
printing documents and, 210
Yes, 210
commands
described, 7, 10
dimmed, 10
giving with gestures and menus, 10–11
illustrated, 6
See also gestures; menus/menu commands or specific command

Complete word only, refining searches and, 175

compound documents. See embedded documents

concentric circles, 11, 34

connecting
keyboard, 272
printers, 79–80
SCSI hard drive, 267
to GO Floppy Drive
directly, 264
through GO Quick Charger, 263
to PC, 268–270
to printer, 260–262
to serial printer
directly, 260
through GO Quick Charger, 262
to TOPS FlashCard
directly, 269
through GO Quick Charger, 270

connector cable. See SCSI-II to SCSI-I connector cable

connectors, serial printer, 261

container documents, printing embedded documents within, 212. See also embedded documents

contents. See Table of Contents

Contents tab, illustrated, 9

Continue, formatting floppy disks and, 235

control panel, turning Table of Contents into, 249–250

converting
PC documents to PenPoint documents, 233–234
PenPoint documents to PC format, 230–232

Copies, printing documents and, 210

Copy (Edit menu), 153

Copy Contents (Volume menu), 228, 229

copying
dictionaries, 72
disks, 228–229
documents
from hard disk to floppy disk, 226
to floppy disk, 217
documents or sections to disk, 224
formats, 162
hyperlink buttons, 193
Notebook objects, 28–29

objects
gestures for, 36
with tap press, 63
selections with tap press, 63
styles, 162
text, 152–153
gestures for, 36
to home, shortcut for, 75

Copy to Home (Home menu), 74, 91
connecting printers and, 79
cork margin
gesture profile for, 46
turning Table of Contents into control panel and, 250
using, 111–112
using hyperlink buttons to move between pages and, 193

Cork margin, setting alarm and, 204

Cork Margin (Access sheet), 111

Cork Margin (Show category), 250
corner handles, making objects bigger or smaller with, 15
correcting
text in writing pad by typing, 135
translations, 124–125
with Proof sheet, 125
in writing pad, 124
cover. See GO Leather Cover

Create
copying dictionaries with, 72
shortcut for creating handwriting profiles, dictionaries, or preference sets with, 72

Create & Close, copying dictionaries with, 72

Create Directory (Edit menu), 222

Create menu, 84
adding stationery to, 88
creating customized stationery and, 90
creating Disk Manager stationery and, 223
moving documents into sections and, 223
Notebook, 247
pop-up, 86, 90, 105
creating sections and, 184
Section, 86, 90, 105
using cork margin and, 111
using to create documents, 85–86
cross out, gesture profile for, 11, 47
{Ctrl}, correcting text in writing pads by typing and, 135
Current, described, 67
customization sets, using, 138–139
customized indexes, creating, 251–252
customized stationery, creating, 89–90
customizing
documents, 113
handwriting, 136–141
Help notebook, 201

D
dark check marks, styling text with Text sheet and, 156
dark gray highlights, using customization sets and, 139
date(s)
  printing, 208
  setting, 196
  See also Clock
Date (Show menu), 180, 182, 221
Date (Sort menu), 221
Date Format, setting date and, 196
Date sheet
  setting date and, 196
  setting preferences and, 194
Day, setting date and, 196
DB9 connectors, 261
DB25 connectors, 261
Deactivate (Home menu), 76, 77
deactivating
  applications, 76–77
  described, 66
  fonts, 77
  things you can safely deactivate, 243
  utilities, 76–77
defining searches, 173–175
Delete (Edit menu), 104, 167, 223
deleting or purging stationery and, 92
deleting, 76
  characters, 124, 125, 149
  documents, 104
    from Disk Manager, 223
Help notebook, 201
hyperlink buttons, 193
Notebook tabs, 189
objects, gestures for, 36
Quick Help, 201
sections, 184
stationery, 92
text, 148
  gestures for, 36
  things you can safely delete, 243
deselecting, described, 12
device drivers, defined, 66
devices, installing, 66–82
dialog sheets
  described, 23
  using, 23–27
  See also option sheets or specific dialog sheet
dictionaries
  adding words to, 166
  changing home volume for, 78
  copying, 72
  creating, 71
  shortcut for, 72
dimmed check marks
  customizing documents and, 113
  styling text with Text sheet and, 156
dimmed commands, 10
dimmed options, 26
direction, search, 173–174
Direction category pop-up list, Backward, 174
directories
  described, 219
  new, creating, 222
disk(s)
  copying, 228–229
  copying documents or sections to, 224
  duplicating, 228–229
  ejecting, 220
    from GO Floppy Drive manually, 266
    finding out more about what’s on, 221
    installing applications from, 68–70
    installing utilities from, 68–70
    renaming, 223
    transferring documents between, 226–227
  See also floppy disks; hard disk; volume(s)
disk drive. See GO Floppy Drive; hard disk
Disk Manager
  changing home volume and, 78
deleting documents from, 223
described, 18, 216
INDEX

eject in, 49
using, 218–223
See also Tools

Disk Manager stationery, creating, 223

Disks, 20. See also Bookshelf

dismissing objects, 13
display, changing, 203
Displayed (Seconds category), 195
displaying
Notebook tabs, 191
option sheets, 24

Display sheet, changing display and, 203
Document Floating option, floating documents and, 178

Document menu, 213
About, 113, 181, 237
Checkpoint, 77, 104, 236, 243, 244, 245, 258
Print, 22, 82, 110, 207, 209, 210, 212
Print Setup, 109, 110, 157, 207, 208, 212
Revert, 104, 236
Send, 22
document names, printing, 208

Document Only (Search category pop-up list), 173
document options, setting, 107
documents
adding signatures to, 167
container, printing embedded documents within, 212
copying, to floppy disk, 217
creating, 84–113
using Create menu, 85–86
using Stationery notebook, 87–88
customizing, 113
deleting, 104
from Disk Manager, 223
described, 6
editing text in, gestures for, 37–38
embedded, 39, 107–110
floating, 108
hiding borders of, 41
making full-page documents, 107
moving, 107
printing, 109–110, 211–212
using hyperlink buttons to move between pages and, 193
existing, embedding, 106
filing, 216–239
finding out more about, 180–181
floating, 97–98, 99, 178, 187
frozen, restarting PenPoint when, 245
full-page, making embedded documents, 107
grouping into sections, 184–186
moving into sections, 185
navigating, tips on, 249–252
new, embedding, 105
in Notebook, 8–9
PC, converting to PenPoint documents, 233–234
PenPoint
converting PC documents to, 233–234
converting to PC format, 230–232
previewing, 164
printing, 82, 206–213
receiving, 206–213
renaming, 86, 102–103, 223
saving, 104, 236
scrolling, 93–96
selecting, 144
sending, 206–213
setting options for, gestures for, 39
spell in, 61
transferring, 224–227
between disks, 226–227
to and from Notebook, 224–225
turning to, 9
using, 84–113
tips on, 249–252
zooming, 100–101

Document sheet
creating customized stationery and, 89
customizing documents and, 113
finding out more about documents and, 180
setting print options for embedded documents and, 109
using, 181
cork margin and, 111
document title line, gestures in, 39
document titles
editing text in, 150
illustrated, 9, 179

Document Zooming option, creating Notebooks and, 248
double caret, gesture profile for, 47
double flick down, gesture profile for, 48
double flick left, gesture profile for, 48
double flick right, gesture profile for, 48
double flick up, gesture profile for, 48
USING PENPOINT

double tap
gesture profile for, 49
to select words, 144

Draw, scrolling documents and, 93
drawing gestures, 34–64
drive. See GO Floppy Drive; hard disk
dt., adding date to headers and footers and, 208
Duplicate (Volume menu), 228
duplicating disks, 228–229

■ E

editing
fill-in fields on forms, 38
overwrite fields on forms, 38
text, 144–167
in boxed writing pads, 38
in documents, 37–38
in edit pads, 38, 149
in fields, 150–151
in labels and document titles, 150
in ruled writing pads, 38

Edit menu, 28, 29
Add, 80
Copy, 153
Create Directory, 222
Delete, 104, 167, 223
Export, 230
Find, 170, 171
moving and copying text and, 152
Options, 78, 156
Rename, 86, 102, 223
Select All, 90, 144
Spell, 165

edit pads
changing style of, 130
editing text in, 149
gestures for, 38
using, 150
eject, gesture profile for, 49

Eject
automatic installation and, 70
using floppy disks and, 265, 266
Eject & Forget, using Disk Manager and, 220
ejecting
disks, 220
from GO Floppy Drive manually, 266

Eject & Remember (Volume menu), 227
using Disk Manager and, 220
electricity, static, 273
ellipsis, described, 23
embedded documents
floating, 108
hiding borders of, 41
making full-page documents, 107
moving, 107
printing, 109–110, 211–212
using hyperlink buttons to move between pages and, 193
working with, 107–110
gestures for, 39
embedded writing pads
adding text and, 147
described, 126
getting, 127
embedding
described, 84
existing documents, 106
new documents, 105
tools, 106

Empty, moving documents into sections and, 185
Enabled, printing documents and, 82
Enabled box, printing from Out box and, 211
Enabled checkbox, 81, 82
Enabled column, printing from Out box and, 211
existing documents, embedding, 106
Exit
analyzing progress and, 140
using customization sets and, 139
Exit Handwriting Customization
analyzing progress and, 140
using customization sets and, 139
using Letter Practice and, 137

Expand (View menu), 179, 221
export, gesture profile for, 49
Export (Edit menu), 230
exporting
described, 230
documents, 230–231

Export sheet
described, 216
exporting documents and, 231
female DB9 connectors, 261
female DB25 connectors, 261
field fonts, choosing, 198
fields
    editing text in, 150–151
    fill-in
        described, 150
        on forms, 38
    overwrite
        described, 151
        on forms, 38
    text, described, 26
Filed Size (Title & Info sheet), 181
    backing up Notebook and, 237
File menu, Rename, 184
filing documents, 216–239
fill-in fields
    described, 150
    on forms, editing, 38
find, gesture profile for, 50
Find
    defining searches and, 173
    finding text and, 170
    replacing text and, 171, 172
Find (Edit menu), 170, 171
finding text, 170–175
Find & Replace sheet
    defining searches and, 173, 174
    refining searches and, 175
    replacing text and, 171
Find sheet
    finding text and, 170
    replacing text and, 171
1st Line Offset (Paragraph sheet), 158
First Page
    adding headers and footers and, 208
    printing documents and, 210
        Yes, 208
FlashCard. See TOPS FlashCard
flick down, gesture profile for, 51
flick left, gesture profile for, 50
flick right, gesture profile for, 50
flicks, described, 93
flick up, gesture profile for, 51
floating
    described, 84
    documents, 97–98, 178, 187
    embedded documents, 108
    pages, 187
floating documents
    moving, 99
    resizing, 99
Floating Documents, floating documents and, 97
floating option, setting, 97
floppy disks
    changing home volume for dictionaries from one to another, 78
    copying documents from hard disk to, 226
    copying documents to, 217
    copying to hard disk, 229
    duplicating, 228
    formatting, 235
    transferring documents from one to another, 227
    using, 265–266
See also disk(s)
Floppy Drive. See GO Floppy Drive
Font category, creating customized stationery and, 90
fonts
    choosing, 198
    deactivating, 77
    field, choosing, 198
    symbol, 77
Fonts & Layout sheet
    choosing PenPoint fonts and field fonts and, 198
    choosing screen layouts and, 199
    setting preferences and, 194
Fonts sheet, 77
Footer, adding headers and footers and, 208
Footer Margin, adding headers and footers and, 208
footers, adding, 208
format(s)
    copying, 162
    described, 216
    PC, 230–232
Format (Volume menu), 235
Format menu
    For Printer, 164
    For Screen, 164
formatting
floppy disks, 235
text, 144–167
Formatting category (Layout sheet), 109, 110
  Begin on New Page, 109, 212
  Keep on Same Page, 109, 212
  Print Entire Document, 109, 110, 212
Formatting option, printing embedded documents and, 109
forms
  fill-in fields on, 38
  overwrite fields on, 38
For Printer (Format menu), 164
For Screen (Format menu), 164
frozen documents, restarting PenPoint when, 245
frozen PenPoint, booting when, 246
full-page documents, making embedded documents, 107
function keys, correcting text in writing pads by typing and, 135
fundamentals, 6–31

G
Gesture, setting response time and, 196
gesture profile(s)
  for arrow down, 41
  for arrow up, 41
  for bold, 41
  for borders, 41
  for bracket, left, 42
  for bracket, right, 42
  for caret, 43
  for caret tap, 43
  for check, 44
  for check tap, 44
  for circle, 45
  for circle line, 45
  for circle tap, 46
  for cork margin, 46
  for cross out, 11, 47
described, 3, 11, 34
  for double caret, 47
  for double flick down, 48
  for double flick left, 48
  for double flick right, 48
  for double flick up, 48
  for double tap, 49
  for eject, 49
  for export, 49
  for find, 50
  for flick down, 51
  for flick left, 50
  for flick right, 50
  for flick up, 51
  for initial caps, 51
  for insert character, 52
  for insert space, 52–53
  for insert tab, 53
  for italic, 54
  for line through, 54
  for lower case, 55
  for menu, 55
  for new line, 55
  for new paragraph, 56
  for normal, 56
  for pigtail, 57
  for plus, 57
  for proof, 59
  for quadruple tap, 59
  for question mark, 60
  for scratch out, 60
  for spell, 61
  for tab, 61
  for tap, 62
  for tap press, 63
  for triple tap, 63
  for underline, 64
  for upper case, 64
using, 35
gestures
  basic, 36
  on Bookshelf, 39
  for copying and moving text and objects, 36
described, 7, 10
  in document title line, 39
drawing, 34–64
  for editing fill-in fields on forms, 38
  for editing overwrite fields on forms, 38
  for editing text in boxed and ruled writing pads, 38
  for editing text in documents, 37–38
  for editing text in edit pads, 38
  for getting help, 38
  giving commands with, 10–11
  illustrated, 6
  on Notebook tabs, 40
INDEX

PenPoint, 36–64
  for scrolling, 39
  in scroll margin, 40
  for setting options for documents, text, and objects, 39
  in Table of Contents, 40
  using, 34–35
  for working with embedded documents, 39
See also commands; menus/menu commands or specific gesture

GO Carrying Case, 273

GO Floppy Drive
  booting and, 246
  connecting, through GO Quick Charger, 263
  connecting to, directly, 264
  formatting floppy disks and, 235
  manually ejecting disks from, 266
  using, 263–264
  using floppy disks and, 265
  using floppy disks in, 265
  using GO Travel Charger and, 256
  using hard drives and, 267

GO Leather Cover, 273

GO PC Cable—FlashCard
  connecting to PCs and, 268–270
  connecting to printers and, 260–262

GO pen, 273
  aligning, 123
  described, 7

GO Quick Charger
  connecting GO Floppy Drive through, 263
  connecting keyboard and, 272
  connecting printers to, 80
  connecting serial printer to through, 262
  connecting to PCs and, 268–270
  connecting to printers and, 260–262
  connecting TOPS FlashCard to through, 270
  recharging battery and, 255
  using, 257
  using floppy disks and, 265
  using GO Travel Charger and, 256

GO Release Notes, connecting to printers and, 260

GO Serial Printer Cable, connecting to printers and, 260–262

GO Travel Charger
  recharging battery and, 255
  using, 256
  gray checkmark, 26
  gray highlights, using customization sets and, 139
  grouping documents into sections, 184–186

H
  handle(s)
    bottom, making objects bigger or smaller with, 15
    corner, making objects bigger or smaller with, 15
  scroll
    described, 95
    scrolling documents and, 96

Hand Preference
  choosing screen layouts and, 199
  Left, 199

handwriting
  customizing, 136–141
  translating, 122–123

Handwriting, setting response time and, 196

Handwriting Customization, 71
  accommodating multiple users and, 141
  customizing handwriting and, 136
  described, 18
See also Tools

handwriting profiles
  accommodating multiple users and, 141
  creating, shortcut for, 72
  renaming, 71
  saving changes to, 74

Handwriting sheet, 67, 74
  adjusting writing pad size and shape and, 133
  choosing boxed pads and, 128
  choosing ruled-boxed pads and, 131
  choosing ruled pads and, 129
  correcting translations in writing pad and, 124
  printing in upper case and, 121
  setting preferences and, 194
  Upper Case Only, 138
  viewing, 67

Handwriting Timeout, translating handwriting and, 123

hard disk
  copying documents to floppy disk from, 226
  copying floppy disk to, 229
  using, 267
See also disk(s); SCSI hard drive

hard drive. See hard disk

Header, adding headers and footers and, 208

Header Font, adding headers and footers and, 208
Header Margin, adding headers and footers and, 208
headers, adding, 208
Headers & Footers sheet, adding headers and footers and, 208
Header sheet, printing embedded documents and, 110
Header Size, adding headers and footers and, 208
help
  getting, 30–31
gestures for, 38
  See also Help; Help notebook; Quick Help
Help (icon), 16. See also Bookshelf; help; Help notebook; Quick Help
Help notebook
  customizing, 201
deleting, 201
  using, 31
  See also help; Help; Quick Help
Help Notebook (button), 16
  closing Quick Help with, 30
  opening Help notebook with, 31
Hidden (Character sheet), 163
hiding borders of embedded documents, 41
highlights, using customization sets and, 139
home
  copying to, shortcut for, 75
described, 66
Home menu
  Copy to Home, 74, 91
  Deactivate, 76
  Update from Home, 74
home path, described, 78
home volume
  changing, 78
saving changes to, 74
  updating from, 75
Home Volume (button), copying dictionaries with, 72
Hour, setting time and, 195
humidity, 273
hyperlink buttons
  copying, 193
  creating customized indexes and, 251–252
deleting, 193
described, 178
moving, 193
redefining, 193
renaming, 193
  turning Table of Contents into control panel and, 250
using cork margin and, 111
  using to move between pages, 192–193
  See also circle tap
I, J
IBM PS/2 keyboard. See keyboard
Icon (Show menu), 180
icons
  on Bookshelf, moving, 28
closing, 227
described, 6
document, 179
illustrated, 9, 187
moving, 200
Icon sheet
  changing icon size and, 200
  finding out more about what’s on disks and, 221
icon size, changing, 200
Ignore, checking spelling and, 165
Import, converting PC documents to PenPoint documents and, 233
Import sheet
  converting PC documents to PenPoint documents
  and, 233, 234
copying documents or sections to disk and, 225
described, 216
sending and receiving documents and, 213
Import to options, Placeholder, 234
In box, 22, sending and receiving documents and, 213.
  See also Bookshelf
indexes, customized, creating, 251–252
Individual Character customization, using customization sets and, 139
initial caps
  gesture profile for, 51
  styling text directly and, 155
In Place (Open category), 108
insert character, gesture profile for, 52
inserting
  line breaks, 161
  paragraph breaks, 161
  spaces, 124, 125, 149
  in text, 148
insertion point
setting
  in boxed pads, 59
  in text, 58

Insert menu
  getting writing pads and, 127
  Page Break, 161
  Signature Pad, 167
  Tab, 160

insert space, gesture profile for, 52–53
insert tab, gesture profile for, 53
Install
  automatic installation and, 70
  installing applications with, 68
installation, automatic, 70
Install & Eject
  automatic installation and, 70
  installing applications with, 68
Installer, 21
  accommodating multiple users and, 141
  described, 66
  See also Bookshelf
Installer sheet, changing home volume and, 78
Install from Disk, 68, 69
installing
  applications, 66–82
    from disk, 68–70
  batteries, 259
  devices, 66–82
  option cartridges, 271
  utilities from disk, 68–70
italic
  gesture profile for, 54
  styling text directly and, 155

K
Keep on Same Page (Formatting category), 109, 212
keyboard
  connecting, 272
  using to write, 134–135
  See also Keyboard; software keyboard
Keyboard (icon), 21
  described, 18
  See also Bookshelf; keyboard; software keyboard; Tools

L
labels, editing text in, 150. See also Notebook tabs; tabs
Landscape (Orientation), 199, 207
layouts, screen, choosing, 199
Layout sheet
  choosing page layouts and, 207
  Formatting category, 109, 110
  printing embedded documents and, 109, 110, 212
learning
  more about Penpoint, 242–252
  to write on screen, 116
leather cover. See GO Leather Cover
Left (Hand Preference), 199
left bracket. See bracket, left
Left Margin (Paragraph sheet), 157
left page arrow. See page arrows
letterhead stationery, 211
Letter Practice
  customizing handwriting and, 136
  described, 18
  using, 116, 137
  See also Tools
letters, mistranslated/unrecognized, correcting, 124
light gray highlights, using customization sets and, 139
line breaks, inserting, 161
Line Height (Paragraph sheet), 158
lines, new, starting, 161
line spacing, changing, 158
line through, gesture profile for, 54
liquids, spilled, 273
lithium battery, removing batteries and, 258
lower case
gesture profile for, 55
  styling text directly and, 155

M
magnifying text, 164
male DB9 connectors, 261
male DB25 connectors, 261
managing
  memory, 242–244
Notebook, 178–204
Stationery notebook, 91–92
manually ejecting disks from GO Floppy Drive, 266
margin(s)
scroll, 95
gestures in, 40
scrolling documents and, 96
setting, 157
marking pages using Notebook tabs, 189–191
memory
finding out how much something uses, 242
managing, 242–244
other ways to use efficiently, 243
out of memory message and, 244
Memory Usage sheet
finding out how much memory something uses and, 242
setting preferences and, 194
menu, gesture profile for, 55
Menu box, creating Disk Manager stationery and, 223
menu commands
choosing, 10
described, 10
menu line
creating customized indexes and, 251
illustrated, 6
turning Table of Contents into control panel and, 250
Menu Line (Show category), 250
menus/menu commands
closing, 10
described, 7
giving commands with, 10–11
illustrated, 6
See also commands; gestures or specific menu/menu command
MiniText
getting writing pads and, 127
printing in writing pads and, 117, 118
setting tabs and, 160
styling text directly and, 155
MiniText documents, adding page breaks to, 161
Minute, setting time and, 195
mistranslated/unrecognized letters, correcting, 124
Model pop-up list, 80
Modified, described, 67
Modified column, saving changes and, 74
moving
between pages, using hyperlink buttons, 192–193
documents, into sections, 185
embedded documents, 107
floating documents, 99
hyperlink buttons, 193
icons, 200
items on Bookshelf, 200
Notebook objects, 14, 28–29
objects
gestures for, 36
with press, 58
pages, 183
selections, with press, 58
text, 152–153
gestures for, 36
multiple check lists, 26
choosing options from, 25
selecting from, 12
multiple Notebooks, creating, 186
multiple users, accommodating, 141, 247–248
Name, described, 67
Name (Sort menu), 221
names, document, printing, 208
navigating documents, tips on, 249–252
new directories, creating, 222
new documents, embedding, 105
new line, gesture profile for, 55
new lines, starting, 161
new pages, starting, 161
new paragraph, gesture profile for, 56
new paragraphs, starting, 161
Next
using customization sets and, 139
using Letter Practice and, 137
nm., adding document name to headers and footers and, 208
normal
gesture profile for, 56
styling text directly and, 155
Not Displayed (Seconds category), 195
Notebook(s)
backing up, 237-239
booting and, 246
creating, 247-248
described, 6, 178
documents in, 8-9
finding out what’s installed in, 67
managing, 178-204
multiple, creating, 186
printing documents from pages in, 209–210
rearranging, 183
restoring, 238–239
seeing what’s in, 179
transferring documents and sections to and from, 224–225
writing in, 116–141
See also specific notebook

Notebook (Create menu), 247

Notebook objects
copying, 28–29
moving, 14, 28–29
working with, 13–15
See also objects

Notebook tabs
attaching, 189, 190
deleting, 189
described, 178
displaying, 191
gestures on, 40
illustrated, 187
using to mark pages, 189–191
See also labels; tabs

numbers
page
described, 7
illustrated, 9, 187
printing, 208

O

objects
copying
gestures for, 36
with tap press, 63
deleting, gestures for, 36
dismissing, 13
making bigger/smaller, 15
moving
gestures for, 36
with press, 58

P

pads. See writing pad(s)
page arrows
described, 178
turning to pages and, 188
Page Break (Insert menu), 161
page breaks, adding to MiniText documents, 161
page layouts, choosing, 207

See also Notebook objects

See also Notebook objects

Open category
In Place, 108
Popup, 108
operating, 273
option cartridges, using, 271
options
choosing, 25–26
dimmed, 26
setting, gestures for, 39
Options (Edit menu), 78, 156
option sheets
described, 17, 23
displaying, 24
using, 23–27
See also dialog sheets or specific option sheet

Option Slot, 80
Options sheet, 81
Orientation
choosing page layouts and, 207
Landscape, 199, 207
Portrait, 199, 207
Original word, refining searches and, 175
Other category (Paper Size), 209
Out box, 22
described, 206
printing documents and, 82
printing from, 211
sending and receiving documents and, 213
See also Bookshelf
out of memory message, 244
overwrite fields
described, 151
on forms, editing, 38
USING PENPOINT

page numbers
described, 7
illustrated, 9, 187
printing, 208

pages
copying sentences between, 29
floating, 187
marking using Notebook tabs, 189–191
moving, 183
moving between using hyperlink buttons, 192–193
new, starting, 161
in Notebook, printing documents from, 209–210
turning to, 187–188
typing text onto, 134
See also sections; subsections

Pages pop-up list
All, 209
printing documents and, 209

page turn arrow, described, 11

Paper Size
choosing page layouts and, 207
Other category, 209
printing documents and, 209

paragraph breaks, inserting, 161

paragraphs
new, starting, 161
selecting, 144

Paragraph sheet
Alignment, 159
Between Lines, 158
changing line spacing and, 158
1st Line Offset, 158
Left Margin, 157
Line Height, 158
Right Margin, 157
setting margins and, 157
Space After, 158
Space Before, 158
paragraph spacing, changing, 158

path, home, described, 78

PC, connecting to, 268–270

PC Cable—FlashCard. See GO PC Cable—FlashCard

PC documents, converting to PenPoint documents, 233–234

PC format, converting PenPoint documents to, 230–232

pen. See GO pen

PenPoint booting when frozen, 246

Penpoint
creating and using documents in, 84–113
drawing gestures in, 34–64
editing and formatting text in, 144–167
filing documents in, 216–239
finding and replacing text in, 170–175
fundamentals in, 6–31
PenPoint, gestures in, 36–64
Penpoint
installing applications and devices in, 66–82
learning more about, 242–252
managing Notebook in, 178–204
printing, sending, and receiving documents in, 206–213
PenPoint, restarting when documents freeze, 245

Penpoint
Using PenPoint and, 2–3
writing in Notebook in, 116–141

PenPoint documents
converting PC documents to, 233–234
converting to PC format, 230–232

PenPoint fonts. See fonts

PenPoint sheet, setting preferences and, 194

Pen sheet
aligning pen and, 123
setting preferences and, 194
Tap to Align Pen category, 123

Personal Dictionary, described, 18. See also Tools
personalized utilities, creating, 71–73
pg., adding page numbers to headers and footers and, 208
pigtail, gesture profile for, 57
Placeholder (Import to options), 234
plus, gesture profile for, 57
P.M., setting time and, 195
point size, styling text directly and, 155

PopUp (Open category), 108
pop-up Create menu, 86
creating customized stationery and, 90
creating new documents inside existing ones and, 105
creating sections and, 184

Section, 184
INDEX

pop-up lists, 26
- choosing options from, 25
described, 25
See also specific pop-up list

pop-up pad
- adding text and, 147
described, 126
getting, 126
port, described, 206
Port pop-up list, 80
Portrait (Orientation), 199, 207
positioning text, 159
preferences
- creating, 71
described, 178
setting, 194–199
Preferences, See also Bookshelf
Preferences (icon), 17
preference sets, creating, shortcut for, 72
Preferences sheet
- floating documents and, 97, 187
- setting preferences and, 194
- setting time and, 195
Timeout category, 34
press, gesture profile for, 58–59
Press, setting response time and, 196
previewing documents, 164
Print (Document menu), 22, 82, 110, 207, 209, 210, 212
Print & Close, printing documents and, 210
Print dialog, printing documents and, 82
Print Entire Document (Formatting category), 109, 110, 212
Print Entire Document (Print Setup menu), 211
Printer (command), described, 206
printer cable. See GO Serial Printer Cable
printer drivers, described, 206
Printer Enabled category, printing documents and, 82
Printer Enabled pop-up list, 209
- printing documents and, 209
printer options, setting, 81–82
Printer pop-up list, printing documents and, 209, 211
Printer port, 80
printers
- connecting to, 260–262
described, 206
setting up, 79–82
Printers (icon)
- connecting printers and, 79
described, 18, 206
See also Tools
Printers sheet, 81, 82
- connecting printers and, 79
printing
- dates, 208
document names, 208
documents, 82, 206–213
embedded documents, 109–110, 211–212
from Out box, 211
page numbers, 208
in upper case, 121
in writing pads, 117–121
print options, setting for embedded documents, 109
Print Setup (Document menu), 109, 110, 157, 207, 208, 212
Print Setup menu, Print Entire Document, 211
Print Setup sheet, printing embedded documents and, 109, 110, 211
procedures
- described, 2
- using, 2–3
profiles. See gesture profile(s); handwriting profiles
proof, gesture profile for, 59
Proof sheet, correcting translations with, 125
Proximity/Merriam-Webster Linguibase, 166
PS/2 keyboard. See keyboard
Purge, deleting or purging stationery and, 92
purging
- described, 92
- stationery, 92

Q

quadruple tap
- gesture profile for, 59
to select paragraphs, 144
question mark, gesture profile for, 60
question mark symbol
   choosing ruled pads and, 130
   correcting translations in writing pad and, 124
Quick Charger. See GO Quick Charger
Quick Help
   deleting, 201
   getting, 30
   See also help; Help; Help notebook
Quit, using Letter Practice and, 116
■ R
rain, 273
range, search, 173–174
Reached End, finding text and, 170
Reactivate, 77
reactivating, described, 66
Read Only
   finding out more about what's on disks and, 221
rearranging
   items on Bookshelf, 200
   Notebook, 183
receiving documents, 206–213
recharging
   battery, 255–257
   with GO Quick Charger, 257
   with GO Travel Charger, 256
redefining hyperlink buttons, 193
refining searches, 175
Refresh (View menu), 219
removing batteries, 258
Rename (Edit menu), 86, 102, 223
Rename (File menu), 184
renaming
   before saving, 75
   disks, 223
   documents, 86, 102–103, 223
   handwriting profiles, 71
   hyperlink buttons, 193
   sections, 184
   stationery, 91
Repeat field, setting alarm and, 204
Replace
   adding words to dictionary and, 166
   checking spelling and, 165
   refining searches and, 175
   replacing text and, 171, 172
   Replace All, replacing text and, 171, 172
   Replacement word, refining searches and, 175
   replacing
      battery, 258–259
      text, 170–175
      words, 149
reset button, booting and, 246
Reset for same time, setting alarm and, 204
resetting time, 195
resizing floating documents, 99
response time, setting, 196
restarting, 244
   PenPoint, when documents freeze, 245
restoring Notebook, 238–239
Revert (Document menu), 104, 236
right bracket. See bracket, right
Right Margin (Paragraph sheet), 157
right page arrow. See page arrows
Ruled (Writing Pad pop-up list), 129
Ruled-Boxed (Writing Pad pop-up list), 131
ruled-boxed pads
   choosing, 131–132
   described, 128
   writing in, 131–132
   See also writing pad(s)
Ruled Height pop-up list, adjusting writing pad size and shape and, 133
ruled pads
   choosing, 129–130
   described, 128
   editing text in, gestures for, 38
   writing in, 120, 129
   See also writing pad(s)
■ S
Safeguards sheet
   backing up Notebook and, 237
   creating Notebooks and, 248
   floating documents and, 97, 178, 187
   restoring Notebook after booting and, 138
   setting alarm and, 204
   setting preferences and, 194
Index

turning on warning beep and, 197
using Auto Shut Off option and, 197
zooming documents and, 100

Same case only, refining searches and, 175

saving
changes, 74–75
documents, 104, 236
renaming before, 75

scratch out, gesture profile for, 60

screen
caring for, 273
cleaning, 273
learning to write on, 116

screen layouts, choosing, 199

scroll arrows, described, 96

scroll handle
described, 95
scrolling documents and, 96

scrolling
described, 8
documents, 93–96
gestures for, 39

scroll margin, 95
gestures in, 40
scrolling documents and, 96

SCSI hard drive, connecting, 267. See also hard disk

SCSI-II to SCSI-I connector cable, using hard drives and, 267

Search, finding text and, 170
Search category pop-up list, Document Only, 173
search direction, setting, 173–174

searches
defining, 173–175
refining, 175

search range, setting, 173–174
Second, setting time and, 195

Seconds category
Displayed, 195
Not Displayed, 195

Section
Create menu, 186
pop-up Create menu, 184

sections
creating, 184
deleting, 184
described, 7, 178

grouping documents into, 184–186
illustrated, 179
moving documents into, 185
renaming, 184
transferring to and from Notebook, 224–225

section titles, illustrated, 9

seeing. See viewing

Select All (Edit menu), 90, 144

selecting
described, 12
text, 144–145
with press, 58

selections
copying, with tap press, 63
deleting, 148
making, 12
moving, with press, 58
spell in, 61

Send (Document menu), 22, 213
sending and receiving documents and, 213

sending documents, 206–213

sentences
copying between pages, 29
selecting, 144

serial options, setting, 81

serial printer
connecting to
directly, 260
through GO Quick Charger, 262
connectors and adapters, 261

serial printer cable. See GO Serial Printer Cable

Serial sheet, 81

services
changes to, 74
defined, 66

Services sheet, connecting printers and, 79

setting
alarm, 204
date, 196
document options, 107
floating option, 97
insertion point
  in boxed pads, 59
  in text, 58
margins, 157
options, gestures for, 39
preferences, 194–199
printer options, 81–82
print options, for embedded documents, 109
response time, 196
search direction, 173–174
search range, 173–174
serial options, 81
tabs, 160
time, 195
zoom preference, 100
setting up, 254–273
printers, 79–82
shape, writing pad, 133
shocks, 273
shortcut
  for copying to home, 75
  for creating handwriting profiles, dictionaries, or preference sets, 72
Show (Borders & Controls category), 109
Show category
  Cork Margin, 250
  Menu Line, 250
Show Hidden Text (View sheet), 163
Show Hidden Text pop-up menu, Yes, 163
Show menu
  Button, 179, 180
  Date, 180, 182, 221
described, 178
finding out more about documents and, 180
finding out more about what's on disks and, 221
Icon, 180
Size, 180, 182, 221, 242
Tab Box, 180, 190
Type, 180, 182
using, 180
Show option, changing display and, 203
Show Special Characters pop-up menu, Yes, 163
Shut Off After category, using Auto Shut Off option and, 197
Signature Pad (Insert menu), 167
signatures, adding to documents, 167
single character pad
  getting, 126
  translating handwriting and, 122
size
  icon, changing, 200
  writing pad, 133
Size, described, 67
Size (Show menu), 180, 182, 221, 242
Size (Sort menu), 221, 242
smaller, making objects, 15
small-to-large adapter. See SCSI-II to SCSI-I connector cable
software keyboard
described, 134
editing text in edit pads and, 151
See also keyboard; Keyboard
sorting Table of Contents, 182
Sort menu
  By Date, 182
  By Name, 182
  By Page, 182
  By Size, 182
  By Type, 182
  Date, 221
finding out more about what's on disks and, 221
Name, 221
Size, 221, 242
sorting Table of Contents and, 182
Type, 221
Space After (Paragraph sheet), 158
Space Before (Paragraph sheet), 158
spaces
  inserting, 124, 125, 149
  in text, 148
spacing
  line, changing, 158
  paragraph, changing, 158
spell, gesture profile for, 61
Spell (Edit menu), 165
Spell dialog, 165
spelling, checking, 165–166
spilled liquids, 273
starburst, 11, 34
Start From category pop-up list, Beginning, 174
Start From field, 72
starting new lines, paragraphs, or pages, 161
static electricity, 273
stationery, 87
  adding, to Create menu, 88
  backing up, 91
  creating, 89–90
  customized, creating, 89–90
  deleting, 92
  described, 84
  Disk Manager, creating, 223
  letterhead, 211
  purging, 92
  renaming, 91
Stationery (icon), 20, 87. See also Bookshelf
Stationery notebook, 84
  managing, 91–92
  using to create documents, 87–88
Status
  finding text and, 170
  replacing text and, 172
storing, 273
style
  of edit pads, changing, 130
  of writing pads
    changing, 130
    choosing, 128–133
Style, changing icon size and, 200
styles, copying, 162
styling text, 154–156
  directly, 154–155
  with Text sheet, 156
subsections, creating, 186. See also pages; sections
symbol fonts, 77
system font. See fonts

tab, gesture profile for, 61
Tab (Insert menu), 160
Tab Box (Show menu), 180, 190
Table of Contents, 6, 84
  booting and, 246
  described, 7, 178
  export in, 49
  frozen documents and, 245
  gestures in, 40
  printing documents and, 210
  renaming documents from, 103
  restarting and, 244
  seeing what’s in Notebook and, 179
  selecting titles on, 12
  sending and receiving documents and, 213
  sorting, 182
  turning into control panel, 249–250	
tabs
  described, 7
  illustrated, 6, 9
  setting, 160
  See also Contents tab; labels; Notebook tabs
tab stops. See tabs
Tab Stops sheet, setting tabs and, 160
tap
  gesture profile for, 62
  to select characters, 144
tap press, gesture profile for, 63
Tap to Align Pen category (Pen sheet), 123
temperature, 273
text
  adding, 147
  in boxed writing pads, editing, 38
  copying, 152–153
  gestures for, 36
  deleting, 148
    gestures for, 36
  in documents, editing, 37–38
  editing, 144–167
    in edit pads, 149
    in fields, 150–151
    in labels and document titles, 150
  in edit pads, editing, 38
  finding, 170–175
  formatting, 144–167
  inserting spaces in, 148
  insert space in, 52
  magnifying, 164
  moving, 152–153
    gestures for, 36
  pigtails in, 57
  positioning, 159
  replacing, 170–175
  in ruled writing pads, editing, 38
  selecting, 144–145
    with press, 58
setting insertion point in, with press, 58
setting options for, gestures for, 39
styling, 154–156
directly, 154–155
with Text sheet, 156
typing onto pages, 134
viewing, 163–164
in writing pad, correcting by typing, 135
text fields, described, 26
Text sheet
creating customized stationery and, 89
displaying, 24
styling text with, 156
tiled, described, 251
tiled indexes, creating, 251–252
time, setting, 195. See also Clock
Time Format, setting time and, 195
timeout, described, 123, 196
Timeout category (Preferences), 34
Timeouts sheet
setting preferences and, 194
setting response time and, 196
translating handwriting and, 123
Time sheet
setting preferences and, 194
setting time and, 195
Time Zone, setting time and, 195
time zones, changing, 195
tips
on navigating and using documents, 249–252
on writing in pads, 119–120
Title & Info sheet
Active Size, 181
Filed Size, 181
renaming documents and, 102
using Document sheet and, 181
title line
creating customized indexes and, 251
document, gestures in, 39
spell in, 61
turning Table of Contents into control panel and, 250
titles
document
editing text in, 150
illustrated, 9, 179
section, illustrated, 9
selecting, 12
tools, embedding, 106
Tools, 18–19
connecting printers and, 79
See also Bookshelf; Clock; Disk Manager; Handwriting Customization; Keyboard; Letter Practice; Personal Dictionary; Printers
TOPS FlashCard
connecting to
directly, 269
through GO Quick Charger, 270
connecting to PCs and, 268–270
transferring
documents, 224–227
documents between disks, 226–227
documents and sections to and from Notebook, 224–225
translating handwriting, 122–123
translations
correcting, 124–125
with Proof sheet, 125
in writing pad, 124
transporting, 273
Travel Charger. See GO Travel Charger
triple tap
gesture profile for, 63
to select sentences, 144
turning to pages, 187–188
turning on warning beep, 197
Turn to (View menu), 188
Type (Show menu), 180, 182
Type (Sort menu), 221
Type pop-up list, 80
typing, correcting text in writing pad by, 135
typing text onto pages, 134

underline
gesture profile for, 64
styling text directly and, 155
underscore symbol, correcting translations in writing pad and, 124
Unrecognized Character pop-up list, correcting translations in writing pad and, 124
INDEX

unrecognized/mistranslated letters, correcting, 124
Update from Home (Home menu), 74
updating from home volume, 75
upper case
gesture profile for, 64
printing in, 121
styling text directly and, 155
Upper Case Only (Handwriting sheet), 138
Upper Case Only (Writing Style category pop-up list), 121
users, multiple, 141, 247–248
Using PenPoint, using, 2–3
utilities
deactivating, 76–77
installing from disk, 68–70
personalized, creating, 71–73

V
viewing
Handwriting Installer sheet, 67
text, 163–164
View menu
Bring to, 188
Collapse, 179, 221
Expand, 179, 221
finding out more about what’s on disks and, 221
Refresh, 219
Turn to, 188
View sheet
magnifying text and, 164
Show Hidden Text, 163
viewing text and, 163
volume(s)
described, 66, 216
home
changing, 78
saving changes to, 74
updating from, 75
See also disk(s)
Volume menu
About, 221, 223
Copy Contents, 228, 229
Duplicate, 228
Eject & Remember, 227
Format, 235
Volume sheet, finding out more about what’s on disks and, 221

W
warm booting. See booting
warning beep, turning on, 197
words
adding, 147
to dictionary, 166
deleting, 148
replacing, 149
selecting, 12, 144
writing
in boxed pads, 120
in Notebook, 116–141
in pads, tips on, 119–120
in ruled-boxed pads, 131–132
in ruled pads, 120, 129
on screen, learning to, 116
using keyboard, 134–135
writing pad(s)
boxed, 38
changing style of, 130
choosing size and shape, 133
choosing style of, 128–133
correcting text in by typing, 135
correcting translations in, 124
embedded, 126
getting, 126–127
pop-up, 126
printing in, 117–121
ruled, 38
writing in, tips on, 119–120
See also boxed pads; ruled-boxed pads; ruled pads
Writing Pad pop-up list
Boxed, 128
Ruled, 129
Ruled-Boxed, 131
Writing Style category pop-up list, Upper Case Only, 121

X, Y, Z
Year, setting date and, 196
zoom, described, 100
zooming documents, 100–101
Zooming Documents
Allowed, 238
backing up Notebook and, 237
zooming documents and, 100
zoom preference, setting, 100